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Předmluva

Do rukou se vám dostává text učebnice a sbírka příkladů, které prošly dlouhým vývojem,
než se staly součástí sborníku z workshopu 7. ročníku mezinárodní odborné konference SCO
(Sharable Content Objects) 2011. Toto dílo vzniklo v roce 2010 v rámci řešení projektu pro-
jektu FRVŠ č. 2785/2010 „Rozvoj výuky předmětu Matematická analýza — cvičení s pou-
žitím Mapleÿ. Cílem projektu bylo poskytnout všem studentům se zájmem o matematickou
analýzu a systém Maple kvalitní výukový materiál tak, aby vzrostla znalost matematické
analýzy a zároveň schopnost řešit složitější problémy za pomocí informačních technologií.

Text učebnice a sbírka příkladů vycházely z dostupných materiálů o systému Maple
a také z časové dotace cvičení předmětu Matematická analýza na Přírodovědecké fakultě
Masarykovy univerzity (PřF MU) v Brně a osnovy příslušné přednášky z Matematické ana-
lýzy pro předměty MB000c Matematická analýza I — cvičení s použitím Maple a MB001c
Matematická analýza II — cvičení s použitím Maple na PřF MU.

Po úspěšné obhajobě projektu na začátku roku 2011 byl text „Matematická analýza –
cvičení s použitím Mapleÿ společně se sbírkou příkladů dán k dalšímu posouzení vysoko-
školským učitelům matematiky na brněnských vysokých školách a Českém vysokém učení
technickém v Praze, kteří k němu vznesli řadu podnětných připomínek.

Tyto připomínky byly ve velké míře akceptovány a zapracovány v prvním pololetí roku
2011 do současného textu „Matematická analýza — cvičení s použitím Mapleÿ, který je
uveden dále.

Mezitím byla vytvořena a distribuována uživatelům nová verze Maple 15, jejíž rozšíření
vůči verzi Maple 14 není v textu této publikace ještě zohledněno. Nejedná se však o pod-
statné rozdíly a popsané vlastnosti a použití Maple ve cvičeních Matematická analýza I
a Matematická analýza II se nezmění.

Autoři připravují nový text a sbírku příkladů, kde již bude Maple 15 zohledněn.
Autoři jsou otevřeni pro případně připomínky a návrhy čtenářů na vylepšení či rozšíření

tohoto textu a sbírky příkladů.

Brno, červen 2011

Mgr. Jaroslav Urbánek
Mgr. Václav Pink

Prof. RNDr. Jiří Hřebíček, CSc.
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1 Úvod do systému Maple

1.1 Systém Maple

Systém Maple je výkonný program pro řešení jednoduchých i složitějších matematických
problémů. S jeho pomocí také můžeme vytvářet dokumenty vysoké kvality, prezentace a in-
teraktivní uživatelské nástroje. Maple patří do skupiny systémů počítačové algebry umožňu-
jící jak symbolické, tak numerické výpočty. Systém navíc obsahuje komponenty podporující
výuku matematiky.

Výrobcem systému je kanadská společnost Maplesoft Inc., jejíž webové stránky1 poskytují
široké informace o systému a jeho dalších příbuzných programech jako je MapleSim, Maple-
Net, Maple T.A. a mnoho dalších nástrojů a programů. Webové stránky mimo jiné obsahují
tzv. Aplikační centrum (Application Center), z nějž si může každý zaregistrovaný uživatel
stáhnout ukázkové programy demonstrující použití systému Maple při řešení mnoha růz-
ných matematických i technických problémů. Poskytují i tzv. Studentské centrum (Student
Center), kde si zaregistrovaný student může stáhnout mnoho studijních materiálů. Dalšími
významnými zdroji informací o Maple jsou diskuzní fórum uživatelů Maple2 a web distribu-
tora Maple pro Českou a Slovenskou republiku3, kde je většina dokumentů v českém jazyce
[5], [9].

Systém Maple je vyvíjen od roku 1980, kdy se objevila jeho první limitovaná verze.
Přelomovým obdobím byly roky 2003–2005, v nichž vznikla devátá a následně desátá verze
Maple 10 přinášející nové grafické uživatelské rozhraní zvané Standard Worksheet a poté tzv.
dokumentový režim (Document mode). Díky nim se ovládání systému Maple stalo výrazně
jednodušším. V současné době vzniká každý rok nová verze, v době psaní tohoto textu byla
na trhu nejnovější verze Maple 14. A právě touto verzí se budeme zabývat.

Se systémem je možné pracovat několika různými způsoby, které volíme při spuštění
programu ze startovacího menu počítače nebo kliknutím na příslušnou ikonu na ploše. Maple
je k dispozici pro různé operační systémy. V následujícím textu popíšeme, jak s program
spouštíme v nejrozšířenějším operačním systému Windows.

1.1.1 Standardní zápisník (Standard Worksheet)

Grafické uživatelské rozhraní Maple zvané Standard Worksheet se spustí ze startovacího
menu počítače výběrem položky Programy > Maple 14 > Maple 14 nebo kliknutím na
ikonu Maple 14 na ploše. Toto prostředí poskytuje veškeré možnosti systému Maple a po-
máhá vytvářet elektronické dokumenty (zápisníky) zobrazující matematické výpočty, texty
a komentáře spolu s propracovanou počítačovou grafikou. Některé je možné v zápisníku
„schovatÿ a nechat „odkrytéÿ jen nejdůležitější pasáže tak, aby dokument poskytoval uživa-
teli potřebné informace. Jelikož jsou vytvořené dokumenty interaktivní, tj. v jistém smyslu

1http://www.maplesoft.com
2http://www.mapleprimes.com
3http://www.maplesoft.cz
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„živéÿ, může si uživatel sám upravovat předdefinované hodnoty parametrů, vyhodnocovat
příkazy, a získávat tak nové výsledky.

Menu zápisníku Maple má tři vodorovné lišty: hlavní menu (Menu Bar, zcela nahoře),
nástrojovou lištu (Toolbar, pod hlavním menu) a kontextovou lištu (Context Bar, pod ná-
strojovou lištou). Zápisník dále obsahuje palety (Palettes , svislý blok na levé straně4), vlastní
pracovní pole – dokument (Document), do nějž zadáváme příkazy, texty, provádíme výpo-
čtové a grafické akce, a stavovou lištu (Status Bar, zcela dole). Vlastní pracovní pole je možné
zobrazit přes celou obrazovku skrytím palet a všech lišt (kromě hlavního menu) kliknutím
na příslušné položky v záložce View hlavního menu.

Obrázek 1.1: Maple 14: Prostředí Standard Worksheet.

1.1.2 Klasický zápisník (Classic Worksheet)

Classic Worksheet se spustí ze startovacího menu počítače výběrem položky Programy >
Maple 14 > Classic Worksheet Maple 14 nebo kliknutím na ikonu Classic Worksheet
Maple 14 na ploše. Tento zápisník Maple je určen především pro méně výkonné počítače
s omezenou pamětí. Neposkytuje také všechny funkce, příkazy a možnosti systému Maple
jako Standard Worksheet [5].

1.1.3 Příkazový řádek a kalkulačka Maple

Se systémem Maple můžeme pracovat i pouze v režimu tzv. příkazového řádku spustitelného
ze startovacího menu počítače výběrem položky Programy > Maple 14 > Command-
line Maple 14. Příkazový řádek je určen k řešení rozsáhlých a složitých úloh. K dispozici
přitom nejsou žádné grafické prvky.

4Palety se automaticky zobrazují v levém bloku. Prostředí systému nabízí blok pro palety i po pravé
straně obrazovky (automaticky zavřený), kam je možné některé (ale i všechny) přesunout.
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Obrázek 1.2: Maple 14: Prostředí Classic Worksheet (převzato z [5]).

Obrázek 1.3: Maple 14: Příkazový řádek.

Dále je možné používat (a vytvářet) tzv. maplety, tj. grafická uživatelská rozhraní ob-
sahující okénka, textová pole a další vizuální prvky umožňující pouhým klikáním spouštět
výpočty. Kalkulačka systému Maple je speciální typ mapletu, který je k dispozici pouze
pro operační systémy Windows. Spouští se ze startovacího menu počítače, kde se vybere
Programy > Maple 14 > Maple Calculator [5].

7



1.1.4 Document Mode, Worksheet Mode

Dále se budeme věnovat pouze rozšířenému prostředí Standard Worksheet. V tomto prostředí
je možné pracovat ve dvou základních režimech: Worksheet Mode a Document Mode. Prvně
jmenovaný odpovídá prostředí Classic Worksheet, v němž je každý příkaz Maple uvozen sym-
bolem [> a musí být ukončen středníkem (výsledek se zobrazí na dalším řádku uprostřed)
nebo dvojtečkou (výsledek se nezobrazí). Otevírá se v hlavním menu zvolením File > New
> Worksheet mode. Document Mode poskytuje přehlednější zápis příkazů a matematic-
kých vzorců bez „přebytečnýchÿ symbolů. Při otevření nového souboru z nástrojové lišty
je automaticky spuštěn právě tento režim, jinak je možné jej též otevřít z hlavního menu
v položce File > New.

Obvykle je zápisník nastaven do jednoho režimu5, který je možné zvolit při otevírání
nového souboru v hlavním menu (File > New > . . .). Existuje však i možnost přepínat
mezi režimy v rámci jednoho zápisníku, kdy je část vytvořena v jednom režimu, část v jiném.
Z Document Mode se přepneme do Worksheet Mode kliknutím na ikonku [> v nástrojové
liště. Naopak z Worksheet Mode se do režimu Document Mode přepneme výběrem položky
v hlavním menu (Format > Create Document block) [5].

1.1.5 Math Mode, Text Mode

Pro rozlišení příkazů a obyčejného textu slouží kontextová lišta zápisníku, kde máme na
výběr Text Mode a Math Mode. Math Mode odpovídá příkazům (po stisku klávesy Enter
dojde k vyhodnocení), v Text Mode píšeme texty dokumentu podobně jako např. v textovém
editoru Word (po stisku klávesy Enter přejdeme na nový řádek bez jakéhokoli vyhodnocení).
Volit režim zápisu můžeme buď kliknutím myši (v kontextové liště nad dokumentem jsou
uvedeny názvy představující jednotlivé možnosti) nebo výběrem položky v hlavním menu
(Edit > Switch to Text/Math Mode). Totéž lze rychleji provést klávesou F5.

V režimu Worksheet Mode lze pro text i pro příkazy použít oba druhy zápisu. Pro psaní
textu je nutné kliknout na ikonku T v nástrojové liště nebo zvolit položku v hlavním menu
(Insert > Text). Podobně pro zápis příkazů jazyka Maple je nutné kliknout na ikonku [>
v nástrojové liště nebo zvolit položku v hlavním menu (Insert > Maple Input). Při otevření
nového souboru je zápisník automaticky nastaven na psaní příkazů.

K příkazům máme dále možnost zapisovat komentáře uvedením symbolu mřížky (#)
před text, který má být komentářem (viz obrázek 1.5) [5].

1.2 Základní ovládání systému

Již víme, jak spustit systém Maple a jak zvolit pracovní prostředí, které chceme. Otevřít
již vytvořený program můžeme z hlavního menu (File > Open. . .) nebo spuštěním pro-
gramu rovnou z operačního systému (prostřednictvím nějakého souborového manažeru).
Když chceme vytvořený dokument uložit, zvolíme položku File > Save (resp. File > Save
As. . .) v hlavním menu systému Maple. Dokumenty prostředí Standard Worksheet mají
příponu mw, dokumenty prostředí Classic Worksheet příponu mws. V prostředí Standard
Worksheet je možné otevřít oba typy souborů, v prostředí Classic Worksheet pouze typ
mws.

Maple poskytuje také možnost exportovat dokumenty jako soubory jiných typů. Pod-
porovány jsou typy: HTML, PDF, LaTeX, Maple Input, Maplet, Maple Text, Plain Text,

5Ten zpravidla volíme při prvním spuštění po instalaci systému nebo jej můžeme následně nastavit v hlav-
ním menu: Tools > Options. . . > Interface.
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Obrázek 1.4: Režimy zápisu (převzato z [5]).

Obrázek 1.5: Zápis komentáře v příkazovém režimu (převzato z [5]).

Maple T.A. a Rich Text Format. Pro export dokumentu vybereme položku Export As. . .
ze záložky File v hlavním menu.

Nyní si ukážeme, jak v Document Mode zadávat jednoduché příkazy. Budeme proto
předpokládat, že zápisník je již nastaven pro psaní příkazů (Math Mode).

Základní operace: pro sčítání používáme symbol plus (+), pro odčítání mínus (–), pro ná-
sobení (*), ale pozor, pro dělení musíme používat pouze lomítko (/), dvojtečka (:) má jiný
význam (viz dále).

Zadání zlomku: zadáme čitatel, lomítko (/) a jmenovatel. Pro opuštění zápisu jmenovatele
stačí stisknout šipku doprava (ve zlomku je též možno pohybovat se šipkami).

Zadání mocniny: zadáme základ, symbol stříška (ˆ) a exponent. Pro opuštění zápisu ex-
ponentu je opět možné použít šipku doprava.

1.2.1 Vyhodnocení příkazů

Příkaz vyhodnotíme stiskem klávesy Enter. Výsledek se zobrazí na dalším řádku uprostřed.
V dřívějších verzích (méně než 10) systému Maple bylo nutné příkaz ukončovat středníkem,
aby se provedl. Tato možnost nadále zůstala (tj. zadáme-li za příkaz středník, „nic nepoka-
zímeÿ) a v některých situacích je dokonce jediná možná – např. textový režim (Text Mode)
příkazů v Worksheet Mode nebo při psaní příkazů v prostředí Classic Worksheet. Z pře-
dešlých verzí Maple se uchovala i funkcionalita symbolu dvojtečka (:), která po zařazení
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za příkaz a následného stisku klávesy Enter potlačí zobrazení výsledku na dalším řádku
(tj. příkaz se vyhodnotí, ale na obrazovku se nic nevypíše). Proto není možné dvojtečku
používat jako operátor dělení. V Document Mode je navíc možné zapisovat příkaz i s výsled-
kem na jeden řádek. Po napsání příkazu k tomu stačí namísto stisku klávesy Enter použít
klávesovou zkratku „Ctrl + =ÿ.

Jak bylo zmíněno dříve, interaktivní dokumenty v Maple jsou „živéÿ. Tím máme na mysli
skutečnost, že i v dříve vytvořeném dokumentu s vyhodnocenými příkazy otevřeném po
libovolně dlouhé době můžeme kterýkoli výraz upravit, znovu vyhodnotit (stisknout Enter
nebo „Ctrl + =ÿ) a dostaneme nový výsledek. Označíme-li myší několik (libovolně mnoho)
příkazů a stiskneme ikonku ! (vykřičník) z nástrojové lišty, všechny označené příkazy budou
postupně vyhodnoceny. K vyhodnocení všech příkazů v dokumentu slouží ikonka !!! (tři
vykřičníky).

Obrázek 1.6: Palety.

Maple obsahuje více než tisíc symbolů, pomocí nichž můžeme
tvořit matematické výrazy a typograficky kvalitní text. Patří mezi
ně písmena a číslice, jimiž vytváříme jména (posloupnost znaků za-
čínající písmenem, za kterým může následovat kombinace písmen,
čísel a vybraných symbolů), reálná čísla (celá, racionální, iracionální,
s desetinou tečkou nebo v notaci pohyblivé řádové čárky), komplexní
čísla, aritmetické, booleovské a jiné operátory (+, –, !, /, *,

∫
, lim, . . .

), konstanty (π, e, . . . ), imaginární jednotku, nekonečno, matema-
tické funkce (cos(x), sin(π3 ), . . . ) a proměnné (pojmenované jménem
. . . ). Velkou předností systému Maple je jeho schopnost symbolic-
kých matematických výpočtů. Některé z matematických symbolů,
které můžeme použít, nejsou na klávesnici, a tak se zadávají buď
z palety nebo pomocí svých názvů [5].

1.2.2 Palety

Palety jsou pojmenované „obdélníčkyÿ s nabídkou předdefinovaných
symbolů, zápisů, výrazů apod. (obrázek 1.6), zpravidla při levém
okraji zápisníku. Každá paleta obsahuje symboly příslušné skupiny.
Například paleta s názvem Expression nabízí některé základní ma-
tematické výrazy, paleta Greek písmena řecké abecedy atd. Stan-
dardně zůstává několik palet nezobrazených. V hlavním menu (View
> Palettes) můžeme seznam zobrazených palet upravit tím, že ně-
které přidáme, odebereme, ale třeba i jinak seřadíme. Totéž lze pro-
vést jen za pomoci myši. Přidržením levého tlačítka vybranou pa-
letu přesuneme na jiné místo, stisknutím pravého tlačítka vyvoláme
stejnou nabídku, jako bychom postupovali přes hlavní menu. Klik-
nutí levého tlačítka myši na některou z palet zobrazí (příp. skryje)
symboly, které paleta nabízí. Vložit z palety symbol do zápisníku
pak stačí pouhým kliknutím, případně „přetáhnutímÿ s pomocí le-
vého tlačítka myši. Obecné barevně zvýrazněné symboly ve výrazu
je možné dále specifikovat (upravovat) dosazením hodnoty, s níž po-
třebujeme pracovat [5].

Příklad 1.1: Vložte do dokumentu výraz
10∑
i=1

2i.

Řešení: Pro zapsání zadaného výrazu potřebujeme celkem dva různé symboly: sumu
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a mocninu. Sumační symbol nalezneme v paletě Expression. Kliknutím na tuto paletu ji
otevřeme (na obrázku 1.6 je jako jediná otevřená) a vybereme z ní přítomný sumační symbol.
Po jeho vložení do zápisníku pak jednoduše přepíšeme obecné symboly (k, n a f) požado-
vanými hodnotami. Pohybovat ve vzorci se můžeme pomocí šipek na klávesnici, s výhodou
lze využít klávesy Tab, přitom k úpravě výrazu můžeme používat i všechny ostatní klávesy
jako např. Delete, Backspace, mezerník, . . . Znak f přepíšeme mocninným výrazem. To
můžeme provést buď vložením dalšího symbolu z palety Expression (symbol ab) a násled-
nou úpravou (specifikací hodnot a, b), nebo užitím již známé klávesy pro tvorbu mocnin –
stříšky (ˆ).

Příklad 1.2: Vložte do dokumentu výraz
∞∑
i=1

1
i
.

Příklad 1.3: Vložte do dokumentu výraz
∣∣∣323−642

17·24

∣∣∣.
Příklad 1.4: Vložte do dokumentu výraz

√
ln(e5)!·sin( 17·π2 )−3·13√

log2(16)−1
.

1.2.3 Názvy symbolů

Mimo palet můžeme k zápisu symbolů užívat jejich názvů. Například symbol π vložíme za-
psáním jeho názvu Pi6, pro odmocninu je vyhrazen název sqrt, takže

√
x vložíme napsáním

sqrt(x). Při vkládání symbolů pomocí názvů nebo při tvorbě příkazů se může hodit funkce
„dokončováníÿ. Pro zadání symbolu pak stačí napsat jeho úvodní písmeno (písmena) a po-
mocí klávesy Esc nebo kláves „Ctrl + mezerníkÿ následně z vyskakovacího okénka zvolit
požadovaný příkaz. Na obrázku 1.7 je ukázka nabídky pro dokončení zápisu písmen so [5].

Obrázek 1.7: Funkce automatického dokončování (převzato z [5]).

6Maple rozlišuje malá a velká písmena. Například zápis Pi představuje Ludolfovo číslo π i s jeho hodnotou,
zatímco zápis pi představuje pouze symbol (řecké písmeno) π.
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Příklad 1.5: Vložte do dokumentu výraz
∣∣∣323−642

17·24

∣∣∣ bez použití palet.

Řešení: Pro absolutní hodnotu z požadovaného výrazu použijeme příkaz abs, při zadá-
vání mocnin využijeme symbolu stříšky (ˆ). Výsledný zápis zadaného výrazu tedy bude:
abs((32^3-64^2)/(17*2^4)).

Příklad 1.6: Vložte do dokumentu výraz
√

ln(e5)!·sin( 17·π2 )−3·13√
log2(16)−1

bez použití palet.

1.3 Nápověda

Významnou součástí systému Maple je jeho nápověda. K dispozici je několik různých typů
nápovědy, které nejlépe najdeme v hlavním menu v nabídce Help. Základní stránky nápo-
vědy zobrazíme výběrem položky Maple Help7.

Vyhledávat v nápovědě můžeme buď zadáním hledaného textu do textového pole v levé
horní části okna (na obrázku 1.8 je v tomto poli zapsán text abs), nebo tematickým vyhledá-
váním v připravené stromové struktuře témat v levé části okna (na obrázku 1.8 je rozbalena
Matematika a v ní téma Calculus, tedy Matematická analýza). Odkliknutím zadaného slova
abs v textovém vyhledávacím poli nápovědy zobrazíme v hlavní části okna nápovědu právě
k příkazu abs. Jak můžeme vidět na obrázku 1.8, nápověda obsahuje základní popis příkazu,
obecný zápis příkazu pro jeho použití a konkrétní ukázkové příklady.

Obrázek 1.8: Hlavní nápověda systému Maple.

7Pro vyvolání této nápovědy můžeme také použít klávesovou zkratku „Ctrl + F1ÿ, nebo poslední ikonku
nástrojové lišty.
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1.3.1 Tour of Maple, Quick Reference, Quick Help

Nabídka Help hlavního menu poskytuje ještě několik jiných forem nápovědy. Položka Take
a Tour of Maple zobrazí interaktivní přehled systému (jeho nejdůležitějších prvků). Klik-
nutí na Quick Reference otevře tabulku informací o ovládání systému Maple, zejména pro
nové uživatele. Jedná se o základní informace s odkazy do nápovědy Maple Help pro jejich
případné doplnění. Položka Quick Help nabízí ještě stručnější tabulku než předchozí nápo-
věda. Standardně se objevuje v každém novém zápisníku při pravé straně v podobě černého
okénka (pokud toto nastavení nezrušíme). Po zavření je možné ji vyvolat stiskem klávesy
F1, či jako položku v hlavním menu [5].

1.3.2 What’s New, Startup Dialog

Dalšími druhy nápovědy jsou přehled rozšíření stávající verze Maple oproti předcházející verzi
(dostupné přes Help > What’s New) a tzv. Startup Dialog obsahující tipy pro práci
se systémem Maple. Startup Dialog se zobrazuje vždy po spuštění systému (pokud toto
nastavení nezrušíme) [5].

1.3.3 Manuals, Resources, and more

Vyvoláním Manuals, Resources, and more přejdeme do další oblasti nápovědy, z níž
popíšeme tři nejdůležitější části.

Maple Portal

Od předcházející verze (tedy Maple 13) je k dispozici tzv. Maple Portal. Spustit jej můžeme
samostatně (Maple Portal má vlastní ikonu na ploše) nebo přes nápovědu v hlavním menu
(Help > Manuals, Resources, and more > Maple Portal). Maple Portal slouží jako po-
mocník novým i zkušenějším uživatelům hledajících pokročilejší nápovědu. Je v něm možné
rychle najít detailní popis práce se systémem Maple od řešení nejjednodušších problémů až
po velmi složité úlohy [5].

Applications and Examples

Z nápovědy je možno vyvolat i spustitelné soubory (tj. již vytvořené dokumenty) demon-
strující možnosti systému Maple. Otevřeme je přes nápovědu v hlavním menu (Help >
Manuals, Resources, and more > Applications and Examples) a pak kliknutim na
zvolený příklad [5].

Manuals

Dále je je možné vyvolat anglické manuály User manual, Introductory Programming
Guide, Advanced Programming Guide a Getting Started with Maple Toolboxes
podrobně popisující možnosti systému Maple. Otevřeme je přes nápovědu v hlavním menu
(Help > Manuals, Resources, and more > Manuals) a pak kliknutim na zvolený
manuál [5].

1.3.4 Pomocníci, instruktoři a řešené úlohy

Systém Maple poskytuje také již připravené „pomocné nástrojeÿ pro řešení úloh. Jsou to
tzv. Pomocníci (Assistants), Instruktoři (Tutors) a Úlohy (Tasks), které vyvoláme z hlav-

13



Obrázek 1.9: Maple Portal (převzato z [5]).

ního menu (Tools > Assistants nebo Tools > Tutors anebo Tools > Tasks). Pomocníci
(Assistants) obsahují například nástroje pro hledání funkční závislosti v datech, optimalizaci
funkcí, řešení diferenciálních rovnic a další. Pro daný typ úlohy mají implementováno ně-
kolik často používaných algoritmů. Po vyvolání provedou uživatele nastavením a specifikací
parametrů úlohy a zvolenou metodou úlohu vyřeší. Instruktoři (Tutors) provedou uživatele
řešenou problematikou pomocí jednoduchých názorných příkladů. Úlohy (Tasks) zobrazují
na příkladech, jak řešit různé úlohy. Zobrazí se vyvoláním z hlavního menu (Tools > Tasks
> Browse) [5].

1.3.5 Příkaz ? (otazník)

Symbol ? (otazník) je dalším ze způsobů zobrazení nápovědy. Zapsáním a provedením pří-
kazu ? otevřeme hlavní stránku nápovědy. Otazník spolu s názvem příkazu otevře nápovědu
na stránce týkající se zadaného příkazu. Tedy např. příkaz ?evalf otevře hlavní nápovědu
systému na stránce popisující syntaxi a sémantiku příkazu evalf spolu s příklady jeho pou-
žití. Zapsáním dvou otazníků na začátek příkazu otevřeme tutéž stránku nápovědy ve „sba-
lenémÿ tvaru osnovy, v níž je možné otevřít (odkrýt) libovolné části. Zadáním tří otazníků
před příkaz otevřeme nápovědu na příkladech použití tohoto příkazu [5].

Otevřít nápovědu na stránce zadaného příkazu (resp. klíčového slova) můžeme též stisk-
nutím klávesy F2 (za přítomnosti kurzoru na klíčovém slově).

Příklad 1.7: Zjistěte, k čemu slouží příkaz sum a jak se používá.

Příklad 1.8: Zjistěte, jak je možné v systému Maple pracovat s vektory a maticemi.
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1.4 Provádění výpočtů

Maple provádí přesně numerické výpočty s celými, racionálními i iracionálními čísly. Každý
zadaný matematický výraz se snaží zjednodušit (např. zlomek zkrátit a převést na základní
tvar, upravit algebraický výraz, . . . ), ale ne za cenu ztráty přesnosti. To znamená, že napří-
klad racionální čísla (zlomky) udržuje stále v jejich základním tvaru. Podobně s konstantami
π, e a dalšími, s odmocninami a jinými výrazy pracuje jako se symboly. Tímto je zaručena
absolutní přesnost výpočtů i v případě, kdy nepracujeme pouze s celými čísly [5].

Jsou však situace, kdy potřebujeme znát přibližnou hodnotu reálného nebo racionálního
čísla v pohyblivé řádové čárce. K tomu slouží příkaz evalf, jenž vrátí zaokrouhlenou hod-
notu svého argumentu na počet platných cifer mantisy specifikovaný systémovou proměnnou
Digits. Ta je standardně nastavena na hodnotu 10. Všechny výpočty, při nichž je nutné za-
okrouhlovat čísla, provádí proto Maple s přesností na 10 platných míst. Proměnnou Digits
můžeme nastavit na takřka libovolné přirozené číslo. Omezení, jak vysoké toto číslo může
být, zjistíme příkazem kernelopts(maxdigits). Pro představu uveďme, že pro Maple 14 je
toto číslo 268 435 448, tedy více než 268 milionů platných cifer, s kterými dokáže systém
„teoretickyÿ8 počítat [5].

Obrázek 1.10: Příkaz evalf (převzato z [5]).

Aniž bychom měnili nastavení proměnné Digits, můžeme zobrazit libovolný výraz s poža-
dovanou přesností pouze pomocí příkazu evalf. Příkaz je možné použít s jedním nebo dvěma
parametry. Jediný zadaný parametr znamená, že tento zadaný výraz bude vyhodnocen na
počet platných míst specifikovaný v proměnné Digits. Přidaný druhý parametr řekne funkci
evalf, na kolik platných míst má výraz vyhodnotit, viz příklady na obrázku 1.10 [5].

Maple rozeznává přesná čísla (mezi něž patří i zmíněné symboly π a e, zlomky atp.)
a čísla typu Floating-Point, nebo-li čísla v pohyblivé řádové čárce. Jestliže systému zadáme
výraz, v němž některý z jeho podvýrazů bude typu Floating-Point, může Maple na celý
výraz pohlížet jako by byl tohoto typu a bude výsledky výpočtů zaokrouhlovat. To nejlépe
uvidíme na dalších příkladech na obrázku 1.11 [5].

1.4.1 Příkazy

Pro provedení výpočtu máme zpravidla více možností. Tou základní, která je k dispozici ve
všech verzích systému, jsou příkazy jazyka Maple. Chceme-li například vypočítat odmocninu

8Výpočet se s rostoucím počtem platných míst prodlužuje a je paměťově náročnější, což způsobuje prak-
tickou nepoužitelnost pro vyšší počet (závislý na typu úlohy) cifer.
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Obrázek 1.11: Přesná čísla a čísla typu Floating-Point (převzato z [5]).

z čísla 2,5, zapíšeme v systému Maple příkaz sqrt(2.5). Stejného výsledku dosáhneme pou-
žitím symbolu pro odmocninu z palety Expression. Pokud chceme určit nejmenší společný
násobek čísel 10, 12 a 15, můžeme využít příkazu lcm, nebo zapsat čísla na řádek za sebe
(oddělená čárkami) a přes pravé tlačítko myši zvolit z kontextové nabídky Apply Function
> Least Common Multiple, viz obrázky 1.12, 1.13 [5].

Obrázek 1.12: Provedení výpočtu pomocí kontextové nabídky (převzato z [5]).

Příklad 1.9: Zobrazte číslo π s přesností na pět desetinných míst.
Řešení: Pro zobrazení přibližné (zaokrouhlené) hodnoty s požadovanou přesností vy-

užíváme příkazu evalf. Funkci evalf dáme jako první argument výraz, jehož přibližnou
hodnotu chceme určit (tj. π). Druhý argument bude specifikovat počet platných míst. Jeli-
kož chceme, aby počet desetinných míst byl roven pěti, počet platných míst nastavíme na 6.
Získáme tak výsledek na obrázku 1.14.

Příklad 1.10: Zobrazte Eulerovo číslo s přesností na dvě desetinná místa.

Příklad 1.11: Vypočítejte, kolik je 1− 1.0
3.0 −

1.0
3.0 −

1.0
3.0 . Proč není výsledek roven 0?
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Obrázek 1.13: Různé možnosti provedení výpočtu (převzato z [5]).

Obrázek 1.14: Řešení příkladu 1.9.

1.4.2 Označení výsledků

Každému zobrazenému výsledku se v zápisníku přiřazuje číselné označení, které se zapisuje
zcela vpravo na řádek s odpovídajícím výsledkem. Označení je možné potlačit (tj. nezobra-
zovat), znovu vyvolat, případně upravit jeho formát v hlavním menu (Format > Equation
Labels > . . .). Díky označení se můžeme na předešlé výsledky odvolávat a používat je
při tvorbě dalších příkazů. V ukázkách vytvořených dokumentů (prezentovaných v tomto
textu) je označení výsledků vždy potlačeno. Použití označení ilustruje obrázek 1.15.

Obrázek 1.15: Označení výsledků (převzato z [5]).

Pokud chceme například přičíst číslo 10 k výsledku s označením (2), pak napíšeme „10
+ ÿ a přes klávesovou zkratku „Ctrl + Lÿ vložíme požadované označení (tedy do „vyska-
kujícího okénkaÿ zadáme číslo 2 a potvrdíme (OK)). Místo klávesové zkratky „Ctrl + Lÿ
je možné použít horní menu (Insert > Label. . . ). Pozor, zápis (2) vytvořený (pouze) na
klávesnici při tvorbě příkazu Maple nepochopí, pro vložení označení do příkazu je třeba
důsledně používat předešlý postup s „vyskakujícím okénkemÿ zobrazeným na obrázku 1.16
[5].

Maple dále nabízí možnost odkazovat se na poslední tři výsledky (v tomto případě je
jedno, zda byly zobrazeny či nikoliv, a zda mají nějaké označení) pomocí symbolu % (pro-
cento). Jedno procento (%) představuje poslední výsledek, dvě procenta (%%) předposlední
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Obrázek 1.16: „Vyskakující okénkoÿ pro zadání označení (převzato z [5]).

a tři procenta (%%%) před-předposlední. Upozorněme, že výsledek získaný těmito příkazy zá-
visí na pořadí vykonaných příkazů, ne na jejich umístění v zápisníku! Tedy např. % vypíše
poslední výsledek získaný předchozím (časově) vykonaným příkazem (obrázek 1.17).

Obrázek 1.17: Využití procent při odkazování se na předchozí výsledky (převzato z [5]).

1.4.3 Přiřazení hodnot do proměnných

Odkazovat se na výrazy můžeme také po jejich přiřazení k nějaké proměnné. Operátorem
přiřazení je (dvoj)symbol := (dvojtečka + rovnítko).

Namísto (dvoj)symbolu := můžeme k přiřazení použít příkaz assign. Tak, jak můžeme
výrazy do proměnných přiřazovat, můžeme též přiřazení zrušit (tj. odebrat proměnné ulo-
ženou hodnotu). Zmíněné provedeme příkazem unassign nebo přiřazením názvu proměnné
v apostrofech (obrázek 1.18).

Přiřazovat hodnoty můžeme i do tzv. systémových proměnných. Již jsme se setkali s pro-
měnnou Digits vyjadřující počet platných míst, s nimiž Maple počítá. Ilustraci na ob-
rázku 1.19 můžeme srovnat s obrázkem 1.10.

Odstranit uloženou hodnotu v systémové proměnné nelze. Do systémových proměnných
můžeme hodnoty pouze přiřazovat, nebo vrátit příkazem restart nastavení všech systémo-
vých proměnných na jejich původní hodnoty. Provedení příkazu odstraní všechny uložené
hodnoty v paměti (tedy i námi definované proměnné, načtené balíky atd.). Příkaz restart
se proto používá zpravidla na počátku řešení nové úlohy, zejména pak na začátku každé práce
se zápisníkem (aby se předešlo tomu, že budeme používat proměnnou, v níž je z dřívějška
uložena pro nás nesprávná hodnota) [5].
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Obrázek 1.18: Přiřazení hodnot do proměnných a odstranění uložené hodnoty (převzato z [5]).

Obrázek 1.19: Proměnná Digits a příkaz evalf (převzato z [5]).

1.4.4 Balíky

Knihovna příkazů jazyka Maple je rozdělena na hlavní knihovnu a tzv. balíky9. Příkazy, s ni-
miž jsme se doposud setkali, patří do hlavní knihovny, a můžeme je tak používat ihned po
spuštění systému. Naproti tomu většina speciálních příkazů náleží do balíků, které musíme
před použitím příslušného příkazu buď načíst do dokumentu pomocí příkazu with, nebo za-
dat příkaz spolu s názvem balíku. Načtení balíku pomocí příkazu with umožní používání
všech příkazů z příslušného balíku. Naopak zadání příkazu spolu s názvem balíku je nutné
provádět při každém použití tohoto příkazu, pokud balík nenačteme (příkazem with).

Načtení balíku můžeme zrušit příkazem unwith. Pokud balík nenačteme a použijeme
z něj nějaký příkaz, Maple jej nerozpozná a příkaz vypíše jako textový řetězec. Například
příkazy pro práci s vektory a maticemi náleží do balíku LinearAlgebra. Jestliže chceme
tedy použít příkaz Eigenvalues pro nalezení vlastních čísel matice, načteme nejprve balík
LinearAlgebra, jak dokumentuje obrázek 1.20 [5].

9Kromě pojmu balík se v češtině používá také termín knihovna.
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Obrázek 1.20: Použití balíků.

Jedním z významných balíků je balík s názvem RealDomain. Systém Maple pracuje s
komplexními čísly a právě balík RealDomain umožňuje omezit se pouze na množinu reálných
čísel10 (obrázek 1.21).

Obrázek 1.21: Použití balíku RealDomain.

10Úplný seznam případů (resp. příkazů), v nichž se můžeme pomocí tohoto balíku omezit jen na reálná
čísla, nalezneme v nápovědě k balíku RealDomain
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Jednotky

Práci s jednotkami umožňuje balík Units. Při výpočtech tak nemusíme pracovat jen s čísly,
ale můžeme jim přiřazovat i jednotky. K vložení jednotek do zápisníku využijeme palety
Units. Obrázek 1.22 ilustruje použití jednotek při výpočtu gravitační síly působící v tíhovém
poli Země (kde gravitační zrychlení je přibližně rovno 9,81 ms−2) na těleso o hmotnosti
10 kg. Vidíme, že Maple umí jednotky také zjednodušovat (resp. upravovat na jiný tvar).
Ke zjednodušení výrazů přitom slouží příkaz simplify.

Obrázek 1.22: Použití jednotek (převzato z [5]).

Maple rozpoznává jednotky různých soustav a velikostí, s nimiž umí pracovat a vzájemně
je převádět. Pro převod jednotek je k dispozici speciální nástroj zvaný Units Calculator.
Spustit jej můžeme z hlavního menu přes Tools > Assistants > Units Calculator. . ..
Ukázku poskytuje obrázek 1.23.

Pokud chceme použít jednotku, která není v paletě Units, můžeme si ji vytvořit sami
tak, že přidáme jednotku s názvem unit a název přepíšeme. V systému Maple 14 je imple-
mentováno přes 500 jednotek (tzn. v paletě Units je pouze několik vybraných) [5].

Obrázek 1.23: Units Calculator (převzato z [5]).

1.4.5 Řešení rovnic

K řešení rovnic v systému Maple slouží příkaz solve a několik příkazů k němu příbuzných
závislých na typech rovnic, viz tabulka 1.1.
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Tabulka 1.1: Příkazy pro řešení rovnic

Typ rovnice Příkaz pro řešení
Rovnice a nerovnice solve, fsolve
Obyčejné diferenciální rovnice dsolve

Parciální diferenciální rovnice pdsolve

Rovnice v oboru celých čísel isolve

Rovnice v oboru celých čísel v konečném tělese msolve

Lineární integrální rovnice intsolve

Systémy lineárních rovnic LinearAlgebra[LinearSolve]

Rekurentní rovnice rsolve

Pomocí interaktivního prostředí Standard Worksheet můžeme řešit rovnice též pomocí
kontextové nabídky. Zapíšeme rovnici a pravým tlačítkem myši zvolíme požadovaný příkaz.
Obrázek 1.24 ilustruje některé příklady řešení rovnic.

Příkazy pro řešení rovnic nemusí vždy zobrazit všechna řešení. Pokud je chceme zobrazit,
přidáme příkazu solve nepovinný parametr AllSolutions, viz obrázek 1.25 [5].

Obrázek 1.24: Ukázka řešení různých druhů rovnic použitím jednak příkazu, jednak kontextové
nabídky (převzato z [5]).

Symbol Z2∼ na obrázku 1.25 představuje libovolnou celočíselnou proměnnou. Že jde o ce-
ločíselnou proměnnou poznáme podle toho, že se v symbolu vyskytuje písmeno Z. Podobně
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Obrázek 1.25: Zobrazení všech řešení rovnice (převzato z [5]).

by výskyt například písmena C značil proměnnou komplexní. Cifra 2 v symbolu proměnné
označuje pořadí, v jakém byla proměnná v zápisníku zavedena. A nakonec znak ∼ vyja-
dřuje, že proměnná splňuje nějaký předpoklad. Jaké předpoklady proměnná splňuje přitom
zjistíme příkazem about, případně zápisem proměnné a po kliknutí pravým tlačítkem myši
zvolením What Assumptions z kontextové nabídky. V zobrazeném příkladu na obrázku
1.25 je předpoklad celočíselnosti (u již celočíselné) proměnné přebytečný.

Dále může příkaz solve zobrazit výsledek se strukturou RootOf vyjadřující kořen (tj. ře-
šení) rovnice v nevyhodnoceném tvaru. Řešení pak vyhodnotíme buď příkazem allvalues
(pro symbolické vyjádření), nebo příkazem evalf (pro numerické vyjádření) – obrázek 1.26.
Vedle příkazů můžeme též využít pravého tlačítka myši, zvolit z kontextové nabídky položku
All Values (pro symbolické vyjádření) a získaný výsledek převést na numerickou hodnotu
zvolením Approximate > 10 (pro 10 platných míst) z kontextové nabídky.

Obrázek 1.26: Tvar zobrazení řešení rovnice (převzato z [5]).

Symboly Z ve struktuře RootOf nyní nepředstavují celočíselnou proměnnou (neboť za
písmenem Z nenásleduje číslo), nýbrž proměnnou libovolnou (tj. i komplexní).

Systém Maple po zadání příkazu vypíše zpravidla pouze řešení, případně chybová hlášení
či varování. U příkazu solve (a nejen u něj) toto chování způsobuje „prázdný výpisÿ v pří-
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Obrázek 1.27: Proměnná infolevel a „prázdný výpisÿ příkazu solve (převzato z [5]).

Obrázek 1.28: Proměnná infolevel a příkaz solve (převzato z [5]).

padě, že Maple žádné řešení nenašel. Pro výpis podrobnějších informací o průběhu vyhod-
nocení příkazu a výsledcích slouží proměnná infolevel. Můžeme ji nastavit buď pro každý
příkaz samostatně, přičemž do hranatých závorek za proměnnou vložíme název příslušného
příkazu, nebo ji nastavíme všem příkazům současně na stejnou hodnotu uvedením slova
all do hranatých závorek. Proměnná může nabývat hodnot 1, 2, . . ., 5. Čím vyšší hodnota
je přiřazena v proměnné infolevel, tím více informací o vyhodnocení příkazu obdržíme.
Standardně není proměnná nastavena na žádnou hodnotu, což v podstatě odpovídá nasta-
vení proměnné na hodnotu 0. Použití proměnné infolevel dokumentují obrázky 1.27 a 1.28
[5].

Příklad 1.12: Řešte nerovnici: |x− 2| < 1 pro x ∈ R.
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Řešení: Pro řešení nerovnice použijeme příkaz solve.

Obrázek 1.29: Řešení příkladu 1.12.

Získaný výsledek odpovídá zápisu x ∈ (1, 3). Výraz RealRange značí reálný interval,
výraz Open(1) vyjadřuje otevřený interval (v bodě 1). Pokud bychom zadali argument pří-
kazu solve do složených závorek (tj. solve({|x-2|<1})), získali bychom výsledek ve tvaru
nerovností.

Příklad 1.13: Řešte nerovnici |x− 2| < 1 pro x ∈ Z.

Příklad 1.14: Řešte nerovnici |x− 2| ≥ 1 pro x ∈ Z.

Příklad 1.15: Určete kořeny polynomu x3 − 3 · x2 − 13 · x+ 15 pro x ∈ R.

Řešení: Kořeny polynomu můžeme určit různými způsoby. Jednak je možné použít příkaz
solve a hledat body, v nichž je polynom nulový. Systém Maple nabízí též příkaz roots pro
hledání kořenů polynomu jedné proměnné. Oba postupy ilustruje obrázek 1.30.

Obrázek 1.30: Řešení příkladu 1.15.

Výstup příkazu roots je tvořen seznamem dvojic. Každá dvojice obsahuje hodnotu ko-
řenu a jeho násobnost.

Příklad 1.16: Řešte nerovnici x ≤ x2 − 12 ≤ 4 · x pro x ∈ R.

Příklad 1.17: Určete obecně kořeny kvadratického polynomu tvaru a · x2 + b · x + c pro
a ∈ R \ {0}, b ∈ R, c ∈ R, x ∈ C. Zamyslete se, jak byste v řešení postupovali, kdybychom
povolili možnost a = 0 a x omezili jen na reálná čísla.

Příklad 1.18: Řešte rovnici tan(x) =
√

3 pro x ∈ R.

Příklad 1.19: Řešte soustavu rovnic

5 · x− 7 · y = −9,

3 · x+ y = 5

pro x ∈ R, y ∈ R.
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2 Matematická analýza s Maple v R

2.1 Výrazy a jejich úpravy

2.1.1 Zjednodušení výrazu

Ke zjednodušení výrazu slouží především příkazy simplify, normal a combine. Příkaz
simplify provádí základní zjednodušení zadaného výrazu, příkaz normal je určen pro úpravy
zlomků a příkaz combine slučuje výrazy. Vybrané příklady použití můžeme pozorovat na ob-
rázku 2.1.

Obrázek 2.1: Zjednodušování výrazů.

2.1.2 Omezující podmínky

Příkazu simplify (stejně jako ostatním příkazům) můžeme doplnit omezující podmínky
(resp. předpoklady), které budou aplikovány při zjednodušování zadaného výrazu. Prove-
deme to buď přidáním druhého parametru assume = podmínka , nebo zápisem assuming
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podmínka za příkaz simplify. Jako druhý parametr můžeme uvést také množinu omezují-
cích rovností. Konkrétní příklady vidíme na obrázku 2.2.

Obrázek 2.2: Zjednodušování výrazů – další možnosti příkazu simplify.

2.1.3 Úprava polynomu

Především pro úpravy polynomů máme k dispozici příkazy collect, coeff, sort, factor
a expand, jejichž použití shrnuje tabulka 2.1 a na příkladech dokumentují obrázky 2.3, 2.4.

Tabulka 2.1: Příkazy pro úpravy především polynomů

Příkaz Použití
collect vytýkání ve výrazech (nejen polynomech)
coeff koeficient u zvoleného členu polynomu
sort setřídění členů polynomu (nebo prvků seznamu)
factor rozklad polynomu na součin kořenových činitelů
expand roznásobení / rozvinutí (nejen u polynomů)

2.1.4 Převod výrazu na jiný tvar

Závěrem této sekce zmíníme velmi univerzální příkaz convert. S jeho pomocí můžeme pře-
vádět zadaný výraz (případně jinou datovou strukturu jako např. seznam) na jiný (zvolený)

27



Obrázek 2.3: Použití příkazů collect, coeff a sort.

Obrázek 2.4: Použití příkazů factor a expand.

tvar1. Obrázky 2.5 a 2.6 ukazují použití příkazu pro převod desetinného čísla na zlomek (při-

1Jelikož má příkaz convertmnoho různých použití, doporučujeme čtenáři podívat se na stránku nápovědy
k tomuto příkazu (viz ?convert).
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dáváme parametr rational) a pro převod výrazu na parciální zlomky (přidáváme parametr
parfrac2).

Obrázek 2.5: Použití příkazu convert.

Jak jsme již viděli, v prostředí Standard Worksheet je obvykle více možností, jak řešit
danou úlohu. U výše uvedených příkladů (na obrázcích 2.1 – 2.6) je možné využít také
kontextové nabídky. Do dokumentu vložíme výraz, který chceme upravovat, klikneme na
něj pravým tlačítkem myši a z kontextové nabídky zvolíme požadovaný příkaz (často i s
upřesněním požadované úpravy, tj. např. vybereme Simplify>Simplify nebo Combine>exp
či Simplify>Assuming Real atp.). Tímto způsobem můžeme obdržet například výsledky
na obrázku 2.7.

2Symbol I v systému Maple značí imagonární jednotku.
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Obrázek 2.6: Možnosti příkazu convert při rozkladu výrazu na parciální zlomky.

Obrázek 2.7: Zjednodušování výrazů pomocí kontextové nabídky.
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Příklad 2.1: Určete hodnotu výrazu
√
x+b · (a·x−b·x)
y3 · (a−b) pro b = 16, x = 9, y = 3.

Řešení: Pro vyřešení máme více možností. Použijme nejprve příkaz simplify podobně
jako na obrázku 2.2. Může se stát, že příkaz neupraví „najednouÿ zadaný výraz až na nej-
jednodušší tvar. V takovém případě (který právě nyní nastane) jej použijeme dvakrát. Další
možností je použít vyhodnocovací příkaz eval.

Obrázek 2.8: Řešení příkladu 2.1.

Příklad 2.2: Vytvořte polynom, který má jeden trojnásobný kořen s hodnotou 3
2 a jeden

dvojnásobný s hodnotou −5. Nechť je výsledný polynom v roznásobeném tvaru.
Řešení: Polynomů splňujících zadání je nekonečně mnoho, připustíme-li možnost mít

i další kořeny. Kořeny jednoznačně určují kořenové činitele polynomu. Polynom mající pouze
kořeny zmíněné v zadání bude tvořený třemi činiteli tvaru (x − 3

2) a dvěma tvaru (x − 5).
Roznásobený tvar získáme příkazem expand.

Obrázek 2.9: Řešení příkladu 2.2.

Příklad 2.3: Zjednodušte výraz cos(n · π) za předpokladu, že n je sudé.
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Příklad 2.4: Zjednodušte výraz
a−b
a+b

1− a
b

.

Příklad 2.5: Zjednodušte výraz

sin(2 · x)− cos(x)
cos(2 · x)− 1 + sin(x)

.

Příklad 2.6: Rozložte na součin: 4 · x2 · (y2 − z2) + 25 · v · (z2 − y2).

Příklad 2.7: Zjednodušte: (2 · h+ 5 · s)2 − (2 · h+ 5 · s) · (2 · h− 5 · s).

Příklad 2.8: Nechť

p1 = x5 + 15 · x4 + 85 · x3 + 225 · x2 + 274 · x+ 120, p2 = x2 + 6 · x+ 8.

Zjednodušte p1
p2

. Výsledek rozložte na součin kořenových činitelů. Výraz p2
p1

rozložte na par-
ciální zlomky.

2.2 Funkce jedné proměnné

2.2.1 Definice funkce

V prostředí Standard Worksheet jsou 2 způsoby, jak definovat funkci. Vytvořme například
funkci f(x) = x2. První možností (k dispozici jen v prostředí Standard Worksheet a pro
matematický režim Math Mode) je napsat funkční předpis stejně, jak jsme to udělali před
chvílí, s tím rozdílem, že namísto rovnítka („=ÿ) použijeme symbol pro přiřazení („:=ÿ),
tedy f(x):=x^2. Po spuštění příkazu musíme v následně zobrazeném vyskakujícím okénku
potvrdit, že se jedná o definici funkce. Druhou možností (platnou i v jiných prostředích
systému Maple), jak vytvořit funkci, je použití šipkové notace. Příkaz pak vypadá následovně:
f:=x->x^2. Šipku vytvoříme pomlčkou následovanou symbolem „větší nežÿ („>ÿ).

V prostředí Standard Worksheet si definování funkce můžeme ulehčit využitím palet.
Buď je možné při vytváření příkazu použít šipku z palety Arrows, nebo můžeme vzít celou
šablonu příkazu vytvoření funkce z palety Expression a modifikovat v ní požadované sym-
boly. Funkční hodnotu definované funkce v daném bodě získáme zápisem názvu funkce spolu
s hodnotami parametrů v závorce (nemusíme přitom zadávat pouze numerické hodnoty).

Důležité je v Maple důsledně rozlišovat funkce a výrazy, lépe řečeno funkční operátory
a výrazy. V matematice totiž užíváme pojem funkce i v případech, které v Maple představují
výrazy (funkční výrazy – např. f(x)). Jestliže vytvoříme výraz, například x^2, a přiřadíme
jej k nějaké proměnné, např. g, jedná se stále pouze o výraz. Hodnotu g pro x = 5 nemůžeme
proto určit jako funkční hodnotu v bodě 5, ale musíme použít vyhodnocovacího příkazu eval,
případně do x přiřadit hodnotu 5. Naproti tomu funkční hodnotu funkce f (nebo vhodněji
řečeno funkčního operátoru) v bodě 5 získáme specifikací argumentu operátoru (funkce) f ,
viz obrázek 2.11 [5].

Dále Maple nabízí příkaz unapply, který ze zadaného výrazu udělá funkci (funkční ope-
rátor). Tento příkaz má dva argumenty: výraz, z něhož chceme udělat funkci, a nezávisle
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Obrázek 2.10: Definice funkce v prostředí Standard Worksheet.

Obrázek 2.11: Rozdíl mezi funkcí a výrazem (převzato z [5] a doplněno).

proměnnou. Podobně máme k dispozici též příkaz apply, který z funkčního operátoru udělá
výraz (aplikuje funkční operátor na zadaný argument/argumenty) – pravá část obrázku 2.11.

Výrazy a funkce můžeme též definovat po částech pomocí příkazu piecewise. Argumenty
v závorce určují vždy nejprve interval následovaný funkční hodnotou na tomto intervalu. Po-
slední množinu bodů již zapisovat nemusíme, stačí funkční hodnota. Maple ji doplní ve zbý-
vající množině zatím nedefinovaných bodů. Je možné též sestrojit funkci, která je definována
pouze na libovolné podmnožině reálných čísel. Pokud má funkce definovaná po částech pouze
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dva různé předpisy, můžeme k jejímu vytvoření využít symbolu otevřené složené závorky
z palety Expression (viz obrázek 2.12) [5].

Obrázek 2.12: Funkce definovaná po částech (převzato z [5]).

2.2.2 Vlastnosti funkcí

Definice 2.1: Definičním oborem funkce f nazýváme množinu všech hodnot, pro něž je
funkce f definována. Značíme ji D(f)3. Oborem hodnot funkce f nazýváme množinu všech
hodnot, kterých funkce f na svém definičním oboru nabývá. Značíme ji H(f)4.

Definice 2.2: Funkce f se nazývá shora ohraničená, pokud existuje K ∈ R tak, že f(x) ≤
K pro všechna x ∈ D(f). Analogicky, funkce f se nazývá zdola ohraničená, pokud existuje
L ∈ R tak, že f(x) ≥ L pro všechna x ∈ D(f). Funkci f nazýváme ohraničenou (omezenou),
pokud je f ohraničená zdola i shora.

3V literatuře je též možné se setkat s označením Dom(f).
4V literatuře je též možné se setkat s označením Im(f), případně R(f).
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Definice 2.3: Funkce f se nazývá sudá, pokud pro všechna x ∈ D(f) platí, že −x ∈ D(f)
a f(x) = f(−x). Funkce f se nazývá lichá, pokud pro všechna x ∈ D(f) platí, že −x ∈ D(f)
a f(x) = −f(−x).

Definice 2.4: Nechť M ⊆ D(f) obsahuje alespoň 2 body. Řekneme, že funkce f je na M
(a) rostoucí, jestliže ∀x1, x2 ∈M : x1 < x2 ⇒ f(x1) < f(x2),
(b) klesající, jestliže ∀x1, x2 ∈M : x1 < x2 ⇒ f(x1) > f(x2),
(c) nerostoucí, jestliže ∀x1, x2 ∈M : x1 < x2 ⇒ f(x1) ≥ f(x2),
(d) neklesající, jestliže ∀x1, x2 ∈M : x1 < x2 ⇒ f(x1) ≤ f(x2),
(e) konstantní, jestliže ∀x1, x2 ∈M : f(x1) = f(x2).

Definice 2.5: Nechť M ⊆ D(f) obsahuje alespoň 2 body. Řekneme, že funkce f je na M
(a) prostá (injektivní), jestliže ∀x1, x2 ∈M : x1 6= x2 ⇒ f(x1) 6= f(x2),
(b) zobrazením na množinu N ⊆ H(f) (surjektivní), jestliže ∀y ∈ N : ∃x ∈M ∧ f(x) = y,
(c) bijektivní z M do N , jestliže je prostá na M a současně je zobrazením na množinu N
(tedy injektivní a surjektivní).

Systém Maple nemá žádné příkazy na určování právě definovaných vlastností. To však
neznamená, že tyto vlastnosti nemůžeme určovat sami. V některých případech nám může
systém Maple pomoci.

I definiční obor a obor hodnot funkce musíme zjistit sami. Systém Maple můžeme efek-
tivně využít pouze v případech, kdy si nejsme jisti, jestli daný bod patří do některé z množin,
a to buď pokusem o vyhodnocení funkce v daném bodě nebo hledáním řešení rovnice, kdy
se uvažovaná funkce rovná danému bodu.

Příklad 2.9: Určete D(f) a H(f) funkce f(x) = ln(x).
Řešení: Z přednášky Matematické analýzy víme, že D(f) = R+ = {x ∈ R|x > 0}

a H(f) = R. Systém Maple bychom využili asi jen v případě, kdybychom si nebyli jistí, jak je
definována funkce ln(x) a chtěli se například přesvědčit, že není definována pro x = 0. V tom
případě bychom mohli zkusit získat funkční hodnotu v bodě 0. Na obrázku 2.13 vidíme, že
obdržíme chybovou zprávu, která je sice trochu matoucí (zmiňováno je dělení nulou), nicméně
funkční hodnota neexistuje. Podobně můžeme například ověřit, že 0 ∈ H(f), řešením rovnice
ln(x) = 0. Upozorněme, že Maple počítá standardně s komplexními čísly, a tak vyhodnocení
funkce ln(x) pro záporné x nezpůsobí žádnou chybu. Jelikož se pohybujeme v oboru reálných
čísel, je třeba se omezit pouze na něj načtením balíku RealDomain (viz obrázek 1.21).

Obrázek 2.13: Řešení příkladu 2.9.

Pro zjištění, zda je funkce (shora, zdola) ohraničená, či nikoliv, můžeme využít příkazů
minimize a maximize pro hledání nejmenších a největších funkčních hodnot. V případě, že
funkce není „v některém směruÿ ohraničená, vrací zmíněné příkazy hodnotu ∞, resp. −∞.
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Další funkční vlastnosti můžeme určovat (ověřovat) za pomoci příkazů evalb nebo verify.
Tyto příkazy otestují, zda je zadaný výraz pravdivý, či nikoliv. Ukažme si to na následujícím
příkladu.

Příklad 2.10: Určete, zda je funkce cos(x) sudá nebo lichá.
Řešení: Opět z přednášky víme, že funkce cos(x) je funkcí sudou. Sudost funkce otes-

tujeme zjištěním pravdivostní hodnoty výrazu cos(x) = cos(−x), lichost podobně podle
pravdivostní hodnoty výrazu cos(x) = −cos(−x). I tentokrát bychom správně měli pou-
žít balík RealDomain, neboť bez něj ověřujeme zmíněné rovnosti pro všechna komplexní x.
V obou případech však získáme stejný výsledek.

Obrázek 2.14: Řešení příkladu 2.10.

Přestože můžeme vytvořit logické výrazy i pro zbylé funkční vlastnosti, příkazy evalb
a verify většinou vracejí hodnotu FAIL jako znamení, že nedokáží o pravdivostní hodnotě
rozhodnout. Některé další příklady je proto potřeba řešit samostatně a systém Maple využít
jen k „drobným podúlohámÿ – jako v následujícím příkladu 2.11.

Příklad 2.11: Určete, zda je funkce cos(x) na R rostoucí, klesající, prostá či bijektivní.
Řešení: Z přednášky víme, že funkce cos(x) na celé množině R žádnou ze zmíněných

vlastností nesplňuje, což můžeme dokázat nalezením protipříkladu. Vezměme např. body
x1 = 0 a x2 = 2 ·π. Platí, že x1 < x2 (tj. x1 6= x2) a současně cos(x1) = cos(x2). Tedy funkce
není rostoucí, není klesající a není prostá, z čehož plyne, že nemůže být ani bijektivní.
Systém Maple tu můžeme použít ke zjišťování funkčních hodnot (i když v tomto případě
známe funkční hodnoty zpaměti).

V praxi se nám však často hodí najít intervaly, v nichž funkce některé vlastnosti splňuje.
Funkce cos(x) je periodická s periodou 2 · π a na intervalech [k · π, (k + 1) · π] pro k ∈ Z
je bijektivní (tedy i prostá), pro sudá k je na těchto intervalech vždy klesající, pro lichá k
rostoucí.

Příklad 2.12: Dokažte, že funkce sin(x) je ohraničená.

Příklad 2.13: Uvažujme funkci f(x) = 1
x2−5·x+6 . Je f sudá nebo lichá? Určete její definiční

obor a obor hodnot. Je f ohraničená?

Příklad 2.14: U následujících funkcí určete, zda jsou sudé, liché, nebo ani jedno.

(a) f(x) = 9− x2, (b) f(x) =
√
x, (c) f(x) = 1

x
.
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Příklad 2.15: Definujte funkci f , pro niž platí:

(a) D(f) = (0, 1), H(f) = (0, 2),

(b) D(f) = R \ {1}, H(f) = R \ {0},

(c) D(f) = R \ {0}, H(f) = R \ {1},

(d) D(f) = R, H(f) = R+, f je prostá,

(e) D(f) = R \ (−2, 2), H(f) = R,

(f) D(f) = R, H(f) = R \ (−2, 2),

(g) D(f) = R, f je prostá a ohraničená,

(h) H(f) = R, f je sudá.

Příklad 2.16: Nalezněte k ∈ R tak, aby byla funkce f(x) = x3 − k · x2 + 2 · x lichá.

Příklad 2.17: U následujících funkcí určete, zda se jedná o bijekci, či nikoliv.

(a) f : R→ R, f(x) = a · x+ b, a, b ∈ R,

(b) f : R+
0 → R+

0 , f(x) =
√
x,

(c) f : R→ R+
0 , f(x) = x2,

(d) f : R→ R, f(x) = x3,

(e) f : R \ {0} → R \ {0}, f(x) = 1
x
.

2.2.3 Inverzní funkce

Definice 2.6: Nechť f je prostá funkce. Funkci f−1, pro niž platí: D(f−1) = H(f) a ∀x ∈
D(f) : ∃y ∈ H(f) tak, že f−1(y) = x⇔ f(x) = y, nazýváme inverzní funkcí.

Poznámka 2.1: Z definice plyne, že funkce a její inverze jsou osově symetrické vzhledem
k přímce y = x.

Systém Maple má uchováno několik základních funkcí s jejich inverzemi v tabulce s ná-
zvem invfunc. Praktičtější je využít příkazů InverseTutor nebo InversePlot z balíku
Student[Calculus1] vykreslujících do jednoho grafu funkci, její inverzi a osu y = x jakožto
osu symetrie. Příkaz InverseTutor provádí zmíněné v mapletu, příkaz InversePlot slouží
pro použití v dokumentu (obrázek 2.15).

Hledat předpis inverzní funkce můžeme rovnou podle definice 2.6, a to řešením rovnice
f(y) = x pro neznámou y.
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Obrázek 2.15: Vykreslení funkce a její inverze.

Obrázek 2.16: Řešení příkladu 2.18.

Příklad 2.18: Nalezněte inverzní funkci k funkci f(x) = x2.
Řešení: Naše odpověď by mohla být velice stručná, neboť funkce f není prostá, a tak k ní

neexistuje funkce inverzní. Nicméně je možné funkci f rozdělit na dvě funkce prosté a hledat
inverzi ke každé zvlášť.

V systému Maple provedeme dříve zmíněný postup, tj. budeme řešit rovnici f(y) = x.
Získáme 2 řešení, a to právě pro 2 „prosté částiÿ funkce f . Pro x ≤ 0 je inverze k x2 rovna
−
√
x, pro x ≥ 0 je rovna

√
x (obrázek 2.16).

Příklad 2.19: Nalezněte inverzní funkce k následujícím funkcím:
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(a) f(x) = 2 · x+ 1,

(b) f(x) = x3,

(c) f(x) = 1+x
1−x ,

(d) f(x) =
√

1− x,

(e) f(x) = 1
x
,

(f) f(x) =
∣∣ 1
x

∣∣.
Příklad 2.20: Existuje funkce, která je sama sobě inverzí? Pokud ano, je jediná, nebo jich
existuje více?

2.2.4 Složená funkce

Operátorem složení funkcí je v systému Maple symbol @ (zavináč). V praxi se bez něj však
obejdeme, když použijeme kulaté závorky. Na obrázku 2.17 je několik příkladů vytvoření
složené funkce, které potvrzují rovnost f(f−1(x)) = x.

Obrázek 2.17: Složená funkce.

2.3 Vykreslení grafu funkce

2.3.1 Vykreslování

Prostředí Standard Worksheet poskytuje několik možností, jak zobrazit graf funkce nebo
výrazu. Nejrychlejší a zřejmě nejjednodušší možností je zapsat do dokumentu výraz (resp.
funkci), který chceme vykreslit, kliknout na něj pravým tlačítkem a z kontextové nabídky
zvolit Plots > 2-D Plot.
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Obrázek 2.18: Zvolení typu vykreslení v Plot Builder (převzato z [5]).

Obrázek 2.19: Okénko pro zadání výrazu z funkčního předpisu a nezávisle proměnných v Plot
Builder (převzato z [5]).
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Dále můžeme využít pomocník Plot Builder, a to dvěma způsoby. Buď opět zapíšeme do
dokumentu výraz z funkčního předpisu, klikneme pravým tlačítkem myši a zvolíme Plots
> Plot Builder, nebo zamíříme do hlavního menu a vybereme Tools > Assistants >
Plot Builder. . .. V prvním případě se objeví okénko Interactive Plot Builder (obrázek
2.18), v němž upřesníme typ vykreslení. Pokud uvažujeme funkci jedné proměnné, volíme
2-D Plot. Je možné volit i jinou možnost jako například vykreslení v polárních souřadnicích
(2-D polar plot). Kliknutím na tlačítko Plot zobrazíme graf v dokumentu [5].

V druhém případě, kdy Plot Builder vyvoláme z hlavního menu, se nám objeví okénko
(viz obrázek 2.19), do nějž zadáme výraz z předpisu funkce, kterou chceme zobrazit (zadání
nám umožní tlačítka Add, resp. Edit), a proměnné (pokud výraz obsahuje pouze proměnné,
systém je vyplní sám). Kliknutím na tlačítko OK přejdeme do již známého okénka pro zvolení
typu vykreslení (obrázek 2.18). Další možností k vykreslení grafu výrazu nebo funkce je příkaz
plot.

Při vykreslování můžeme specifikovat několik atributů měnících podobu grafu. Opět je
několik možností, jak atributy zadávat. Při použití pomocníka Plot Builder se v okénku
Interactive Plot Builder (obrázek 2.18) objevuje tlačítko Options. Kliknutím na toto
tlačítko přejdeme na okénko (viz obrázek 2.21) umožňující nastavit parametry vykreslení
jako jsou rozsah hodnot závisle i nezávisle proměnné, barva a styl vykreslované křivky, titulek
grafu, legenda atd. Užitečné je navíc tlačítko Preview umožňující předběžně si prohlédnout
současný stav a následně pokračovat v dalším nastavování atributů vykreslení grafu.

Obrázek 2.20: Vykreslení grafů pomocí kontextové nabídky a příkazu plot (převzato z [5]).

Při použití příkazu plot můžeme totéž provést specifikací nepovinných parametrů jako
jsou thickness pro tloušťku křivky, color pro její barvu, labels pro popisky os, legend
pro tvar legendy u obrázku, axes pro nastavení souřadých os a další. Ukázku použití příkazu
plot s nastavením některých nepovinných parametrů nabízí obrázek 2.22 [5].

Vzhled grafu můžeme upravovat i po jeho vytvoření a umístění do dokumentu. Jednak lze
na graf kliknout pravým tlačítkem myši a z kontextové nabídky vybírat vlastnosti grafu, které
jsme mohli měnit již dříve, nebo můžeme využít kontextové lišty těsně nad dokumentem. Po
kliknutí levým tlačítkem myši na graf se ve zmíněné liště zobrazí nástroje skupiny nazvané
Plot. K dispozici je též skupina s názvem Drawing. Nástroje v těchto skupinách umožňují
do hotového grafu přidávat text, kreslit, či jinak graf upravovat [5].

Jestliže chceme vykreslit více funkcí (resp. výrazů) do jediného grafu, zapíšeme všechny
do hranatých, případně složených, závorek jako první parametr příkazu plot. Uživatelům
doporučujeme používat spíše hranaté závorky, v nichž systém Maple respektuje pořadí. Po-
kud nechceme u vykreslovaných funkcí nic dále specifikovat, je nám jedno, v jakém pořadí
Maple funkce „vezmeÿ a vykreslí, použijeme libovolné závorky (tj. hranaté nebo složené).
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Obrázek 2.21: Okénko Plot Builder pro nastavení parametrů grafu (převzato z [5]).

Obrázek 2.22: Vykreslení grafu při specifikaci některých nepovinných parametrů (převzato z [5]).
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Pokud však chceme např. každé z křivek přiřadit nějakou barvu, použitím hranatých závorek
se barvy aplikují v tom pořadí, v jakém očekáváme. Při použití složených závorek tomu tak
být nemusí, viz obrázek 2.23.

Obrázek 2.23: Vykreslení grafu více výrazů příkazem plot.

K dispozici je dále příkaz display z balíku plots, kterým můžeme dosáhnout stejného
výsledku. Jednotlivé grafy nejprve vytvoříme a přiřadíme do proměnných, jež dáme jako
parametry právě příkazu display (obrázek 2.24).

Obrázek 2.24: Vykreslení grafu více výrazů pomocí příkazu display.
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2.3.2 Animace

V systému Maple můžeme též vytvářet animace. Animace se skládá z několika grafů, které
jsou po spuštění zobrazené v sekvenci za sebou. Vytvoříme ji buď příkazem animate z balíku
plots, nebo pomocí Plot Builderu. Obrázky 2.25 a 2.26 ukazují nastavení Plot Builderu
pro vytvoření animace, obrázek 2.27 ilustruje tentýž příklad při použití příkazu animate.

Obrázek 2.25: Zadání výrazu z předpisu funkce v Plot Builderu (převzato z [5]).

Ukončení Plot Builderu, resp. provedení příkazu, umístí do dokumentu „prázdnýÿ graf.
Kliknutím na něj zobrazíme skupinu nástrojů v kontextové liště s názvem Animation.
Pomocí těchto nástrojů můžeme animaci spustit, změnit její rychlost, podívat se na libovolný
snímek animace atd.

Animace můžeme upravovat stejně jako grafy, tj. měnit tloušťku, barvu a druh křivky,
souřadné osy, legendu apod. Navíc máme k dispozici několik nepovinných parametrů, díky
nimž můžeme například určit počet grafů, z nichž se animace skládá (parametr frames), nebo
kolik grafů vyjma posledního má zůstat trvale zobrazených po spuštění animace (parametr
trace) [5].
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Obrázek 2.26: Zvolení druhu vykreslení (animace) v Plot Builderu (převzato z [5]).

Obrázek 2.27: Animace vytvořená příkazem animate (převzato z [5]).
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Příklad 2.21: Vykreslete funkci f(x) = x5 + 15 · x4 + 85 · x3 + 225 · x2 + 274 · x+ 120.
Řešení: K vykreslení zadané funkce ji stačí zapsat do dokumentu a použít některý z dříve

uvedených postupů. Musíme však mít na paměti, co bychom rádi na grafu viděli a že je
možné získaný výsledek ovlivnit. Například v tomto případě, když nespecifikujeme rozsah
vykreslení (použije se standardní rozmezí -10. .10) zcela zkreslíme informaci o chování funkce
na intervalu [−5, 0].

Obrázek 2.28: Řešení příkladu 2.21.

Příklad 2.22: K funkci g(x) = e2·x nalezněte inverzní funkci. Vykreslete do jednoho grafu
funkci g(x), její inverzi a funkci f(x) = x. Do grafu přidejte také legendu.

Příklad 2.23: Zkoumejte závislost funkce h(x) = ea·x na parametru a ∈ R (pomocí ani-
mace). Kdy je funkce rostoucí a kdy klesající?

Příklad 2.24: Vraťte se k příkladům 2.12 – 2.20 předchozí sekce a vykreslením grafů se
ujistěte o správnosti vašich odpovědí.

2.4 Limita a spojitost funkce

Definice 2.7: Funkce f(x) má v bodě x0 ∈ R limitu L ∈ R, jestliže ke každému ε > 0
existuje δ > 0 tak, že pro všechna x ∈ (x0 − δ, x0 + δ) různá od x0 platí: |f(x) − L| < ε.
Takovou limitu nazýváme vlastní limitou ve vlastním bodě.

Definice 2.8: Funkce f(x) má v bodě x0 ∈ R limitu L ∈ R zleva, jestliže ke každému
ε > 0 existuje δ > 0 tak, že pro všechna x ∈ (x0 − δ, x0) platí: |f(x) − L| < ε. Analogicky
definujeme limitu zprava.

Definice 2.9: Funkce f(x) má v bodě x0 ∈ R limitu rovnu +∞, jestliže ke každému M ∈ R
existuje δ > 0 tak, že pro všechna x ∈ (x0−δ, x0+δ) různá od x0 platí: f(x) > M . Analogicky
definujeme limitu rovnu −∞. Takovou limitu nazýváme nevlastní limitou ve vlastním bodě.
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Definice 2.10: Funkce f(x) má v bodě +∞ limitu rovnu L ∈ R, jestliže ke každému ε > 0
existuje K ∈ R tak, že pro všechna x > K platí: |f(x) − L| < ε. Analogicky definujeme
limitu v bodě −∞. Takovou limitu nazýváme vlastní limitou v nevlastním bodě.

Příklad 2.25: Definujte limitu zprava.

Příklad 2.26: Definujte nevlastní limitu v nevlastním bodě.

V systému Maple použijeme k výpočtu limity buď příslušný symbol z palety Expression
(a upravíme v něm barevné symboly, jak potřebujeme) nebo příkaz limit, který má povinně
dva parametry – výraz (tj. i funkční výraz) a bod, v němž hledáme limitu. Také je možné
zadat do dokumentu výraz, jehož limitu chceme určit, kliknout na něj pravým tlačítkem
a z kontextové nabídky zvolit položku Limit. Otevře se nám okénko, v němž je dále třeba
specifikovat bod, v němž hledáme limitu. Můžeme dále uvést i typ limity – oboustrannou
(základně zvolená), limitu zleva nebo limitu zprava.

V případě použití palety specifikujeme jednostrannou limitu zapsáním symbolu + nebo
− do exponentu bodu, v němž chceme limitu určit. Příkazu limit můžeme zadat třetí
(nepovinnný) parametr ve tvaru right nebo left pro limitu zprava, resp. zleva. Všechny
zmíněné postupy ilustruje obrázek 2.29. V jeho pravé části je definována funkce a při určování
limit používán funkční výraz f(x). Funkční operátor (tj. f) použít nemůžeme.

Obrázek 2.29: Určení limity v bodě.

Systém Maple v některých případech zobrazuje neočekávané výsledky, které můžeme
označit za chybné. Jedná se například o limity na obrázku 2.30. Vypsaným výsledkem se nám
systém snaží dát omezení na funkční hodnoty v okolí bodu, v němž hledáme limitu. Podle
uvedených definic v tomto textu však musíme konstatovat, že příslušné limity neexistují.

Příklad 2.27: Určete následující limity:

(a) lim
x→0

sin(x)
x

,

(b) lim
x→0

sin(a·x)
sin(b·x) ,

(c) lim
x→0

ex−1
x

,

(d) lim
x→π

2
+

tan(x).
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Obrázek 2.30: Nedostatky Maplu při určování limity.

Příklad 2.28: Určete následující limity:

(a) lim
x→0

3√
x2− 3
√
x

3√
x2+ 3√x

,

(b) lim
x→π

2

cos(x2 )−sin(x2 )
cos(x) ,

(c) lim
x→2

√
x2+5−3
x2−2·x ,

(d) lim
x→−∞

3·x+2√
x2−1

,

(e) lim
x→−∞

5x+3x

4x ,

(f) lim
t→0

sin(t)·cos(t)
t−t2 .

Jak byste limity určovali bez systému Maple?

Příklad 2.29: Definujte funkci, která:

(a) má vlastní limitu ve vlastním bodě,

(b) má vlastní limitu v nevlastním bodě,

(c) má nevlastní limitu ve vlastním bodě,

(d) má nevlastní limitu v nevlastním bodě,

(e) splňuje všechny předchozí body (a) – (d).

Jak jsme se zmínili v sekci 1.3.4, Maple obsahuje pomocné nástroje, které nám ulehčují
řešení úloh a pomáhají v učení některých matematických postupů při jejich řešení. Jedním
z takových nástrojů je maplet zvaný Limit Methods. Spustíme jej z hlavní nabídky zvole-
ním Tools > Tutors > Calculus − Single Variable > Limit Methods. . .. Tento nástroj
umí řešit zadané limity krok po kroku pomocí implementovaných matematických pravidel.
Můžeme mu tedy zadat výraz a bod, v němž chceme určit jeho limitu, a nechat například
maplet zobrazit celé řešení krok za krokem kliknutím na tlačítko All Steps. Výsledek tohoto
postupu na příkladu 2.28.(b) můžeme vidět na obrázku 2.31. V mapletu si však můžeme zob-
razit pouze následující krok výpočtu, pokusit se použít některé z implementovaných pravidel
nebo požádat o nápovědu, které pravidlo použít.

Definice 2.11: Řekneme, že funkce f(x) je spojitá v bodě x0, pokud má v tomto bodě
vlastní limitu a platí: lim

x→x0
f(x) = f(x0).

Definice 2.12: Řekneme, že funkce f(x) je zprava (resp. zleva) spojitá v bodě x0, pokud
má v tomto bodě příslušnou jednostrannou vlastní limitu a platí: lim

x→x0+
f(x) = f(x0) (resp.

lim
x→x0−

f(x) = f(x0)).
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Obrázek 2.31: Pomocník pro určování limit.

Definice 2.13: Řekneme, že funkce f(x) je spojitá na intervalu J ∈ D(f), pokud

(a) f je spojitá v každém vnitřním bodě intervalu J

(b) a patří-li levý (resp. pravý) koncový bod do intervalu J , je v něm funkce f spojitá
zprava (resp. zleva).

V systému Maple můžeme jednak testovat rovnost limity a funkční hodnoty, jak plyne
z definice. Pro určování spojitosti funkce na intervalu je však možné (a vhodné) využít
příkazu discont hledajícího nespojistosti funkce. Příkaz má dva povinné parametry, a to
výraz, jehož nespojitosti určujeme, a nezávisle proměnnou.

Pokud je funkce y = f(x) nespojitá na daném intervalu jen v konečně mnoha (izolova-
ných) bodech, systém Maple ji v těchto bodech spojuje úsečkami rovnoběžnými s osou y.
Jestliže chceme nespojitosti zobrazit korektně, použijeme nepovinný atribut discont příkazu
plot, který nastavíme na hodnotu true – viz obrázek 2.32.

Od verze Maple 14 je možné také zobrazovat odstranitelné nespojitosti (obrázek 2.33).
Příkaz discont však není možné používat u funkcí definovaných po částech. Výsledkem

příkazu jsou v tomto případě vždy body „podezřeléÿ z nespojitostí. Pro zjištění, zda se jedná
o nespojitosti či nikoliv, je potřeba v těchto bodech provést test (existence a) rovnosti limity
a funkční hodnoty. Obrázek 2.34 ukazuje použití příkazu discont v případě funkce f(x)
zadefinované po částech.
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Obrázek 2.32: Zobrazování nespojitých funkcí.

Příklad 2.30: Nalezněte číslo C ∈ R tak, aby funkce f(x) =

{
x2−16
x−4 . . . x 6= 4

C . . . x = 4
byla spojitá pro všechna x ∈ R.

Řešení: Jelikož x2−16 = (x−4)·(x+4), platí f(x) = x+4 pro x 6= 4, a tedy lim
x→4

f(x) = 8.

Z definice spojitosti pak dostáváme: C = f(4) = 8.

Příklad 2.31: Určete body nespojitosti funkcí:

(a) f(x) =


x+ 1 . . . x ≥ 2

2 · x− 1 . . . 1 < x < 2,

x− 1 . . . x ≤ 1

(b) f(x) = 3·x+3
x2−3·x−4 ,

(c) f(x) = x2−b2
x−b , b ∈ R.
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Obrázek 2.33: Zobrazování nespojitých funkcí a vyznačování odstranitelných nespojitostí.

Obrázek 2.34: Použití příkazu discont u funkce definované po částech.

Příklad 2.32: Nalezněte čísla c, d ∈ R tak, aby funkce f(x) =


3 · x2 − 1 . . . x < 0

c · x+ d . . . 0 ≤ x ≤ 1√
x+ 8 . . . x > 1

byla spojitá pro všechna x ∈ R.

Příklad 2.33: Uveďte příklad funkce, která na uzavřeném intevalu není spojitá, ale má
limitu v každém bodě tohoto intervalu.
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2.5 Derivace funkce

Definice 2.14: Nechť f je funkce, x0 ∈ R. Existuje-li lim
x→x0

f(x)−f(x0)
x−x0 , nazýváme tuto limitu

derivací funkce f v bodě x0.

Poznámka 2.2: Derivace funkce f(x) je funkce, která je definovaná ve všech bodech,
v nichž existuje limita z předchozí definice. Tuto funkci značíme několika způsoby: f ′(x),
df(x)
dx

nebo ∂f(x)
∂x

. Analogicky můžeme definovat druhou derivaci funkce f(x) jako derivaci
funkce f ′(x) a podobně derivace vyšších řádů.

Poznámka 2.3: Limita v definici 2.14 může být vlastní i nevlastní. Podle toho rozlišujeme
také vlastní a nevlastní derivaci. V tomto textu si situaci ulehčíme a budeme uvažovat pouze
vlastní derivace. Z tohoto důvodu budeme slovo „vlastníÿ vynechávat a slovem „derivaceÿ
budeme vždy rozumět vlastní derivaci.

Systém Maple nabízí (jako obvykle) několik možností, jak určit derivaci funkce. Opět
můžeme využít kontextové nabídky (tj. zapsat do dokumentu výraz, který chceme derivovat,
kliknout na něj pravým tlačítkem myši a z nabídky zvolit položku Differentiate s výběrem
nezávisle proměnné). Dále je možné použít oba již uvedené symboly zápisu derivace, které
jsou k dispozici v paletě Expression. Systém Maple (v režimu Document Mode) rozpozná
i zápis f ′(x) (tj. použití apostrofu jako symbolu derivace). Dlaší možností je příkaz diff
mající dva povinné argumenty: výraz a nezávisle proměnnou.

Obrázek 2.35: Přehled možností při výpočtu derivace.

Při počítání derivací musíme být opět opatrní a rozlišovat mezi funkčním operátorem
a výrazem. Všechny zmíněné způsoby určení derivace funkce (nebo lépe výrazu) vrací výsle-
dek jako výraz. Pokud chceme poté určit jeho funkční hodnotu, musíme buď použít příkaz
eval, nebo ze získaného výrazu udělat funkci příkazem unapply, případně použít apostro-
fovou notaci pro zápis derivace, viz obrázek 2.36.

Systém Maple disponuje též příkazem D představujícím diferenciální operátor. Jeho ar-
gumentem je funkční operátor a výsledkem derivace opět jako funkce (funkční operátor) –
pravá část obrázku 2.36.
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Obrázek 2.36: Výpočet derivace v bodě.

Obrázek 2.37: Výpočet derivací vyšších řádů.

Derivace vyšších řádů zadáváme tak, jak jsme zvyklí „s tužkou na papířeÿ. Při použití
příkazu diff se n-tá derivace specifikuje tak, že zadáme nezávisle proměnnou n-krát (jako
argument příkazu)5. Systém Maple (opět pouze v režimu Document Mode) umí rozpoznat
i zápis s číslem derivace v exponentu výrazu v kulatých závorách – toto je nutné při odkliknutí
ještě potvrdit ve vyskakujícím okénku (obrázek 2.37).

5Je možné použít i zkrácený zápis ve tvaru diff(f(x),x$n).
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Stejně jako u limit poskytuje Maple pomocné nástroje pro výpočet derivací. Prvním z nich
je maplet zvaný Derivatives. Spustíme jej z hlavní nabídky zvolením Tools > Tutors >
Calculus − Single Variable > Derivatives. . .. Maplet pro zadanou funkci vypočítá její
první a druhou derivaci, zvolené funkce vykreslí do jednoho grafu.

Obrázek 2.38: Pomocník pro výpočet a zobrazení derivací.

Obrázek 2.39: Pomocník pro výpočet derivací.
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Druhý pomocný nástroj je maplet s názvem Differentiation Methods. Spustíme jej
z hlavní nabídky zvolením Tools > Tutors > Calculus − Single Variable > Differen-
tiation Methods. . .. Stejně jako analogický pomocník u limit umí řešit derivace zadaných
funkcí krok po kroku pomocí implementovaných matematických pravidel (která nalezneme
v nápovědě). Můžeme mu tedy opět zadat výraz a nezávisle proměnnou a nechat maplet
zobrazit celé řešení krok za krokem kliknutím na tlačítko All Steps. Výsledek tohoto po-
stupu můžeme vidět na obrázku 2.39. V mapletu si také můžeme zobrazit pouze následující
krok výpočtu (Next Step), pokusit se použít některé z implementovaných pravidel nebo
požádat o nápovědu (Get Hint), které pravidlo použít.

Příklad 2.34: Určete:

(a) d
dx

(f(x) · g(x)),

(b) d
dx

(f(g(x)),

(c) d
dx

(a · x3 + b · x2 + c · x+ d),

(d) d
dx

(
(x−1)3

x2−1

)
.

Příklad 2.35: Uveďte příklad spojité funkce na intervalu J , která na tomto intervalu není
diferencovatelná (tj. nemá v alespoň jednom bodě derivaci). Dokážete uvést příklad funkce
spojité na intervalu J , která na tomto intervalu nemá derivaci právě ve dvou bodech?

Poznámka 2.4: Geometrickou interpretací derivace funkce f(x) v bodě x0 je směrnice
tečny k funkci f(x) v tomto bodě. Jestliže tedy y = k ·x+ q je rovnicí tečny v bodě x0, pak
k = f ′(x0).

Příklad 2.36: Určete rovnici tečny k funkci f(x) = x2 v bodě x0 = 1. Vykreslete do
jednoho grafu funkci f(x) i tuto tečnu.

Příklad 2.37: Najděte bod x0 tak, aby tečna k funkci f(x) = x3 v tomto bodě byla
rovnoběžná s přímkou y = 12 · x − 5. Vykreslete do jednoho grafu funkci f(x), nalezenou
tečnu a zadanou přímku.

Příklad 2.38: Najděte bod x0 tak, aby tečna k funkci f(x) = x3 v tomto bodě byla kolmá
na přímku y = −1

3 ·x−5. Vykreslete do jednoho grafu funkci f(x), nalezenou tečnu a zadanou
přímku.

2.5.1 Diferenciál

Definice 2.15: Řekneme, že funkce f je diferencovatelná v bodě x0, jestliže je v něm
definovaná a jestliže existuje A ∈ R tak, že lim

h→0

f(x0+h)−f(x0)−A·h
h

= 0. Funkce A · h (h ∈ R)

se nazývá diferenciálem funkce f v bodě x0 a značí se df(x0)(h).

Poznámka 2.5: Jak již bylo zmíněno v příkladu 2.35, „diferencovatelná funkceÿ je totéž
co „funkce mající derivaciÿ.

Diferenciál je možné použít k určení přibližné hodnoty funkce v okolí bodu se známou
funkční hodnotou. V systému Maple se tato „výhodaÿ smazává, jelikož samotný Maple nám
okamžitě vypíše přibližnou funkční hodnotu s „libovolnouÿ přesností. Přesto je možné si na
příkladech význam pojmu ověřit a využít Maple alespoň k dílčím výpočtům.
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Příklad 2.39: Určete přibližně: arctan(1.01).
Řešení: Vyjdeme z definice 2.15. Ta nám říká, že f(x0 +h) ≈ f(x0) +df(x0) ·h. V našem

případě x0 = 1 a h = 0.01. Řešení získané v Maple je znázorněno na obrázku 2.40.

Obrázek 2.40: Řešení příkladu 2.39.

Příklad 2.40: Určete přibližně:
√

51.

Příklad 2.41: Určete přibližně: 3
√

123.

Příklad 2.42: Určete přibližně: 2.954.

2.5.2 Taylorův polynom

Definice 2.16: Nechť n ∈ N∪{0} a f je funkce mající v bodě x0 ∈ R derivace až do řádu
n. Polynom

T fn (x) = f(x0) +
f ′(x0)

1!
· (x− x0) +

f ′′(x0)
2!

· (x− x0)2 + . . .+
f (n)(x0)
n!

· (x− x0)n, x ∈ R,

se nazývá Taylorův polynom stupně n funkce f v bodě x0. Funkci

Rf
n(x) = T fn (x)− f(x)

říkáme Taylorův zbytek a celý výraz

T fn (x) +Rf
n(x)

nazýváme Taylorovým vzorcem.

Poznámka 2.6: Jak jsme si mohli všimnout, aproximace funkční hodnoty pomocí dife-
renciálu je vlastně speciální případ Taylorova polynomu pro n = 1. Taylorův polynom také
můžeme využít k aproximaci funkční hodnoty v okolí bodu se známou funkční hodnotou.
Aproximace je tím přesnější, čím vyšší je n. Díky následující poznámce můžeme zjistit, jak
vysoké musí být n, abychom docílili požadované přesnosti aproximace.

Poznámka 2.7: Nechť jsou splněny předpoklady definice 2.16. Pak existuje číslo Θ ∈ (0, 1)
tak, že

Rf
n(x) =

f (n+1)(x0 + Θ · (x− x0))
(n+ 1)!

· (x− x0)n+1.
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Poznámka 2.8: Když položíme v Taylorově vzorci x0 = 0, všechny výrazy se nám zjedno-
dušší. V takovém případě také někdy mluvíme o Maclaurinově vzorci . Pro Maclaurinův
zbytek pak platí:

Rf
n(x) =

f (n+1)(Θ · x)
(n+ 1)!

· xn+1.

Systém Maple obsahuje příkaz taylor vypisující Taylorův vzorec příslušný zadané funkci
v prvním parametru příkazu. Druhým povinným parametrem je bod, v němž se vzorec reali-
zuje. Standardně je vzorec vypisován pro n = 5, což je o jedna nižší hodnota než základní na-
stavení systémové proměnné Order. Tato proměnná představuje řád Taylorova zbytku, tedy
číslo n+1. Počet členů Taylorova vzorce tak můžeme ovlivnit přenastavením proměnné Order
nebo zapsáním této hodnoty na místo třetího (nepovinného) parametru příkazu taylor6.

Někdy se nám může hodit pracovat pouze s Taylorovým polynomem (tedy bez Taylorova
zbytku). K tomu je potřeba použít příkaz convert, kterému zadáme jako první parametr
Taylorův vzorec (získaný příkazem taylor) a na místo druhého parametru zapíšeme slovo
polynom (čímž se „zbavímeÿ vyjádření Taylorova zbytku pomocí funkce O).

Obrázek 2.41: Ukázka použití příkazu taylor.

Příklad 2.43: Najděte Maclaurinův polynom funkce tan(x) pátého stupně.

Příklad 2.44: Vytvořte Taylorův polynom pro funkci xx čtvrtého stupně v bodě 1.

Příklad 2.45: Pomocí Taylorova polynomu vyjádřete funkci f(x) = x5+x4+x3+x2+x+1
jako polynom v proměnné x− 2.

Jak jsme se zmínili v poznámce 2.6, Taylorův polynom můžeme využít k nalezení přibližné
funkční hodnoty. Díky poznámkám 2.7 a 2.8 máme navíc nástroj, jak určit tuto hodnotu se
zadanou přesností. Podobně jako v případě použití diferenciálu platí i zde, že (podstatně)
jednodušším způsobem získáme dokonce přesnější hodnotu pouhým použitím systému Maple.
Přesto může Maple sloužit jako pomocník při výpočtu a současně díky němu můžeme ověřit,
zda byla splněna požadovaná přesnost výpočtu.

6V tomto případě nedojde ke změně hodnoty uložené v proměnné Order, ovlivněn bude pouze příslušný
výpis příkazu taylor.
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Příklad 2.46: Určete hodnotu Eulerova čísla e s chybou menší než 10−3.
Řešení: Chceme zjistit hodnotu čísla e, vezmeme si proto na pomoc funkci f(x) = ex

a budeme hledat funkční hodnotu f(1). Funkci musíme aproximovat v nějakém jiném bodě
než je bod 1 (neboť pro ten bychom dostali přesnou hodnotu e a v ničem by nám to ne-
pomohlo), současně ale ne příliš daleko od tohoto bodu (čím dále od tohoto bodu bychom
hledali aproximaci, tím nepřesnější bude výsledek). Abychom si situaci co nejvíce zjedno-
dušili, vezmeme bod 0 (který je „blízkoÿ bodu 1), pro nějž máme tvar Taylorova (resp.
Maclaurinova) zbytku určený poznámkou 2.8.

Máme tedy funkci f(x) = ex a víme, že pro příslušný Maclaurinův zbytek platí:

Rex

n (x) =
eΘ·x

(n+ 1)!
· xn+1,

kde Θ ∈ (0, 1). Nás bude zajímat funkční hodnota v bodě 1, tj. pro x = 1 dostáváme:

Rex

n (1) =
eΘ

(n+ 1)!
.

V zadání je požadována přesnost 10−3. Má tedy platit:∣∣Rex

n (1)
∣∣ < 10−3.

Dosazením získáme: ∣∣∣∣ eΘ

(n+ 1)!

∣∣∣∣ =
eΘ

(n+ 1)!
< 10−3.

Nyní je třeba si uvědomit, že eΘ < 3, jelikož Θ ∈ (0, 1). Můžeme proto psát, že platí:

eΘ

(n+ 1)!
<

e3

(n+ 1)!
.

Když nyní najdeme n takové, že
e3

(n+ 1)!
< 10−3,

pak bude jistě platit:
eΘ

(n+ 1)!
< 10−3.

Získané n představuje stupeň Maclaurinova polynomu, takže už zbývá pouze popsaný postup
aplikovat v systému Maple – obrázek 2.42.

Příklad 2.47: S chybou menší než 10−3 určete hodnotu čísla:

(a) 1
e
, (b) 5

√
250.

2.6 Vyšetření průběhu funkce

Než začneme s vyšetřováním průběhu funkce na příkladech, připomeňme si základní důležité
pojmy a jejich vlastnosti.
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Obrázek 2.42: Řešení příkladu 2.46.

Poznámka 2.9: Nechť f(x) je funkce. Pokud f ′(x) > 0 pro všechna x ∈ J , pak je f(x)
na intervalu J rostoucí. Pokud f ′(x) < 0 pro všechna x ∈ J , pak je f(x) na intervalu J
klesající.

Definice 2.17: Řekneme, že funkce f(x) má v bodě x0 ∈ R lokální minimum, jestliže
existuje δ ∈ R, δ > 0 tak, že f(x) ≥ f(x0) pro všechna x ∈ (x0 − δ, x0 + δ). Analogicky
definujeme lokální maximum funkce. Lokální minima a maxima se souhrnně nazývají lokální
extrémy.

Poznámka 2.10: Nechť f(x) je spojitá v bodě x0. Jestliže existuje δ ∈ R, δ > 0 tak, že
f(x) je neklesající na intervalu (x0 − δ, x0) a nerostoucí na intervalu (x0, x0 + δ), má f(x)
v bodě x0 lokální maximum. Analogické tvrzení platí pro lokální minimum.

Poznámka 2.11: V předchozí poznámce jsou záměrně použity výrazy „neklesajícíÿ a „ne-
rostoucíÿ. Lokální minimum (resp. maximum) se totiž může podle definice nacházet i na in-
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tervalu, kde je funkce konstantní. V tom případě se jedná o tzv. neostrý extrém. Pro případ
ostrých extrémů je možné v předchozí poznámce nahradit slovo „neklesajícíÿ za „rostoucíÿ
a „nerostoucíÿ za „klesajícíÿ.

Poznámka 2.12: Body x0, v nichž f ′(x0) = 0, nazýváme stacionárními body . Tyto body
a body, v nichž funkce f(x) nemá derivaci, jsou „podezřeléÿ z toho, že jsou lokálními extrémy
funkce. Jestli se skutečně jedná o extrém, určíme buď podle definice 2.17, poznámky 2.10
nebo poznámky 2.13.

Poznámka 2.13: Nechť f ′(x0) = 0 a f ′′(x0) 6= 0. Pokud f ′′(x0) < 0, má funkce f(x)
v bodě x0 lokální maximum. Pokud f ′′(x0) > 0, má funkce f(x) v bodě x0 lokální minimum.

Definice 2.18: Nechť f(x) je funkce, J interval. Říkáme, že f je konvexní na J , jestliže
pro každé dva body x1, x2 ∈ J , x1 < x2 a každá dvě nezáporná reálná čísla a1, a2 taková, že
a1 + a2 = 1 platí:

f(a1 · x1 + a2 · x2) ≤ a1 · f(x1) + a2 · f(x2).

Pokud za týchž předpokladů platí:

f(a1 · x1 + a2 · x2) ≥ a1 · f(x1) + a2 · f(x2),

říkáme, že f je konkávní na J . Pokud změníme všechny neostré nerovnosti na ostré, mluvíme
o ryzí konvexitě, resp. ryzí konkávitě.

Poznámka 2.14: Nechť f má na intervalu J ⊆ D(f) druhou derivaci. Pokud f ′′(x) ≥ 0
pro všechna x ∈ J , pak je f na J konvexní. Pokud platí ostrá nerovnost, je f na J ryze
konvexní. Analogicky, pokud f ′′(x) ≤ 0 pro všechna x ∈ J , pak je f na J konkávní. V případě
ostré nerovnosti je ryze konkávní.

Poznámka 2.15: Body, v nichž se mění ryzí konvexita funkce na ryzí konkávitu a naopak,
nazýváme inflexními body. Nechť tedy x0 ∈ R, δ ∈ R, δ > 0. Pokud f(x) je na (x0−δ, x0) ryze
konvexní a na (x0, x0 + δ) ryze konkávní (resp. naopak), nazýváme bod x0 bodem inflexním.

Poznámka 2.16: V bodech nespojitosti x0 funkce f(x) zkoumáme, jestli v nich jsou
asymptoty bez směrnice, a to ověřením, zda lim

x→x0−
f(x) = ±∞ nebo lim

x→x0+
f(x) = ±∞.

Dále zkoumáme, zda má funkce f(x) asymptotu (asymptoty) se směrnicí, tj. zda existují
A,B ∈ R tak, že lim

x→∞
f(x) = A · x+B nebo lim

x→−∞
f(x) = A · x+B.

Platí, že

A = lim
x→∞

f(x)
x

(
resp. A = lim

x→−∞

f(x)
x

)
a

B = lim
x→∞

(f(x)− A · x)

(
resp. B = lim

x→−∞
(f(x)− A · x)

)
.

Při vyšetřování průběhu zadané funkce f(x) zkoumáme vlastnosti popsané v předchozích
definicích a poznámkách, spolu s některými dříve zavedenými pojmy. Aplikujeme tak násle-
dující postup:
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1. Zjišťujeme D(f), hledáme nulové body (tj. taková x, pro která f(x) = 0), průsečík
s osou y (tj. f(0)), určujeme, kdy je funkce kladná, záporná, a hledáme body nespoji-
tosti funkce f .

2. Vyšetřujeme funkci f ′(x). Hledáme D(f ′), nulové body a intervaly, kde je funkce f ′(x)
kladná (tj. f(x) je rostoucí) a kde záporná (tj. f(x) je klesající).

3. Vyšetřujeme funkci f ′′(x). Hledáme nulové body a intervaly, kde je funkce f ′′(x) kladná
(tj. f(x) je konvexní) a kde záporná (tj. f(x) je konkávní). Ověřujeme, zda je některý
z dříve nalezených stacionárních bodů lokálním extrémem funkce f(x).

4. Hledáme asymptoty funkce f , a to asymptoty bez směrnice a asymptoty se směrnicí.

5. Vykreslujeme graf funkce f(x).

Příklad 2.48: Vyšetřete průběh funkce f(x) = x · e 1x .
Řešení:
Budeme procházet právě uvedený postup, přičemž budeme využívat možností Maple 14.

1. Definiční obor funkce vidíme na první pohled z jejího předpisu. Funkce není definovaná
pouze v bodě nula, tedy D(f) = R \ {0}. K nalezení nulových bodů a intervalů, kde je
funkce kladná, resp. záporná, využijeme příkaz solve7. V tomto případě však příkaz
žádné řešení nenajde. Musíme jej proto určit „samiÿ. Výraz e

1
x je pro libovolná x

kladný, z čehož plyne, že f(x) > 0 pro x > 0 a f(x) < 0 pro x < 0. Pro nalezení
nespojitostí použijeme příkaz discont.

Obrázek 2.43: Řešení příkladu 2.48 – bod 1.

2. Vypočteme f ′(x). Definiční obor první derivace je stejný jako u původní funkce, tedy
D(f ′) = R \ {0}. Dále použijeme příkaz solve. Nyní již dostáváme všechny požado-
vané výsledky od Maple. Pro nalezení stacionárních bodů je možné též použít pří-
kaz extrema vypisující funkční hodnoty ve stacionárních bodech. Prvním parametrem
příkazu je výraz, jehož stacionární body hledáme, druhým parametrem je množina
omezujících podmínek (když žádné nejsou, uvedeme prázdné složené závorky). Dalším
parametrem je nezávisle proměnná zadané funkce a posledním čtvrtým parametrem je
název proměnnné (v apostrofech), do níž se uloží stacionární body – viz obrázek 2.44.

7Upozorněme, že příkaz solve má jednu „nepříjemnouÿ vlastnost: v případech, kdy nenalezne žádné
řešení, na výstup nic nevypíše a přejde na další řádek.
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Obrázek 2.44: Řešení příkladu 2.48 – bod 2.

3. Vypočteme f ′′(x) a do třetice použijeme příkaz solve, který podobně jako poprvé
nezvládne vypočítat zkoumané nerovnosti. Jelikož je výraz e

1
x vždy kladný, můžeme

nerovnosti zjednodušit a hledat pouze znaménka výrazu x3. Vyhodnocením druhé de-
rivace ve stacionárním bodě x = 1 zjistíme, že se jedná o lokální minimum.

Obrázek 2.45: Řešení příkladu 2.48 – bod 3.

4. Počítáme dříve uvedené limity a zjišťujeme, že zadaná funkce má asymptotu se směrnicí
tvaru y = x+ 1 a asyptotu bez směrnice v bodě x = 0 (obrázek 2.46).
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Obrázek 2.46: Řešení příkladu 2.48 – bod 4.

5. Vykreslíme graf funkce f(x). Použijeme k tomu příkaz plot, jemuž nastavíme něko-
lik nepovinných parametrů pro lepší vzhled. Do grafu vykreslíme zadanou funkci f
(červeně) a asymptotu se směrnicí y = x + 1 (zeleně čárkovaně). Parametr discont
nastavíme na true, aby byla správně zobrazena nespojitost funkce f .

Obrázek 2.47: Řešení příkladu 2.48 – bod 5.
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Příklad 2.49: Vyšetřete průběh funkce f(x) = x
x2+1 .

Řešení:

1. Definiční obor funkce f je celá množina reálných čísel, tj. D(f) = R. K nalezení
nulových bodů a intervalů, kde je funkce kladná, resp. záporná, využijeme klasicky
příkaz solve. Pro nalezení nespojitostí použijeme opět příkaz discont.

Obrázek 2.48: Řešení příkladu 2.49 – bod 1.

2. Postupujeme zcela analogicky předchozímu příkladu. D(f ′) = R

Obrázek 2.49: Řešení příkladu 2.49 – bod 2.

3. Opět postupujeme stejně jako v příkladu 2.48. Tentokrát však získáváme nulové body
druhé derivace zadané funkce. Jak vidíme z intervalů konvexity a konkávity, všechny
tři získané body jsou body inflexní. Stacionární body jsou dva, bod x = 1 je lokálním
maximem funkce f a bod x = −1 jejím lokálním minimem.
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Obrázek 2.50: Řešení příkladu 2.49 – bod 3.

4. Určíme asymptoty se směrnicí a bez směrnice.

Obrázek 2.51: Řešení příkladu 2.49 – bod 4.
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5. Vykreslíme graf funkce f(x).

Obrázek 2.52: Řešení příkladu 2.49 – bod 5.

Příklad 2.50: Vyšetřete průběh funkce:

(a) f(x) = (x2 − 1)3,

(b) f(x) = x
3√x2−1

,

(c) f(x) = (x−1)3

x2
,

(d) f(x) = sin(x) + x,

(e) f(x) =

{
x2 · ln |x| . . . x 6= 0

0 . . . x = 0.

Při vyšetřování průběhu funkce nám mohou dále pomoci některé příkazy nacházející se
v balíku Student[Calculus1]. Představme si alespoň několik z nich. Příkaz FunctionChart
zobrazí graf funkce (zadané jako výraz) s vyznačením významných bodů a funkčních vlast-
ností. Na obrázku 2.53 je zobrazen graf funkce f(x) z příkladu 2.48. Jsou v něm znázorněny
extrémní a limitní body, monotonie funkce a konvexita s konkávitou. Pokud chceme zanést
do grafu méně informací (pro větší přehlednost), můžeme například vypnout zobrazování
konvexity a konkávity nastavením concavity = [].

Díky dalšímu příkazu, Asymptotes, získáme asymptoty funkce (zadané systému jako
výraz) se směrnicí i bez směrnice. Použití na funkcích z příkladů 2.48 a 2.49 ilustruje obrázek
2.54.

Do balíku Student[Calculus1] dále náleží příkazy CriticalPoints pro hledání stacio-
nárních bodů, ExtremePoints pro hledání extrémů, InflectionPoints pro hledání inflex-
ních bodů, Roots pro hledání kořenů a další. Více v nápovědě k balíku Student[Calculus1].
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Obrázek 2.53: Použití příkazu FunctionChart z balíku Student[Calculus1].

Obrázek 2.54: Použití příkazu Asymptotes z balíku Student[Calculus1].

2.7 Integrál funkce

2.7.1 Neurčitý integrál

Definice 2.19: Řekneme, že funkce F (x) je na intervalu I primitivní funkcí k f(x), jestliže
pro všechna x ∈ I platí F ′(x) = f(x).

Poznámka 2.17: Ke každé funkci f(x) spojité na I existuje na intervalu I nekonečně
mnoho primitivních funkcí lišících se o tzv. integrační konstantu.

Definice 2.20: Množinu všech primitivních funkcí k funkci f(x) nazýváme neurčitý inte-
grál a značíme ∫

f(x) dx.
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Poznámka 2.18: Nechť F (x) je primitivní k funkci f(x). Pak platí:∫
f(x) dx = F (x) + C,

kde C ∈ R je integrační konstanta.

V systému Maple máme opět několik možností, jak spočítat integrál ze zadané funkce,
přesněji řečeno, jak k této funkci určit funkci primitivní. Systém Maple totiž k výsledkům
nepřidává integrační konstantu (resp. ji pokládá standardně rovnu 0), což musíme mít stále
na paměti.

Při výpočtu můžeme využít symbol pro integrování z palety Expression, příkaz int,
jehož parametry jsou výraz, který chceme integrovat, a proměnná podle níž integrujeme.
Nakonec můžeme zapsat výraz do dokumentu, kliknout na něj pravým tlačítkem myši a z
kontextové nabídky zvolit Integrate a následně proměnnou, podle níž chceme integrovat
(viz obrázek 2.55).

Obrázek 2.55: Výpočet primitivní funkce.

K výpočtu integrálů se nejčastěji používají 2 základní metody - metoda per partes a sub-
stituční metoda.

Poznámka 2.19: Metoda per partes vychází z pravidla pro derivaci součinu. Její předpis
pro funkce u(x) a v(x) (které mají na daném intervalu spojité derivace) vypadá následovně:∫

u(x) · v′(x) dx = u(x) · v(x)−
∫
u′(x) · v(x) dx.

Substituční metoda poskytuje řešení pro integraci složené funkce. Jestliže F (x) je primitivní
funkcí k f(x) a funkce ϕ(x) má derivaci v každém bodě svého definičního oboru, pak platí:∫

f(ϕ(x)) · ϕ′(x) dx =
∫
f(t) dt = F (t) = F (ϕ(x))

při substituci t = ϕ(x).
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2.7.2 Metoda per partes

Systém Maple obsahuje balík s názvem IntegrationTools. Pro aplikaci metody per partes
slouží příkaz Parts mající dva parametry – integrál, který chceme určit, a funkci, jejíž
derivaci chceme počítat (v poznámce 2.19 tomu odpovídá funkce u(x)). Pro zápis integrálu
se v tomto případě používá příkaz Int8, který vytvoří integrál symbolicky a nevyhodnotí jej
(narozdíl od příkazu int). Pro vyhodnocení symbolicky zapsaného výrazu můžeme použít
příkaz value.

Příklad 2.51: Pomocí metody per partes určete
∫
x · ex dx.

Řešení: V systému Maple použijeme výše popsané příkazy. Při aplikaci metody per partes
máme vždy více možností9, jak volit funkci, která se bude derivovat. Některé možnosti vedou
k cíli, jiné ne, jak je vidět i na tomto řešení (obrázek 2.56). Druhá volba funkce, která se má
derivovat, vedla k ještě výpočetně náročnějšímu integrálu, než byl v zadání.

Obrázek 2.56: Řešení příkladu 2.51.

Příklad 2.52: Pomocí metody per partes určete
∫
x2 · sin(x) dx.

Řešení: Aplikujeme stejný postup jako v předchozím příkladu10. Přestože zvolíme vhodně
funkci, která se bude derivovat, nedospějeme hned k výsledku. Metodu per partes je třeba

8Pozor na to, že Maple rozlišuje malá a velká písmena!
9Ve skutečnosti jich je nekonečně mnoho.
10Pouze nebudeme načítat balík IntegrationTools, neboť jsme jej načetli již dříve.
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v některých případech aplikovat vícekrát, a toto je právě jeden z nich. Takže metodu per
partes aplikujeme na získaný výsledek ještě jednou a získáme hledané řešení (které opět
vyhodnotíme příkazem value).

Obrázek 2.57: Řešení příkladu 2.52.

2.7.3 Substituční metoda

Pro aplikaci substituční metody slouží příkaz Change, opět z balíku IntegrationTools.
Příkaz má dva parametry (zcela analogicky k příkazu Parts) – integrál, který chceme určit,
a substituci, již zamýšlíme použít.

Zavedením substituce přejdeme k jiné proměnné, v níž také obdržíme výsledek. Na závěr
se proto musíme „vrátitÿ k proměnné původní, což provedeme zavedením téže substituce (na-
zpět) pomocí příkazu subs. Příkaz subs má 2 povinné parametry – substituce, jež hodláme
zavést, a výraz, v němž budou substituce aplikovány11.

Příklad 2.53: Pomocí substituční metody určete
∫

sin3(x) · cos(x) dx.
Řešení: Postupujeme analogicky jako v předchozích příkladech. Pokud jsme při předchozí

práci se systémem Maple nenačetli balík IntegrationTools, je třeba jej načíst. Zavedeme
substituci, získáme „tabulkovýÿ integrál, který vyhodnotíme příkazem value, a další substi-
tucí se vrátíme k původní proměnné.

Při výpočtech integrálů se uplatňují i některé další postupy jako například rozklad na
parciální zlomky, pravidlo o integraci součtu funkcí, či pravidlo o integraci funkce násobené
konstantou (podrobnosti najdeme též v nápovědě systému). Pro rozklad na parciální zlomky
je možné použít již dříve zmíněný příkaz convert s parametrem parfrac.

11Upozorněme na rozdíl mezi příkazy Change a subs. Příkaz Change zavede substituci proměnných v za-
daném integrálu, zatímco příkaz subs provede substituce v zadaném výrazu.
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Obrázek 2.58: Řešení příkladu 2.53.

Příklad 2.54: Pomocí vhodné metody (resp. vhodného postupu) určete následující inte-
grály. Příkazem int následně ověřte správnost vašeho výpočtu.

(a)
∫

5·x2−3√
x

dx,

(b)
∫ √

x4−2+x−4

x3
dx,

(c)
∫

(x− 1) · (x− 2) · (x− 3) dx,

(d)
∫

x
(x−1)·(x−2)2 dx,

(e)
∫

1
x3+1 dx,

(f)
∫

cos(5 · x+ 6) dx,

(g)
∫

1
x·ln(x) dx,

(h)
∫
x ·
√
x2 + 1 dx,

(i)
∫
x · cos2(x) dx,

(j)
∫
x · ln(x) dx,

(k)
∫

arctan(x) dx,

(l)
∫
x3 · ex2 dx.

Již jsme se setkali s výukovými nástroji pro výpočet limit a derivací. Podobný nástroj je
k dispozici i pro integrování. Spustíme jej z hlavní nabídky zvolením Tools > Tutors > Cal-
culus – Single Variable > Integration Methods. . .. Maplet nás krok po kroku povede
výpočtem zadaného integrálu, nabízí tradičně nápovědu k jednotlivým krokům a pravidla,
která je možno použít (viz obrázek 2.59).

2.7.4 Určitý integrál

Definice 2.21: Mějme funkci f(x), která je ohraničená na uzavřeném intervalu [a, b]. Roz-
dělme interval [a, b] na n podintervalů a označme toto dělení d. Délku i-tého podintervalu
(pro i = 1, 2, ..., n) i samotný podinterval označme stejným symbolem ∆xi. Označme dále
mi infimum f(x) pro x ∈ ∆xi a Mi supremum f(x) na tomtéž intervalu. Nyní definujeme
dolní integrální součet předpisem:

s(d) =
n∑
i=1

mi ·∆xi
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Obrázek 2.59: Výukový nástroj pro počítání integrálů.

a horní integrální součet předpisem:

S(d) =
n∑
i=1

Mi ·∆xi.

Definice 2.22: Nechť platí předpoklady a označení definice 2.21. Nyní definujeme dolní
integrál jako supremum všech dolních integrálních součtů (pro různá dělení d), tj.:

b∫
a

f(x) dx = sup
d
s(d)

a horní integrál jako infimum všech horních integrálních součtů (pro různá dělení d), tj.:

b∫
a

f(x) dx = inf
d
S(d).

Definice 2.23: Jestliže platí:

b∫
a

f(x) dx =
∫ b

a

f(x) dx,
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pak řekneme, že ohraničená funkce f(x) je na intervalu [a, b] integrovatelná (resp. má ur-
čitý integrál). Společnou hodnotu z předchozí rovnosti nazýváme Riemannovým integrálem
z funkce f(x) na intervalu [a, b] a značíme:

b∫
a

f(x) dx.

Poznámka 2.20: (Newtonova-Leibnizova formule) Jestliže je funkce f(x) na intervalu
[a, b] integrovatelná, funkce F (x) na intervalu [a, b] spojitá a primitivní k f(x), pak platí:

b∫
a

f(x) dx = [F (x)]ba = F (b)− F (a).

K výpočtu určitého integrálu systém Maple nabízí předdefinovaný symbol v paletě Ex-
pression. Je možné použít i příkaz int podobně jako pro neurčitý integrál s tím rozdílem, že
nyní při specifikaci proměnné, podle níž integrujeme, uvádíme i její rozsah (rozsah integrace).

Obrázek 2.60: Výpočet určitého integrálu.

Je samozřejmě možné využít i Newtonovy-Leibnizovy formule, přičemž si pomůžeme
příkazem unapply pro převod výrazu na funkci. Na tomto příkladu si můžeme všimnout, že
různými postupy je možné dojít ke stejnému, ale jinak upravenému výsledku.

Pro geometrickou interpretaci určitého integrálu a názorné zobrazení dříve definovaných
pojmů (dolní integrální součet, horní integrální součet, . . .) poskytuje systém Maple příkaz
RiemannSum z balíku Student[Calculus1]. Příkaz má dva povinné argumenty, a to funkci,
již chceme integrovat, a interval, přes který chceme integrovat. Pokud zadáme jen tyto pa-
rametry, příkaz vypočítá integrální součet pro funkční hodnoty ve středech podintervalů
vzniklých rozdělením původního intervalu a vypíše hodnotu tohoto součtu. K dispozici je
však několik parametrů, které můžeme nastavit.

Prvním je parametr method určující, jakou metodou budou voleny funkční hodnoty v pod-
intervalech vzniklých z rozdělení původního intervalu. Pro dolní integrální součet použijeme
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Obrázek 2.61: Výpočet určitého integrálu pomocí Newtonovy-Leibnizovy formule.

nastavení method=lower, pro horní integrální součet nastavení method=upper (základní na-
stavení odpovídá zápisu method=midpoint). Dalším parametrem je output (výstup). Pro
nás jsou zajímavé zejména možnosti output=plot (zobrazí funkci v grafu i s dělením původ-
ního intervalu a základními informacemi) a output=animation (vytvoří animaci sestávající
z grafů v případě output=plot pro různě jemná dělení původního intervalu)12. Nakonec
uveďme ještě parametr partition specifikující dělení původního intervalu. Parametru je
možné přiřadit číslo (v tom případě se původní interval rozdělí na zadaný počet stejně vel-
kých intervalů) nebo seznam bodů, v nichž se má původní interval rozdělit.

Obrázek 2.62: Geometrická interpretace určitého integrálu – vykreslení.

12V animaci tak můžeme sledovat, jak se pro různě jemná dělení původního intervalu mění hodnota
aproximace integrálu.
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Obrázek 2.63: Geometrická interpretace určitého integrálu – animace.

Pokud nechceme používat příkaz RiemannSum, je možné využít další z nástrojů systému
Maple, který nalezneme v menu zvolením Tools > Tutors > Calculus – Single Variable
> Approximate Integration. . .. V tomto mapletu (obrázek 2.64) můžeme zadat funkci,
interval, počet podintervalů tohoto intervalu a zvolit metodu, která bude použita k výpočtu
určitého integrálu. Na výběr máme přitom i několik dalších metod kromě Riemannových
součtů. Maplet také nabízí srovnání provedené aproximace integrálu a jeho skutečné hodnoty.
Přesto tento nástroj postrádá některé možnosti, které nám poskytuje příkaz RiemannSum.

Příklad 2.55: Pomocí vhodné metody (resp. vhodného postupu) aplikované pomocí exis-
tujících příkazů určete následující integrály. Příkazem int následně ověřte správnost vašeho
výpočtu.

(a)
1∫
0

arctan(x) dx,

(b)
9∫
1

1
1+
√
x
dx,

(c)

π
4∫

0
sin(x) · cos2(x) dx,

(d)
ln(3)∫
ln(2)

ex

e2·x−1 dx,

(e)
2·π∫
0
x2 · cos(x) dx,

(f)
ln(2)∫
0

√
ex − 1 dx.
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Obrázek 2.64: Maplet pro přibližný výpočet určitého integrálu a jeho geometrická interpretace.

2.7.5 Aplikace určitého integrálu

Obsah plochy

Již z geometrické interpretace určitého integrálu vidíme jednu z jeho možných aplikací pro
řešení praktických úloh, a tou je výpočet obsahu plochy vymezené dvěma (případně i více)
křivkami.

Poznámka 2.21: Nechť f(x) je na intervalu [a, b] nezáporná integrovatelná funkce. Pak
pro obsah S plochy vymezené funkcí f(x), osou x a přímkami x = a, x = b platí:

S =

b∫
a

f(x) dx.

Pokud je naopak funkce f(x) na tomto intervalu nekladná, pak pro obsah S plochy vymezené
týmiž křivkami platí:

S = −
b∫

a

f(x) dx.

Z předchozí poznámky můžeme odvodit i jak počítat obsah plochy v případě, kdy funkce
f(x) na intervalu [a, b] protíná osu x (interval rozdělíme na podintervaly, v nichž je funkce
nezáporná, a podintervaly, v nichž je nekladná). Podobně můžeme odvodit, že pro výpočet
obsahu S plochy vymezené funkcemi f(x), g(x) (f(x) ≥ g(x)), a přímkami x = a, x = b
platí:

S =

b∫
a

(f(x)− g(x)) dx.
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Příklad 2.56: Určete obsah plochy vymezené křivkami x2 a x3.

Řešení: V zadání příkladu není zmíněn interval, na kterém se plocha nachází, neboť in-
terval určí samotné křivky x2 a x3 protínající se právě ve dvou bodech. Souřadnice průsečíků
na ose x tvoří hledané body a a b. Průsečíky zadaných funkcí zjistíme např. příkazem solve.
Poté stačí pouze „dosadit do vzorečkuÿ13. Plochu, jejíž obsah počítáme, můžeme zobrazit též
graficky. K vybarvení plochy mezi funkcemi využijeme příkaz transform z balíku plottools.
Definujeme si zobrazení x2− x3, které s pomocí příkazu transform vykreslujeme „vyplněně
(filled) od křivky x3 ke křivce x2ÿ (viz obrázek 2.65).

Obrázek 2.65: Řešení příkladu 2.56.

Funkce je možné zadávat též parametricky, a to například rovnicemi x = ϕ(t),
y = ψ(t), t ∈ [a, b].

13Ještě je třeba vědět, která ze zadaných funkcí je na získaném intervalu „většíÿ.
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Poznámka 2.22: Nechť je funkce f zadána rovnicemi
x = ϕ(t), y = ψ(t), t ∈ [a, b], přičemž funkce ϕ(t), ψ(t) jsou spojité pro t ∈ [α, β]. Je-li ϕ(t)
ryze monotonní a má spojitou derivaci na [a, b], přičemž ϕ(α) = a, ϕ(β) = b, pak pro obsah
S plochy vymezené funkcí f(x), osou x a přímkami x = a, x = b platí:

S =

∣∣∣∣∣∣
β∫
α

ψ(t) · ϕ′(t) dt

∣∣∣∣∣∣ .

Příklad 2.57: Určete obsah plochy vymezené osou x a funkcí zadanou rovnicemi
x = t− sin(t), y = 1− cos(t), t ∈ [0, 2 · π].

Řešení: Funkce x = t− sin(t) je na [0, 2 ·π] ryze monotonní a má spojitou derivaci, takže
můžeme využít předchozí poznámku. Při vykreslování plochy se nyní obejdeme bez příkazu
transform, pouze využijeme atributu filled, jenž nastavíme na hodnotu true. Tím dosáh-
neme vykreslení plochy pod křivkou funkce až k ose x. Pro přehlednější zobrazení vytvoříme
dva grafické objekty, které pomocí příkazu display vykreslíme do jednoho obrázku. Sou-
časně nastavíme atribut scaling na hodnotu constrained, abychom měli na obou osách
stejné měřítko (a graf funkce tak nebyl zkreslený).

Obrázek 2.66: Řešení příkladu 2.57.

Příklad 2.58: Určete obsah plochy ohraničené křivkami:

(a) y = 4− x2, y = x2,

(b) y = x3, y = −x, y = 1,

(c) y = x2, x = y2,

(d) y = tan(x), y = 0, x = π
4 ,

(e) y = ex, y = e−x, y = 2.
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Příklad 2.59: Určete obsah plochy ohraničené:

(a) funkcí y = x2 − 2 · x+ 2, její tečnou v bodě [3, 5] a souřadnými osami,

(b) funkcí y = x3 a tečnou v bodě x = 1,

(c) parabolou y = x2 − 6 · x+ 8 a tečnami v bodech [1, 3] a [4, 0].

Příklad 2.60: Určete obsah plochy ohraničené osou x a křivkou zadanou parametricky:

(a) x = 3 · t2, y = 3 · t− t3, t ∈ [−
√

3,
√

3],

(b) x = 2 · (t− sin(t)), y = 2 · (1− cos(t)), t ∈ [0, 2 · π],

(c) x = 3 · sin3(t), y = 3 · cos3(t), t ∈ [0, π].

Příklad 2.61: Odvoďte vzorec pro obsah kruhu o poloměru r.

Délka oblouku křivky

Poznámka 2.23: Nechť má funkce f(x) spojitou derivaci na intervalu [a, b]. Pak pro délku
křivky l funkce f(x) od bodu a k bodu b platí:

l =

b∫
a

√
1 + (f ′(x))2 dx.

Poznámka 2.24: Nechť je funkce f zadána parametricky rovnicemi x = ϕ(t), y = ψ(t), t ∈
[α, β], přičemž funkce ϕ(t), ψ(t) mají spojité derivace pro t ∈ [α, β]. Pak pro délku křivky l
funkce f od α k β platí:

l =

β∫
α

√
(ϕ′(t))2 + (ψ′(t))2 dt.

Příklad 2.62: Určete délku křivky funkce y = ln(x) mezi body x = 1 a x = 10.
Řešení: Funkce (ln(x))′ = 1

x
je spojitá na [1, 10], můžeme tedy využít poznámky 2.23

(obrázek 2.67).

Příklad 2.63: Určete délku křivky zadané parametricky rovnicemi x = cos3(t), y = sin3(t),
t ∈ [0, 2 · π].

Řešení: Funkce cos3(t), sin3(t) mají na intervalu [0, 2 · π] spojité derivace, takže můžeme
využít poznámky 2.24 (obrázek 2.68).

Příklad 2.64: Určete délku křivky:

(a) y2 = x3 na intervalu [0, 1],

(b) y = ex+e−x

2 na intervalu [−1, 1],

(c) y = sin(x) na intervalu [0, π],

(d) y = sin2(x) na intervalu [0, π].
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Obrázek 2.67: Řešení příkladu 2.62.

Obrázek 2.68: Řešení příkladu 2.63.
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Příklad 2.65: Určete délku křivky zadané parametricky:

(a) x = t2, y = t− t3

3 , t ∈ [0,
√

3],

(b) x = t · cos(t), y = t · sin(t), t ∈ [0, 4 · π],

(c) x = cos(t) + t · sin(t), y = sin(t)− t · cos(t), t ∈ [0, 2 · π].

Příklad 2.66: Odvoďte vzorec pro délku kružnice o poloměru r.

Objem rotačního tělesa

Poznámka 2.25: Nechť je funkce f(x) spojitá a nezáporná na intervalu [a, b]. Pak ro-
tační těleso vzniklé rotací křivočarého lichoběžníka ohraničeného shora funkcí f(x), osou x
a přímkami x = a, x = b kolem osy x má objem V :

V = π ·
b∫

a

f 2(x) dx.

Poznámka 2.26: Nechť je funkce f zadána parametricky rovnicemi x = ϕ(t), y = ψ(t), t ∈
[α, β], přičemž funkce ϕ(t) má spojitou derivaci pro t ∈ [α, β] a funkce ψ(t) je spojitá
a nezáporná pro t ∈ [α, β]. Pak pro objem V rotačního tělesa vzniklého rotací oblasti x ∈
[ϕ(α), ϕ(β)] a y ∈ [0, ψ(t)] kolem osy x platí:

V = π ·
β∫
α

ψ2(t) · |ϕ′(t)| dt.

Příklad 2.67: Vypočtěte objem tělesa, které vznikne rotací oblasti ohraničené křivkami
y = x2, y = 2− x2 kolem osy x.

Řešení: Objem budeme počítat podobně, jako když počítáme obsah plochy vymezené
dvěma křivkami. Přesněji řečeno: vypočteme objem rotačního tělesa, které vznikne rotací
funkce y = 2− x2 kolem osy x, a od něj odečteme objem tělesa, které vznikne rotací funkce
y = x2 kolem osy x. Jelikož obě funkce splňují předpoklady poznámky 2.25, může k vý-
počtu objemu použít uvedený vztah. V systému Maple můžeme jednak vykreslit zadanou
oblast, která má rotovat kolem osy x, jednak můžeme využít příkazu plot3d pro vykreslo-
vání trojrozměrných grafů. Nastavením parametru coords=cylindrical vytvoříme rotační
těleso vzniklé rotací kolem jedné z os. Dále nastavujeme parametry jako úhel, o nějž má za-
daná (resp. zadané) funkce rotovat, a interval oblasti. Příkazu display nakonec nastavíme
parametr orientation pro názornější zobrazení (pootočení grafu), obrázek 2.69.

Poznámka 2.27: Mějme funkci zadanou parametricky rovnicemi x = f(t), y = g(t), z =
h(t), t ∈ [α, β]. Pak těleso vzniklé rotací této funkce kolem osy x je popsáno parametricky
rovnicemi x = f(t), y =

√
g(t)2 + h(t)2 · cos(s), z =

√
g(t)2 + h(t)2 · sin(s), t ∈ [α, β], s ∈

[0, 2 · π].
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Obrázek 2.69: Řešení příkladu 2.67.

Příklad 2.68: Vypočtěte objem tělesa, které vznikne rotací plochy vymezené křivkou za-
danou parametricky rovnicemi x = t− sin(t), y = 1− cos(t), t ∈ [0, 2 · π] a osou x kolem této
osy.

Řešení: Zadaná křivka splňuje předpoklady poznámky 2.26. Výpočet objemu tedy pro-
vedeme dosazením do příslušného vzorce. V systému Maple opět vykreslíme zadanou oblast,
která má rotovat kolem osy x, a poté i získané těleso pomocí příkazu plot3d. Přitom vy-
užijeme poznámky 2.27. Podobně jako v předchozím příkladu použijeme příkaz display
s nastavením parametru orientation pro názornější zobrazení (pootočení grafu), obrázek
2.70.

Příklad 2.69: Určete objem tělesa vzniklého rotací plochy ohraničené zadanými křivkami
kolem osy x:

(a) y2 = x, y = x2,

(b) y = 0, x = 0, y = sin(x), x = π,

(c) y = x, y = 1
x
, y = 2,

(d) x2 + y2 = 4, x+ y = 2.

Příklad 2.70: Určete objem tělesa, které vznikne rotací plochy ohraničené křivkou zada-
nou parametricky a osou x kolem této osy:

(a) x = t2, y = t− t3

3 , t ∈ [0,
√

3],

(b) x = 3 · sin3(t), y = 3 · cos3(t), t ∈ [−π
2 ,

π
2 ],

(c) x = sin2(t), y = 1− cos(t), t ∈ [0, π],

(d) x = 2 + sin(t), y = 2 + cos(t), t ∈ [0, 2 · π].
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Obrázek 2.70: Řešení příkladu 2.68.

Příklad 2.71: Odvoďte vzorec pro objem koule o poloměru r.

Příklad 2.72: Odvoďte vzorec pro objem válce o poloměru podstavy r a výšce válce v.

Příklad 2.73: Odvoďte vzorec pro objem kužele o poloměru podstavy r a výšce kužele v.

Obsah pláště rotačního tělesa

Poznámka 2.28: Nechť je funkce f(x) spojitá a nezáporná na intervalu [a, b] a má zde
spojitou derivaci. Pak pro obsah S rotační plochy vzniklé rotací křivky y = f(x) kolem osy
x platí:

S = 2 · π ·
b∫

a

f(x) ·
√

1 + (f ′(x))2 dx.

Poznámka 2.29: Nechť je funkce f zadána parametricky rovnicemi x = ϕ(t), y = ψ(t), t ∈
[α, β], přičemž funkce ϕ(t) a ψ(t) mají spojité derivace pro t ∈ [α, β] a funkce ψ(t) je
nezáporná pro t ∈ [α, β]. Pak pro obsah S rotační plochy vzniklé rotací grafu funkce f kolem
osy x platí:

S = 2 · π ·
β∫
α

ψ(t) ·
√

(ϕ′(t))2 + (ψ′(t))2 dt.

Příklad 2.74: Vypočtěte obsah pláště rotačního kužele, který vznikne rotací funkce y = x
pro x ∈ [0, 3] kolem osy x.

Řešení: Jelikož platí všechny předpoklady poznámky 2.28, stačí dosadit do uvedeného
vzorce (obrázek 2.71).

83



Obrázek 2.71: Řešení příkladu 2.74. Obrázek 2.72: Řešení příkladu 2.75.

Příklad 2.75: Vypočtěte obsah pláště tělesa, které vznikne rotací křivky zadanou para-
metricky rovnicemi x = cos3(t), y = sin3(t), t ∈ [0, π] kolem osy x.

Řešení: Zadaná křivka splňuje všechny předpoklady poznámky 2.29. Použijeme proto
příslušný vztah pro výpočet obsahu pláště (obrázek 2.72).

Příklad 2.76: Určete obsah pláště tělesa vzniklého rotací plochy ohraničené zadanými
křivkami kolem osy x:

(a) y2 = x, y = x2,

(b) y = 0, x = 0, y = sin(x), x = π,

(c) y = x, y = 1
x
, y = 2,

(d) x2 + y2 = 4, x+ y = 2.

Příklad 2.77: Určete obsah pláště tělesa, které vznikne rotací plochy ohraničené křivkou
zadanou parametricky a osou x kolem této osy:

(a) x = t2, y = t− t3

3 , t ∈ [0,
√

3],

(b) x = 3 · sin3(t), y = 3 · cos3(t), t ∈ [−π
2 ,

π
2 ],

(c) x = sin2(t), y = 1− cos(t), t ∈ [0, π],

(d) x = 2 + sin(t), y = 2 + cos(t), t ∈ [0, 2 · π].
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Příklad 2.78: Odvoďte vzorec pro povrch koule o poloměru r.

Příklad 2.79: Odvoďte vzorec pro povrch válce o poloměru podstavy r a výšce válce v.

K předešlým aplikacím určitého integrálu poskytuje systém Maple několik nástrojů z ba-
líku Student[Calculus1]. Tyto nástroje je možné používat jednak jako příkazy příslušné
knihovny (balíku) nebo je spouštět jako maplety z hlavního menu (Tools > Tutors >
Calculus – Single Variable). Jmenovitě jde o Arc Length (délka křivky), Surface of
Revolution (obsah pláště rotačního tělesa) a Volume of Revolution (objem rotačního
tělesa). Při použití příkazů můžeme mimo jiné specifikovat parametr output určující, zda pří-
kaz vypíše výslednou hodnotu, vzorec s integrálem nebo vykreslí obrázek (v případě příkazu
VolumeOfRevolution je k dispozici i animace). Maplet po zadání předpisu funkce a integrač-
ních mezí provede výpočet odpovídajícího integrálu, který doprovodí grafickým zobrazením.
Obrázek 2.73 ukazuje maplet pro výpočet délky křivky.

Obrázek 2.73: Pomocný nástroj pro výpočet délky křivky.

2.7.6 Nevlastní integrál

Definice 2.24: Nechť je funkce f(x) integrovatelná v každém intervalu [a, t], kde a < t < b,

a nechť je f(x) neohraničená v levém okolí bodu b. Existuje-li vlastní limita lim
t→b−

t∫
a

f(x) dx,
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pak řekneme, že integrál
b∫
a

f(x) dx konverguje, a klademe

b∫
a

f(x) dx = lim
t→b−

t∫
a

f(x) dx.

Pokud zmíněná limita neexistuje nebo je nevlastní, říkáme, že integrál
b∫
a

f(x) dx diverguje.

Poznámka 2.30: V případě neohraničenosti funkce f(x) na intervalu [a, b] v pravém okolí

bodu a definujeme integrál
b∫
a

f(x) dx analogicky.

Příklad 2.80: Určete
1∫
0

1√
1−x2 dx.

Řešení: V systému Maple obdržíme řešení automaticky pouhým zadáním integrálu a pro-

vedením příkazu. Musíme si však uvědomit, že zadaná funkce
(

1√
1−x2

)
není v bodě 1 spojitá

a na intervalu [0, 1] ohraničená! Správně bychom se tedy měli o získaném výsledku přesvědčit
určením limity z definice 2.24.

Obrázek 2.74: Řešení příkladu 2.80.

Příklad 2.81: Určete
1∫
0
x · ln(x) dx.

Poznámka 2.31: Pokud je funkce f(x) neohraničená na intervalu [a, b] v pravém okolí
bodu a i v levém okolí bodu b, rozdělíme interval [a, b] libovolným bodem c ∈ (a, b), čímž
přejdeme k případům popsaným v definici 2.24 a poznámce 2.30.

Definice 2.25: Nechť je funkce f(x) integrovatelná v každém intervalu [a, b], kde a < b.

Existuje-li vlastní limita lim
b→∞

b∫
a

f(x) dx, pak řekneme, že integrál
∞∫
a

f(x) dx konverguje,
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a klademe
∞∫
a

f(x) dx = lim
b→∞

b∫
a

f(x) dx.

Neexistuje-li zmíněná vlastní limita, říkáme, že integrál
∞∫
a

f(x) dx diverguje.

Poznámka 2.32: Analogicky definujeme nevlastní integrál
b∫
−∞

f(x) dx. Je-li funkce f inte-

grovatelná na každém omezeném intervalu, pak řekneme že integrál
∞∫
−∞

f(x) dx konverguje,

jestliže pro nějaké a ∈ R konvergují oba nevlastní integrály
a∫
−∞

f(x) dx,
∞∫
a

f(x) dx a klademe

∞∫
−∞

f(x) dx =

a∫
−∞

f(x) dx+

∞∫
a

f(x) dx.

Příklad 2.82: Určete
∞∫
2

1
x2
dx.

Řešení: V systému Maple obdržíme řešení opět automaticky pouhým zadáním integrálu
a provedením příkazu. Jako v předchozím případě bychom si však měli uvědomit, zda existuje

vlastní limita lim
b→∞

b∫
2

1
x2
dx. Při výpočtu limity Maple zahlásí, že neumí určit, jestli b < 0.

Je možné mu „pomociÿ zavedením předpokladu, že b > 0, pomocí příkazu assume (obrázek
2.75).

Obrázek 2.75: Řešení příkladu 2.82.

Příklad 2.83: Určete následující integrály:
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(a)
∞∫
1

1√
x
dx,

(b)
∞∫
−∞

1
1+x2 dx,

(c)
∞∫
1

sin(x2) dx,

(d)
∞∫
0

x2+1
x3+1 dx.

Doposud jsme se setkali pouze s příklady, kdy Maple umí nalézt symbolické řešení (při
použití „standardníchÿ funkcí). Jsou však případy, kdy Maple zavádí funkce nové či symbo-
lické řešení nenalezne. Pokud Maple zahrne do výsledku novou funkci, najdeme její předpis
v nápovědě. Například na obrázku 2.76 je v řešení zahrnuta tzv. chybová funkce erf(x)
s předpisem

erf(x) =

2 ·
(

x∫
0
e−t

2
dt

)
√
π

.

Jestliže Maple nenalezne symbolické řešení, vypíše námi zadaný příkaz jako výsledek.
V případě určitého integrálu můžeme hledat numerické řešení, a to buď přidáním nepo-
vinného parametru numeric příkazu int, nebo použitím příkazu evalf na integrál zadaný
příkazem Int14. Numerických metod pro výpočet určitého integrálu nabízí Maple několik.
Mezi nimi je možné volit specifikací parametru method (více v nápovědě systému).

Obrázek 2.76: Symbolická a numerická integrace.

14Upozorněme na rozdíl v zadání evalf(Int(..)) a evalf(int(...)). První možnost vede na nume-
rické řešení zadaného integrálu, v druhém případě je nejprve vyhodnocen integrál symbolicky příkazem int
a následně výsledek převeden na numerickou hodnotu příkazem evalf.
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3 Matematická analýza s Maple v Rn

Ačkoli v sobě název kapitoly obsahuje prostor Rn, často se budeme omezovat na funkce dvou
proměnných, tedy prostor R2, pro nějž máme v systému Maple grafickou podporu.

3.1 Funkce více proměnných

3.1.1 Definice funkce více proměnných

Funkci více proměnných definujeme v systému Maple zcela analogicky k funkci jedné pro-
měnné (viz 2.2.1). V prostředí Standard Worksheet používáme tytéž postupy, pouze „přidá-
vámeÿ proměnné.

Obrázek 3.1: Definice funkce dvou proměnných.

3.1.2 Vykreslení funkce dvou proměnných

V závěru předchozí kapitoly jsme se již setkali s příkazem plot3d pro vykreslování trojroz-
měrných grafů. V systému Maple máme tedy možnost vykreslovat funkce dvou proměnných,
a to opět podobnými postupy jako v případě funkce jedné proměnné. První způsob nabízí
kliknutí pravým tlačítkem na funkci (resp. výraz) dvou proměnných v dokumentu a zvolení
Plots > 3-D Plot se specifikací proměnných. Další možnost poskytuje pomocník zvaný
PlotBuilder a nakonec máme k dispozici již zmíněný příkaz plot3d.

Narozdíl od vykreslování funkcí jedné proměnné Maple nyní v grafu standardně nezobra-
zuje souřadnicové osy. Pokud je chceme zobrazit (a na výběr máme z několika typů: normal,
boxed, framed), je třeba při tvorbě grafu specifikovat parametr axes. Graf je možné upra-
vovat i po jeho vytvoření kliknutím pravého tlačítka myši a volením požadovaných parametrů
grafu z kontextové nabídky. Kliknutím na graf a přidržením levého tlačítka myši můžeme
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Obrázek 3.2: Definice funkce více proměnných.

s grafem funkce otáčet podle pohybů myši, případně provádět další úpravy, které si předem
vybereme v kontextové liště, resp. kontextovém menu.

Rozdíl mezi příkazy plot a plot3d je také v povinnosti specifikovat rozsah nezávisle
proměnných. Zatímco u příkazu plot se použije standardní interval [−10, 10] při nezadání
rozsahu, příkaz plot3d zadání rozsahu vyžaduje pro obě nezávisle proměnné, jinak se ne-
provede a vypíše chybové hlášení.

Stejně jako v případě funkce jedné proměnné musíme i zde myslet na to, jak má graf
funkce vypadat a případně vyzkoušet různá nastavení parametrů (tj. např. rozsahů nezá-
visle proměnných), abychom dostali názorný graf. Některá zobrazení mohou velmi zkreslovat
(resp. zobrazovat graf funkce chybně).

Systém Maple kvůli efektivitě (rychlosti) vykreslování počítá funkční hodnoty1 jen v „ně-
kolikaÿ bodech. Graf bývá zpravidla rozdělen na čtvercovou síť bodů, v nichž je spočítána
odpovídající (funkční) hodnota. Parametry sítě se pro různé typy grafů liší, například pro
příkaz plot3d je standardně použita síť 25x25 bodů, pro příkaz implicitplot síť 26x26
bodů atp. Zbylé body grafu jsou získané lineární (rovinnou) interpolací.

Pokud chceme po systému přesnější zobrazení, máme několik možností. První je omezení
rozsahů nezávisle proměnných (viz obrázek 3.4). Můžeme také nastavit parametr numpoints
určující, v kolika bodech bude vypočítána (funkční) hodnota. Další možností je nastavit ex-
plicitně síť počítaných bodů pomocí parametru gridlines. Ten specifikujeme dvojicí v hra-
natých závorkách: [počet bodů na ose x, počet bodů na ose y]2.

1Ve skutečnosti nemusí jít jen o funkční hodnoty, vykreslovat můžeme například i hodnoty vyhovující
nějaké rovnosti (nerovnosti).
2Příkazu implicitplot je možné navíc nastavit parametr gridrefine, který „zjemňujeÿ síť počítaných

bodů. Standardní nastavení je 0. Nastavení na hodnotu 1 (zjednodušeně) znamená, že místo jedné (funkční)
hodnoty v daném místě sítě budou určeny dvě funkční hodnoty. Při dalším zvyšování hodnoty parametru
gridrefine se vždy rekurzivně počítají dvě nové (funkční) hodnoty místo jedné předcházející. Více informací
nalezneme v nápovědě k příkazu implicitplot.
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Obrázek 3.3: Vykreslení funkce dvou proměnných pomocí příkazu plot3d.

Obrázek 3.4: Ukázka různých nastavení příkazu plot3d.
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Obrázek 3.5: Ukázka dalších nastavení příkazu plot3d pro přesnější vykreslení.

3.1.3 Definiční obor funkce dvou proměnných

Systém Maple nám dává možnosti, jak zakreslit do grafu dvourozměrnou (případně i tříroz-
měrnou) oblast. K zakreslení dvourozměrné oblasti zadané implicitně (rovností či nerovností)
slouží příkaz implicitplot z balíku plots. Pokud chceme zadanou oblast vyplnit, nastavíme
parametr filled na hodnotu true.

Pro vykreslení oblastí vymezených více nerovnostmi (resp. rovnostmi) je nutné použít jiný
postup (například takový, který jsme používali k vykreslování ploch v sekci 2.7.5). Pokud je
oblast vymezená lineárními nerovnostmi, je možné použít příkaz inequal z balíku plots.

Příklad 3.1: Nakreslete oblast A = {(x, y) ∈ R2 : x2 + y2 < 1}.
Řešení: Použijeme příkaz implicitplot, kterému navíc specifikujeme i parametr view

pro rozsah souřadných os3 (obrázek 3.6).

Příklad 3.2: Nakreslete oblast A = {(x, y) ∈ R2 : |x|+ |y| ≤ 1}.
Řešení: Právě v tomto případě se projeví nedostatečný počet generovaých bodů pro

vykreslení zadané oblasti. Využijeme proto parametru gridrefine, který poskytuje příkaz
implicitplot (obrázek 3.7).

Příklad 3.3: Nakreslete oblast A = {(x, y) ∈ R2 : x ≥ 0, y ≥ 0, x+ y < 1}.
Řešení: Požadovaná oblast je zadána třemi nerovnostmi, přičemž všechny jsou lineární.

Využijeme proto příkazu inequal. Příkaz má několik nepovinných parametrů, v nichž mů-
žeme například specifikovat barvu, kterou budou vykreslovány body patřící (resp. nepatřící)
do zadané množiny (oblasti) nebo hraniční body (obrázek 3.8).

3Neplést s nastavením rozsahu nezávisle proměnných!
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Obrázek 3.6: Řešení příkladu 3.1.

Obrázek 3.7: Řešení příkladu 3.2.
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Obrázek 3.8: Řešení příkladu 3.3.

Příklad 3.4: Nakreslete oblast:

(a) A = {(x, y) ∈ R2 : |x · y| ≤ 1},

(b) A = {(x, y) ∈ R2 : 0 ≤ x ≤ y ≤ 1},

(c) A = {(x, y) ∈ R2 : (x− 2)2 + y2 ≥ 1},

(d) A = {(x, y) ∈ R2 : x < x2 + y2 ≤ 1},

(e) A = {(x, y) ∈ R2 : 1 ≤ |x|+ |y| < 2}.

Vykreslování dvourozměrných oblastí využijeme při určování definičního oboru funkce
dvou proměnných. Systém Maple nemá žádný nástroj pro nalezení definičního oboru funkce,
nic nám však nebrání využít jej při podúlohách vedoucích k hledanému řešení.

Příklad 3.5: Určete definiční obor funkce f(x, y) =

√(
x2 + (y−2)2

4 − 1
)
· (x2 + y2 − 6 · x)

a zakreslete jej v rovině.
Řešení: Výraz pod odmocninou musí být nezáporný, tj.(

x2 +
(y − 2)2

4
− 1

)
·
(
x2 + y2 − 6 · x

)
≥ 0.

Předchozí nerovnost se nám rozpadne na 2 případy, které bychom dále upravovali. V tuto
chvíli však již můžeme využít příkazu implicitplot a příslušnou oblast – definiční obor
funkce f(x, y) – rovnou vykreslit. Opět je nutné specifikovat některý z parametrů „kvalityÿ
zobrazení, použijeme proto například znovu parametr gridrefine (obrázek 3.9).
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Obrázek 3.9: Řešení příkladu 3.5.

Příklad 3.6: U následujících funkcí určete jejich definiční obor a zobrazte jej v rovině:

(a) f(x, y) =
√

1− x2 − 4 · y2,

(b) f(x, y) =
√

sin(x2 + y2),

(c) f(x, y) = ln(x+ y),

(d) f(x, y) = arccos( x
x+y ),

(e) f(x, y) =
√

1− x2 +
√

1− y2,

(f) f(x, y) = ln (x · ln(y − x)).

V systému Maple je možné vykreslovat též vrstevnice funkcí dvou proměnných, tj. mno-
žiny bodů se stejnou funkční hodnotou. Slouží k tomu příkaz contourplot, případně je
možné vrstevnice zakreslit do grafu funkce nastavením parametru style příkazu plot3d na
hodnotu patchcontour (lze nastavit i dodatečně v kontextové liště či kontextovém menu).

Příkazům contourplot a plot3d můžeme dále zadat parametr contours určující, kolik
vrstevnic se zobrazí4, případně jaké vrstevnice (tj. vrstevnice jakých funkčních hodnot)5.

Příklad 3.7: Zobrazte vrstevnice následujících funkcí:

(a) f(x, y) = x2 − y2,

(b) f(x, y) = 1
x2+y2 ,

(c) f(x, y) = x
y
,

(d) f(x, y) = x · y.

4zadáme přirozené číslo
5zadáme seznam funkčních hodnot
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Obrázek 3.10: Zobrazení vrstevnic funkce dvou proměnných.

3.2 Limita a spojitost funkce více proměnných

3.2.1 Limita funkce

Definice 3.1: Řekneme, že funkce f(x, y) má v bodě [x0, y0] ∈ R2 limitu L ∈ R, jestliže
ke každému ε > 0 existuje δ > 0 tak, že pro všechny [x, y] splňující |x− x0| < δ, |y− y0| < δ
a [x, y] 6= [x0, y0] platí |f(x, y)− L| < ε, a píšeme

lim
(x,y)→(x0,y0)

f(x, y) = L.

Poznámka 3.1: Analogicky k vlastním a nevlastním bodům a limitám definujeme tyto
body i v prostoru R2. Limita se nazývá nevlastní, jestliže je rovna ∞ nebo −∞. V opačném
případě se nazývá vlastní. Nevlastní bod je bod s alespoň jednou souřadnicí rovnou∞ nebo
−∞, tj. bod typu [a,±∞] nebo [±∞, a], kde a ∈ R ∪ {−∞,∞}.

Poznámka 3.2: Taktéž analogicky definujeme příslušné pojmy v prostoru dimenze větší
než 2.

Poznámka 3.3: Zásadní rozdíl mezi limitou funkce jedné proměnné a limitou funkce dvou
proměnných spočívá v okolí limitního bodu a tedy směru přibližování k limitnímu bodu.
U funkce jedné proměnné se blížíme pouze po jedné přímce (a to zleva nebo zprava). Naproti
tomu u funkce dvou (a více) proměnných se k limitnímu bodu blížíme po různých přímkách,
parabolách či jiných množinách. Pokud v daném bodě limita existuje, nesmí záležet na cestě,
po jaké se k tomuto bodu přibližujeme.

V systému Maple máme možnost počítat limity funkcí dvou (i více) proměnných. Nemáme
k tomu však již symbol v paletě Expression, a tak musíme použít příkaz limit. Příkaz po-
užíváme jediný, limitní bod zapíšeme do složených závorek. Pokud bychom použili příkaz
dvakrát za sebou vždy pro jednu proměnnou, tj. např. limit(limit(f(x),x=a),y=b), ne-
počítali bychom dříve definovanou limitu – k limitnímu bodu se totiž v tomto případě blížíme
pouze ve dvou směrech (nejprve po ose x a následně po ose y).
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Obrázek 3.11: Výpočet limity funkce více proměnných.

Systém Maple limitu v mnohých případech neumí určit, i když limita existuje. Často je
proto vhodnější použít „klasickýÿ způsob určení limity a Maple použít jako pomocníka při
dílčích výpočtech a pro vykreslení funkce (výrazu) v blízkosti limitního bodu (pro vyslovení
hypotézy o existenci limity a její hodnotě). Pokud je možné do výrazu, jehož limitu počítáme,
dosadit, řešení je triviální. Pokud při dosazení dostáváme neurčitý výraz typu „0

0ÿ nebo „∞∞ÿ,
upravujeme původní výraz, abychom do něj mohli „dosaditÿ. Nejběžnějšími úpravami jsou
rozšíření zlomků, použití (součtových) vzorců či substituce.

Klíčová je otázka, zda limita vůbec existuje. Pokud očekáváme, že zadaný výraz nemá
limitu, je možné využít přibližování k limitnímu bodu z různých směrů (tj. např. po různých
přímkách, po přímkách a po parabolách, . . .). Pokud dostaneme různé výsledky (limity),
limita neexistuje. Často je využívána transformace do polárních souřadnic a následné při-
bližování se k limitnímu bodu po kružnicích. V tomto případě je nutné mít na paměti,
že výsledná limita nesmí záviset na úhlu (ϕ) a že přibližování se po kružnici je opět pouze
jeden z možných způsobů přibližování se k limitnímu bodu! Nicméně existuje tvrzení, které
nám za jistých předpokladů dovolí určit limitu funkce (výrazu) použitím jen této metody.

Poznámka 3.4: Platí-li pro funkci f(x, y) po transformaci do polárních souřadnic

lim
(x,y)→(x0,y0)

f(x, y) = lim
r→0+

h(r) · g(ϕ),

přičemž
lim
r→0+

h(r) = 0 a g(ϕ) je ohraničená pro ϕ ∈ [0, 2 · π),

pak
lim

(x,y)→(x0,y0)
f(x, y) = 0.

Příklad 3.8: Určete lim
(x,y)→(0,0)

1
x2+y2 .

Řešení: Právě v tomto případě od systému Maple obdržíme chybné řešení.
Již první pohled nám napovídá, že by limita měla existovat a měla být rovna∞. K určení

limity musíme vyjít z definice nevlastní limity. Potřebujeme ukázat, že pro libovolně velké
M ∈ R existuje δ > 0 tak, že pro všechna [x, y] splňující |x| < δ, |y| < δ a [x, y] 6= [0, 0] platí
f(x, y) > M .
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Obrázek 3.12: Pokus o získání řešení příkladu 3.8 v Maple.

Mějme proto libovolné, ale pevné M ∈ R. Položme δ = 1√
2·|M |

. Pro [x, y] splňující

|x| < δ, |y| < δ a [x, y] 6= [0, 0] nyní platí: x2 + y2 < 2 · δ2 = 1
|M | . Z toho už vidíme, že

skutečně f(x, y) > M pro tato [x, y], a tedy

lim
(x,y)→(0,0)

1
x2 + y2

=∞.

Příklad 3.9: Určete lim
(x,y)→(0,0)

x2·y2
x2+y2 .

Řešení: Od systému Maple nezískáme řešení. Nejprve musíme „odhadnoutÿ, zda limita
existuje a pokud ano, čemu je rovna. Z toho vyvodíme postup, jakým vyslovenou hypotézu
dokázat. Díky tvaru zadání nemusíme uvažovat nad změnami znamének, funkční hodnoty
jsou vždy nezáporné. Když se budou x a y blížit k nule, budou „velmi maláÿ. Přitom pro
|x| < 1 a |y| < 1 platí x2 + y2 > x2 · y2 a podíl čitatele a jmenovatele bude tím menší, čím
menší (v absolutní hodnotě) budou x a y. To nás přivádí na myšlenku, že limita existuje a je
rovná nule.

Nyní bychom mohli opět postupovat podle definice. Vzali bychom libovolné, ale pevné ε
a k němu bychom „vytvořiliÿ δ tak, abychom splnili předpoklady definice 3.1 pro L = 0.

Zkusme však k výpočtu limity použít transformaci do polárních souřadnic, tzn. provést
substituci: [x, y] = [r · cos(ϕ), r · sin(ϕ)].

Získali jsme (viz obrázek 3.13) výsledek tvaru r2 ·cos2(ϕ) ·sin2(ϕ). Aplikací poznámky 3.4
dostáváme h(r) = r2 a g(ϕ) = cos2(ϕ) · sin2(ϕ). Platí, že lim

r→0+
h(r) = 0 a g(ϕ) je ohraničená

pro ϕ ∈ [0, 2 · π). Tedy

lim
(x,y)→(0,0)

x2 · y2

x2 + y2
= 0.

Příklad 3.10: Určete lim
(x,y)→(0,0)

x2·y2
x2+y2 přímo z definice limity.
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Obrázek 3.13: Řešení příkladu 3.9.

Příklad 3.11: Určete:

(a) lim
(x,y)→(0,0)

x−2·y
3·x+y ,

(b) lim
(x,y)→(0,0)

x3·y
x4+y4 ,

(c) lim
(x,y)→(0,0)

x·y
x2+y2 ,

(d) lim
(x,y)→(1,1)

x·y√
x2+y2

,

(e) lim
(x,y)→(0,0)

x·y√
x2+y2

,

(f) lim
(x,y)→(0,2)

sin(x·y)
x

,

(g) lim
(x,y)→(0,0)

√
x2+y2+1−1
x2+y2 .

3.2.2 Spojitost funkce

Definice 3.2: Řekneme, že funkce f(x, y) je spojitá v bodě [x0, y0] ∈ R2, jestliže má
v tomto bodě vlastní limitu a platí

lim
(x,y)→(0,0)

f(x, y) = f(x0, y0).

V systému Maple máme pro hledání bodů nespojitosti funkce jedné proměnné příkaz
discont. Ten však „fungujeÿ jen pro funkce jedné proměnné. Pro funkce více proměnných
můžeme využít příkazu singular hledajícího tzv. singularity. Jeho použitím pak můžeme
odhalit některé body nespojitosti. Příkaz singular má však několik „nedostatkůÿ (resp.
„omezeníÿ), takže je vhodnější hledat nespojitosti „klasickyÿ a Maple využívat k dílčím
úkolům.

Příklad 3.12: Je funkce

f(x, y) =

{
x3·y
x4+y4 . . . [x, y] 6= [0, 0]

0 . . . [x, y] = [0, 0]
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spojitá na celém R2?
Řešení: V příkladu 3.11.(b) pilný čtenář zjistil, že funkce f(x, y) nemá v bodě [0, 0] limitu.

Podle definice 3.2 proto f(x, y) není v tomto bodě spojitá.

Příklad 3.13: Určete body nespojitosti u následujících funkcí:

(a) f(x, y) = 1√
x2+y2

,

(b) f(x, y) = sin
(

1
x·y

)
,

(c) f(x, y) = arccos
(
x
y

)
,

(d) f(x, y) = ln |1− x2 − y2|,

(e) f(x, y) =

{
x2·y2
x2+y2 . . . [x, y] 6= [0, 0]

0 . . . [x, y] = [0, 0]
.

Příklad 3.14: Určete C ∈ R tak, aby byla následující funkce spojitá v bodě [0, 0]:

(a) f(x, y) =

{√
x2+y2+1−1
x2+y2 . . . [x, y] 6= [0, 0]

C . . . [x, y] = [0, 0]
,

(b) f(x, y) =

{
x·y

x2+y2 . . . [x, y] 6= [0, 0]

C . . . [x, y] = [0, 0]
.

3.3 Parciální derivace funkce více proměnných

Definice 3.3: Nechť je funkce f(x, y) definována v bodě [x0, y0] a nějakém jeho okolí.
Položme ϕ(x) = f(x, y0). Existuje-li derivace funkce ϕ(x) v bodě x0, nazýváme tuto derivaci
parciální derivací funkce f(x, y) podle proměnné x v bodě [x0, y0] a značíme f ′x(x0, y0)

(
resp.

∂f(x0,y0)
∂x

)
.

Poznámka 3.5: Předchozí definici můžeme zapsat následovně:

f ′x(x0, y0) = lim
x→x0

f(x, y0)− f(x0, y0)
x− x0

.

Poznámka 3.6: Analogicky definujeme f ′y(x0, y0)
(

resp. ∂f(x0,y0)
∂y

)
či parciální derivace funkcí

více proměnných.

V systému Maple máme několik možností, jak určovat parciální derivace funkcí (výrazů).
Jednak máme v paletě Expression již předdefinované symboly pro derivaci ( d

dx
f , ∂

∂x
f), vy-

užít můžeme též příkaz diff fungující pro výrazy libovolného počtu proměnných. Můžeme
též zapsat výraz (funkci) do dokumentu, kliknout pravým tlačítkem myši a z kontextové na-
bídky zvolit Differentiate a proměnnou, podle níž chceme derivovat. Oproti derivaci funkce
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jedné proměnné není možné nyní používat apostrof jako symbol pro derivaci. Respektive to
možné je, ale apostrof má význam parciální derivace podle proměnné x, takže můžeme tímto
způsobem derivovat pouze podle této proměnné.

Stále musíme mít na paměti rozdíl mezi funkcí a výrazem (jak to „vnímáÿ Maple, který
většinou pracuje s výrazem). Pro derivování funkcí z pohledu systému Maple (tj. funkčních
operátorů) máme příkaz D (s nímž jsme se setkali již v případě funkcí jedné proměnné, viz
sekce 2.5). Na obrázku 3.14 vidíme, že výsledek použití příkazu D může být poněkud matoucí
(viz výsledek příkazu D[2](g), kde by bylo vhodnější obdržet (x,y)->1). Příkaz D totiž vždy
vrací opět funkci (funkční operátor).

Obrázek 3.14: Výpočet parciální derivace v Maple.

Poznámka 3.7: Podobně jako v případě derivace funkce jedné proměnné má svůj geome-
trický význam i parciální derivace funkce dvou proměnných. Také parciální derivace funkce
f(x, y) v bodě [x0, y0] je směrnicí tečny k funkci f(x, y), a to v bodě [x0, y0, f(x0, y0)]. Ta-
kových tečen je však nekonečně mnoho. Konkrétně parciální derivace funkce f(x, y) podle
proměnné x je směrnicí tečny ke křivce vzniklé jako průsečík grafu funkce f(x, y) a ro-
viny y = y0. Podobně parciální derivace funkce f(x, y) podle proměnné y je směrnicí tečny
ke křivce vzniklé jako průsečík grafu funkce f(x, y) a roviny x = x0.

Tvrzení poznámky 3.7 nyní zobrazíme graficky. Na pomoc si vezmeme funkci f(x, y) =
x2 + y2 a budeme počítat její parciální derivaci v bodě [−1, 1] podle proměnné x. Podle zmí-
něné poznámky je tato parciální derivace směrnicí tečny v bodě [−1, 1, 2] ke křivce vzniklé
jako průsečík funkce f(x, y) a roviny y = 1. Pro vykreslení funkce f(x, y) použijeme již
známý příkaz plot3d. Pro vykreslení roviny y = 1 použijeme příkaz implicitplot3d k vy-
kreslování objektů v třírozměrném prostoru zadaných implicitně. Následně vykreslíme tečnu

101



k funkci f(x, y) (jejíž směrnici určuje parciální derivace) příkazem spacecurve pro vykres-
lování prostorových křivek zadaných parametricky.

Rovnice tečny je dána rovnicí z = k ·x+ q, přičemž hodnota k je právě parciální derivace
funkce f(x, y) v bodě [−1, 1] a je tedy rovna −2. Bod q již dopočítáme dosazením bodu
dotyku ([−1, 1, 2]) tečny k funkci f(x, y). Nakonec do grafu ještě pro názornost zaneseme bod
dotyku pomocí příkazu pointplot3d. Vše vykreslíme najednou příkazem display a získáme
obrázek 3.156.

Obrázek 3.15: Geometrický význam parciální derivace.

Definice 3.4: Nechť bod [x0, y0] patří do definičního oboru parciální derivace funkce
f(x, y). Existuje-li parciální derivace funkce f ′x(x0, y0) podle proměnné x v bodě [x0, y0],
nazýváme tuto derivaci parciální derivací 2. řádu funkce f(x, y) v bodě [x0, y0] podle pro-
měnné x a značíme

f ′′xx(x0, y0)

(
resp.

∂2f(x0, y0)
∂x2

)
.

6Všechny použité příkazy kromě příkazu plot3d náleží balíku plots, který je potřeba načíst před jejich
použitím (případně používat spolu s voláním příslušného balíku).
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Existuje-li parciální derivace funkce f ′x(x0, y0) podle proměnné y v bodě [x0, y0], nazýváme
tuto derivaci smíšenou parciální derivací 2. řádu funkce f(x, y) v bodě [x0, y0] a značíme

f ′′xy(x0, y0)

(
resp.

∂2f(x0, y0)
∂x∂y

)
.

Poznámka 3.8: Analogicky definujeme „zbyléÿ parciální derivace 2. řádu a parciální de-
rivace vyšších řádů.

V systému Maple postupujeme při zadávání parciálních derivací vyšších řádů podobně,
jak tomu bylo u derivací vyšších řádů v případě funkce jedné proměnné.

Obrázek 3.16: Parciální derivace vyšších řádů funkcí více proměnných.

Poznámka 3.9: (Schwarzova věta) Nechť má funkce f(x, y) spojité smíšené parciální de-
rivace f ′′xy a f ′′yx v bodě [x0, y0]. Pak platí:

f ′′xy(x0, y0) = f ′′yx(x0, y0).

Příklad 3.15: Určete všechny parciální derivace 1. a 2. řádu u následujících funkcí:
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(a) f(x, y) = x2 · y + ln
(
x
y

)
,

(b) f(x, y) = (x2 · y + y)4,

(c) f(x, y) = xy,

(d) f(x, y) = x · y · ln (x+ y).

Příklad 3.16: Určete všechny parciální derivace 1. řádu funkce f(x, y) v bodě A:

(a) f(x, y) = ln
(
x+

√
x2 + y2

)
, A = [1, 2],

(b) f(x, y) =
(
1 + logy(x)

)3
, A = [e, e],

(c) f(x, y) = ln
(
x+ y

2·x

)
, A = [1, 2].

3.3.1 Směrové derivace

Definice 3.5: Nechť f je funkce n proměnných, X = [x1, x2, ..., xn] vnitřní bod D(f)
a u = (u1, u2, ..., un) vektor. Nechť ϕ(t) = f (X + t · u). Má-li funkce ϕ(t) derivaci v bodě
t = 0, nazýváme ji derivací funkce f v bodě X ve směru vektoru u nebo také směrovou
derivací funkce f a označujeme ji f ′u(X). Tedy:

f ′u(X) = lim
t→0

ϕ(t)− ϕ(0)
t

= lim
t→0

f (X + t · u)− f (X)
t

.

Směrové derivace můžeme počítat buď rovnou z definice nebo využijeme příkaz balíku
Student[MultivariateCalculus] s názvem DirectionalDerivative.

Příklad 3.17: Vypočtěte směrovou derivaci funkce f(x, y) = x2 + y2 v bodě [−2, 2] ve
směru vektoru u = (3, 5).

Řešení: Využijeme příkazu DirectionalDerivative, který má 3 povinné parametry –
výraz, bod, v němž hledáme směrovou derivaci, a příslušný směr (obrázek 3.17).

Obrázek 3.17: Řešení příkladu 3.17.

Systém Maple nabízí dále maplet s názvem Directional Derivative, který můžeme
spustit z hlavní nabídky: Tools > Tutors > Calculus - Multi-Variable > Directional
Derivatives. . .. Maplet pro zadanou funkci, bod a směr vypočítá směrovou derivaci a zobrazí
ji graficky spolu s funkcí a tečnou rovinou v daném bodě. V mapletu je dále možné zobra-
zit animaci sestávající ze směrových derivací v různých směrech ve stejném bodě (ukázku
poskytuje obrázek 3.18).
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Obrázek 3.18: Maplet zobrazující směrové derivace.

Příklad 3.18: Určete směrovou derivaci funkce

(a) f(x, y) = arctan(x · y) v bodě [1, 1] ve směru vektoru u = (
√

2
2 ,
√

2
2 ),

(b) f(x, y) = ln (ex + ey) v bodě [0, 0] ve směru vektoru u = (cos(α), sin(α)).

3.3.2 Diferenciál

Definice 3.6: Řekneme, že funkce f(x, y) je diferencovatelná v bodě [x0, y0], jestliže exis-
tují reálná čísla A, B tak, že

lim
(h,k)→(0,0)

f(x0 + h, y0 + k)− f(x0, y0)− (A · h+B · k)√
h2 + k2

= 0.

Lineární funkce A · h+ B · k proměnných h, k se nazývá (totální) diferenciál funkce v bodě
[x0, y0] a značí se df(x0, y0)(h, k), resp. df(x0, y0).

Poznámka 3.10: Je-li funkce f(x, y) diferencovatelná v bodě [x0, y0], pak má v tomto
bodě parciální derivace a platí A = f ′x(x0, y0), B = f ′y(x0, y0), tj.

df(x0, y0) = f ′x(x0, y0) · h+ f ′y(x0, y0) · k.
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Poznámka 3.11: Tečná rovina k funkci f(x, y) v bodě T = [x0, y0, f(x0, y0)] má tvar

z = f(x0, y0) + f ′x(x0, y0) · (x− x0) + f ′y(x0, y0) · (y − y0).

Podobně jako v případě funkce jedné proměnné využíváme diferenciál k výpočtům od-
hadů funkčních hodnot v okolí bodu, v němž funkční hodnotu známe. I tady pochopitelně
platí, že samotný systém Maple určí funkční hodnotu přesněji. Přesto jej můžeme využít
k dílčím výpočtům a kontrole přesnosti získaných aproximací.

Příklad 3.19: Určete přibližně:
√

1.023 + 1.973.
Řešení: Budeme uvažovat funkci f(x, y) =

√
x3 + y3. Aproximaci získáme podle vztahu:

f(x0 +h, y0 +k) ≈ f(x0, y0)+df(x0, y0) = f(x0, y0)+f ′x(x0, y0) · (x−x0)+f ′y(x0, y0) · (y−y0).

V našem případě: [x0, y0] = [1, 2], [x, y] = [1.02, 1.97]. Systém Maple využijeme k výpočtu
parciálních derivací v příslušných bodech a celkovému součtu vypočtených hodnot (obrázek
3.19).

Obrázek 3.19: Řešení příkladu 3.19.
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Příklad 3.20: Určete přibližně:

(a) 3.050.99,

(b)
√

3.05 · cos(62◦),

(c) arctan(1.02
0.95),

(d) log4(4.01 · 0.972).

Příklad 3.21: Určete rovnici tečné roviny k funkci f(x, y) =
√

1− x2 − y2 v bodě [ 1√
3
, 1√

3
, 1√

3
]

a rovinu i s funkcí vykreslete.
Řešení: Vyjdeme z poznámky 3.11. V Maple vykreslíme funkci f(x, y) i tečnou rovinu

pomocí příkazu plot3d (v němž nastavíme parametr průhlednosti – transparency – pro
větší přehlednost), navíc doplníme i bod dotyku tečné roviny příkazem pointplot3d z balíku
plots (obrázek 3.20).

Obrázek 3.20: Řešení příkladu 3.21.

Příklad 3.22: Určete rovnici tečné roviny a rovinu i s funkcí vykreslete pro:

(a) funkci f(x, y) = x2 + y2 v bodě [2,−1, 5],

(b) funkci f(x, y) = x4 + 2 · x2 · y − x · y + x v bodě [1, 0, 2],

(c) funkci f(x, y) = ln(x2 + y2) v bodě [2, 1, ln(5)],

(d) funkci f(x, y) = ex
2+y2 v bodě [0, 0, 1].
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3.3.3 Taylorův polynom

Definice 3.7: Nechť n ∈ N ∪ {0} a f(x, y) funkce mající v bodě [x0, y0] ∈ R2 a nějakém
jeho okolí spojité parciální derivace až do řádu n. Polynom

T fn (x, y) = f(x0, y0) +
∂f

∂x
(x0, y0) · (x− x0) +

∂f

∂y
(x0, y0) · (y − y0)

+
1
2!
·
(
∂2f

∂x2
(x0, y0) · (x− x0)2 + 2 · ∂

2f

∂x∂y
(x0, y0) · (x− x0) · (y − y0) +

∂2f

∂y2
(x0, y0) · (y − y0)2

)
+...+

1
n!
·

n∑
j=0

(
n

r

)
∂nf

∂xn−j∂yj
(x0, y0) · (x− x0)n−j · (y − y0)j

se nazývá Taylorův polynom stupně n funkce f(x, y) v bodě [x0, y0]. Funkci

Rf
n(x, y) = T fn (x, y)− f(x, y)

říkáme Taylorův zbytek a celý výraz

T fn (x, y) +Rf
n(x, y)

nazýváme Taylorovým vzorcem.
Podobně jako v jednorozměrném případě existuje i nyní „předpisÿ proRf

n(x, y), který nám
řekne, „jak dobrouÿ aproximací dané funkce f(x, y) je polynom T fn (x, y). My jej potřebovat
nebudeme, a proto čtenáře pouze odkážeme na další literaturu (např. [2]).

V systému Maple slouží k získání Taylorova polynomu funkce více proměnných příkaz
mtaylor. Příkaz má 2 povinné parametry, a to výraz (funkční předpis) a seznam proměnných
s případnou specifikací bodu, v němž má být polynom rozvinut. Pokud bod nespecifikujeme,
bude použit nulový bod. Můžeme si dále všimnout, že narozdíl od příkazu taylor v jednoroz-
měrném případě nyní získáme „pouzeÿ Taylorův polynom (bez chybového členu). Stejně jako
dříve využíváme k nastavení řádu chybového členu systémovou proměnnou Order, případně
třetí (nepovinný) parametr příkazu mtaylor (viz obrázek 3.21).

Příklad 3.23: Určete Taylorův polynom pro

(a) funkci f(x, y) = x
y

v bodě [1, 1],

(b) funkci f(x, y) = cos(x)
sin(y) v bodě [0, π2 ],

(c) funkci f(x, y) = sin(x+ y) v bodě [0, 0] tak, aby byl chybový člen řádu 9,

(d) funkci f(x, y, z) = (cos(x+ y)) · z v bodě [0, 0, 0].

Příklad 3.24: Pomocí Taylorova polynomu určete přibližně:

(a)
√

1.023 + 1.973,

(b)
√

3.05 · cos(62◦),

(c) arctan(1.02
0.95),

(d) log4(4.01 · 0.972).
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Obrázek 3.21: Výpis Taylorova polynomu funkce dvou proměnných.

3.4 Extrémy funkce více proměnných

3.4.1 Lokální extrémy

Definice 3.8: Nechť ρ : Rn × Rn → R je funkce, pro niž pro libovolná X, Y, Z ∈ Rn platí:

(a) ρ(X, Y ) ≥ 0,

(b) ρ(X, Y ) = 0⇔ X = Y ,

(c) ρ(X, Y ) = ρ(Y,X),

(d) ρ(X,Z) ≤ ρ(X, Y ) + ρ(Y, Z).

Takovou funkci nazýváme metrikou (resp. vzdáleností) v Rn. Pomocí metriky definujeme ε-
okolí bodu X ∈ Rn jako množinu Oε(X) = {Y ∈ Rn | ρ(X, Y ) < ε}. V případě, že hodnota
ε není podstatná, mluvíme pouze o okolí bodu X.

Definice 3.9: Řekneme, že funkce f : Rn → R nabývá v bodě X∗ ∈ Rn lokálního maxima,
jestliže existuje okolí bodu X∗ takové, že pro všechna X z tohoto okolí platí: f(X) ≤ f(X∗).
Je-li uvedená nerovnost ostrá, mluvíme o ostrém lokálním maximu.

Poznámka 3.12: Zcela analogicky definujeme (ostré) lokální minimum. Minima a maxima
souhrnně nazýváme extrémy.

Příklad 3.25: Napište definici lokálního minima.

Definice 3.10: Mějme funkci f : Rn → R. Bod X∗ ∈ Rn nazveme stacionárním bodem
funkce f , jestliže v bodě X∗ existují všechny parciální derivace funkce f a platí:

∂f

∂xi
(X∗) = 0 pro i = 1, ..., n.
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Poznámka 3.13: Funkce f : Rn → R může mít lokální extrém pouze ve svém stacionárním
bodě nebo v bodě, kde alespoň jedna z parciálních derivací neexistuje [2].

Poznámka 3.14: Nyní se omezíme pouze na funkce dvou proměnných. Nechť má funkce
f(x, y) v okolí bodu [x0, y0] spojité parciální derivace druhého řádu. Označme

H1 = f ′′xx(x0, y0), H2 =

∣∣∣∣∣∣
f ′′xx(x0, y0) f ′′xy(x0, y0)

f ′′yx(x0, y0) f ′′yy(x0, y0)

∣∣∣∣∣∣ .
Pak:

• Když H2 > 0, má funkce f(x, y) v bodě [x0, y0] ostrý lokální extrém.

(a) Pokud navíc H1 > 0, pak je v bodě [x0, y0] lokální minimum.

(b) Pokud navíc H1 < 0, pak je v bodě [x0, y0] lokální maximum.

• Když H2 < 0, nemá funkce f(x, y) v bodě [x0, y0] lokální extrém.

• Když H2 = 0, neumíme o existenci extrému tímto způsobem rozhodnout.

Matici druhých derivací funkce f(x, y), jejíž determinant jsme označili H2, nazýváme Hes-
sovou maticí, její determinant, H2, označujeme jako hessián.

V systému Maple je opět několik cest, po nichž můžeme dospět k lokálním extrémům
zadané funkce. K dispozici máme několik příkazů, které nám mohou pomoci pří dílčím vý-
počtu, případně i nalezení některého z extrémů, žádný příkaz však obecně nedokáže najít
všechny lokální extrémy. Nejuniverzálnější cesta je projít výše popsaný postup, který známe
z přednášky. Systém Maple přitom můžeme využít k vykreslení zadané funkce, výpočtu par-
ciálních derivací (případně rovnou k výpočtu stacionárních bodů pomocí příkazu extrema),
výpočtu Hessovy matice či jejího determinantu. K výpočtu Hessovy matice slouží příkaz
Hessian z balíku VectorCalculus. Pro výpočet determinantu je určen příkaz Determinant
z balíku LinearAlgebra.

Příklad 3.26: Najděte lokální extrémy funkce f(x, y) = (x− 2)2 + (y − 3)2 + 5.
Řešení: Využijeme příkaz extrema k nalezení stacionárních bodů. Následně vypočítáme

Hessovu matici příkazem Hessian a její determinant příkazem Determinant. Na základě
poznámky 3.14 pak rozhodneme o lokálních extrémech (obrázek 3.22).

Příklad 3.27: Najděte lokální extrémy funkce f(x, y) = (y − 3)2 − (x− 2)2 + 5.
Řešení: Postupujeme zcela analogicky k předchozímu příkladu. Využijeme opět příkaz

extrema k nalezení stacionárních bodů, příkaz Hessian k výpočtu Hessovy matice a příkaz
Determinant k určení jejího determinantu. Na základě poznámky 3.14 pak rozhodneme
o lokálních extrémech (obrázek 3.23).

Příklad 3.28: Najděte lokální extrémy funkce f(x, y) = x · y · e−x
2+y2

2 .
Řešení: Postupujeme opět stejně. Nyní získáváme víc stacionárních bodů, pro něž musíme

vyhodnotit Hessovu matici a její determinant. Při tom si „pomůžemeÿ příkazem eval a na-
rozdíl od předchozích příkladů načteme příkazem with potřebné balíky pro příkazy Hessian
a Determinant (obrázek 3.24).
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Obrázek 3.22: Řešení příkladu 3.26.

Obrázek 3.23: Řešení příkladu 3.27.
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Obrázek 3.24: Řešení příkladu 3.28.

Jak jsme zmínili dříve, v systému Maple jsou i některé příkazy hledající extrémy funkcí.
Jedná se především o příkazy minimize a maximize pro nalezení globálního minima či
maxima (symbolicky). Stejné příkazy, ovšem s velkými počátečními písmeny, tj. Minimize
a Maximize z balíku Optimization, hledají globální extrémy numericky. Všem zmíněným pří-
kazům je možné nastavit omezující podmínky, a hledat tak absolutní extrémy na dané mno-
žině (více v další části kapitoly). Můžeme také využít mapletu s názvem Optimization, který
vyvoláme například z hlavního menu zvolením Tools > Assistants > Optimization. . ..
Na výběr máme několik metod, kterými je extrém hledán, tlačítkem Solve vypíšeme řešení,
tlačítkem Plot jej zobrazíme graficky. Jeho ukázku s nalezením globálního minima funkce
f(x, y) = x2 + y2 poskytuje obrázek 3.25.

Příklad 3.29: Najděte lokální extrémy funkce f(x, y) =
√
x2 + y2.

Řešení: Postupujeme stále stejně. V tomto případě však nenalezneme žádné stacionární
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Obrázek 3.25: Optimization maplet.

body. Již z grafu funkce je na první pohled vidět, že funkce má lokální minimum v bodě [0, 0],
v němž neexistuje parciální derivace. Existenci minima můžeme ověřit vyšetřením lokálního
chování funkce v okolí tohoto bodu nebo využitím příkazu minimize. Příkaz volaný s jedním
parametrem vypíše pouze hodnotu minima. Abychom získali i jeho polohu, přidáme druhý
nepovinný parametr location (obrázek 3.26).

Obrázek 3.26: Řešení příkladu 3.29.
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Příklad 3.30: Najděte lokální extrémy funkce:

(a) f(x, y) = x3 + y3 − 3 · x · y,

(b) f(x, y) = x4 − 3 · x2 · y + 3 · y − y3,

(c) f(x, y) = x · y · ln(x2 + y2),

(d) f(x, y) = (x2 + y2) · e−x2−y2 ,

(e) f(x, y) = 3 · x2 − 2 · x · √y + y − 8 · x+ 12,

(f) f(x, y) = y ·
√

1 + x+ x ·
√
y + 1,

(g) f(x, y) = 3−
√
x2 + y2 + 2 ·

√
(x− 2)2 + (y − 3)2.

3.4.2 Absolutní extrémy

Definice 3.11: Mějme funkci f : Rn → R a množinu M ⊂ D(f). Řekneme, že bod X∗ ∈M
je bodem absolutního maxima funkce f na množině M , jestliže pro všechna X z množiny M
platí: f(X) ≤ f(X∗). Je-li uvedená nerovnost ostrá pro všechna X 6= X∗, mluvíme o ostrém
absolutním maximu.

Poznámka 3.15: Zcela analogicky definujeme (ostré) absolutní minimum. Místo pojmu
absolutní minimum (maximum, extrém) používáme někdy termín globální minimum (maxi-
mum, extrém).

Příklad 3.31: Napište definici absolutního minima.

Definice 3.12: Bod X ∈ Rn nazveme bodem uzávěru množiny M ⊆ Rn, jestliže pro
libovolné ε platí: Oε(X) ∩ M 6= ∅. Množina všech bodů uzávěru množiny M se nazývá
uzávěr množiny M a značí se M . Množinu M nazveme uzavřenou, jestliže M = M .

Poznámka 3.16: Nechť je množina M uzavřená a ohraničená a funkce f na množině M
spojitá. Pak f nabývá absolutních extrémů na množině M buď v bodech lokálních extrémů
patřících do množiny M nebo v některém hraničním bodě množiny M .

Při hledání absolutních extrémů můžeme v systému Maple využívat tytéž příkazy jako při
hledání extrémů lokálních, přičemž specifikujeme navíc i množinu, na níž extrémy hledáme.
Má to však svá omezení. Příkazu extrema můžeme zadat omezující podmínky pouze ve tvaru
rovností. Příkazům minimize a maximize je možné zadat omezení ve tvaru rozsahů (inter-
valů) jednotlivých proměnných. Více možností nám nabízí příkazy Minimize a Maximize
z balíku Optimization hledající extrémy numericky a maplet Optimization (viz obrázek
3.25), u nichž můžeme zadávat omezení i ve tvaru neostrých nerovností.

Příklad 3.32: Najděte absolutní extrémy funkce f(x, y) = x2 − y2 + 4 na množině
M : x2 + y2 ≤ 1.

Řešení: Nejprve vykreslíme zadanou funkci i s vyznačením hranice množiny M , které
provedeme příkazem spacecurve. Následně prověříme lokální extrémy příkazem extrema
s následným vyhodnocením determinantu Hessovy matice. Týmž příkazem najdeme extrémy
funkce na hranici množiny M (obrázek 3.27).
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Obrázek 3.27: Řešení příkladu 3.32.

Příklad 3.33: Najděte absolutní extrémy funkce f(x, y) = x2 + y2 + 4 na množině
M : x2 + y2 ≤ 1.

Řešení: Postupujeme stejným způsobem jako v předchozím příkladu. Zadaná funkce má
jeden lokální extrém, který je současně i jejím globálním minimem na množině M . Absolut-
ních maxim je nekonečně mnoho a jsou tvořeny hranicí množiny M (obrázek 3.28).

Příklad 3.34: Najděte absolutní extrémy funkce f(x, y) = x2 + 2 · x · y − 4 · x − 8 · y na
množině M určené přímkami x = 0, x = 1, y = 0, y = 2.

Řešení: K zakreslení hranice množiny M do zadané funkce potřebujeme nyní použít
4× příkaz spacecurve (pro každou přímku – resp. úsečku, zvlášť). Následně nalezneme
stacionární bod funkce příkazem extrema. Tento stacionární bod leží mimo množinu M ,
zadaná funkce je v každém bodě diferencovatelná, absolutní extrémy tedy leží na hranici
množiny M . Díky tvaru M (jedná se o obdélník) ji můžeme jednoduše vyjádřit pomocí dvou
intervalů (rozsahů pro proměnné x a y). Přesně toto omezení je možné zadávat příkazům
minimize a maximize, takže je využijeme7 (obrázek 3.29).

7Příkazy minimize a maximize v tomto případě neprochází jen hranici množiny M , ale celou množinu
(což nám ale nevadí). Pro jiný tvar množiny M , např. trojúhelník, často musíme procházet jednotlivé části
její hranice, tj. např. jednotlivé úsečky (a hledat na nich extrém).
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Obrázek 3.28: Řešení příkladu 3.33.

Příklad 3.35: Určete absolutní extrémy funkce f(x, y) na množině M :

(a) f(x, y) = x2 + y2,M : x2 + y2 ≤ 1,

(b) f(x, y) = x+ y,M : |x| ≤ 1, |y| ≤ 1,

(c) f(x, y) = |x|+ |y|,M : x2 + y2 ≤ 1,

(d) f(x, y) = x · y − x2 − y2 + x+ y,M je ohraničená přímkami x = 0, y = 0, y = 4− x,

(e) f(x, y) = x2 +2 ·x ·y+2 ·y2−3 ·x−5 ·y,M je trojúhelníková oblast s vrcholy v bodech
A = [0, 2], B = [3, 0], C = [0,−1],

(f) f(x, y) = sin(x) · sin(y) · sin(x+ y),M : x > 0, y ≤ π.

Příklad 3.36: Najděte kladná čísla x, y, z taková, že x+y+z = 18 a x ·y ·z je maximální.
Řešení: Chceme maximimalizovat funkci f(x, y, z) = x · y · z. Přitom má platit, že x +

y + z = 18. Tuto rovnost můžeme zahrnout rovnou do předpisu funkce, a získat tak funkci
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Obrázek 3.29: Řešení příkladu 3.34.

pouze dvou proměnných: x ·y ·(18−y−x). Nově vzniklou funkci přitom maximalizujeme pro
x ∈ (0, 18), y ∈ (0, 18), x + y < 18. Tímto zápisem jsem zadanou úlohu převedli na klasické
hledání absolutního maxima funkce, jak jsme jej řešili v předchozích příkladech. Tentokrát
dokonce nemusíme ani vyšetřovat funkční hodnoty na hranici „omezujícíÿ množiny, neboť
omezující podmínky jsou ostré nerovnosti. Celkem získáváme, že požadovaná kladná čísla
jsou: x = y = z = 6 (obrázek 3.30).

Příklad 3.37: Najděte kladná čísla x, y, z taková, že x ·y ·z = 64 a x+y+z je minimální.

Příklad 3.38: Jakého nejmenšího čísla může nabýt součet tří kladných čísel x, y, z, jestliže
pro ně platí: x · y · z2 = 2500?

Příklad 3.39: Najděte bod plochy z = x · y − 1, který je nejblíže bodu [0, 0, 0].

Příklad 3.40: Určete rovnici přímky, pro niž platí, že má od bodů [0, 2], [1, 3] a [2, 5]
nejmenší součet čtverců (druhých mocnin) jejich vertikálních vzdáleností (tj. ve směru osy
y) – tzv. metoda nejmenších čtverců.
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Obrázek 3.30: Řešení příkladu 3.36.

3.5 Vícerozměrný integrál

Poznámka 3.17: Mějme spojitou funkci f(x, y) na obdélníku [a, b]×[c, d]. Pak jsou spojité
i funkce ϕ(x) a ψ(y) dané integrály:

ϕ(x) =

d∫
c

f(x, y) dy a ψ(y) =

b∫
a

f(x, y) dx.

Funkce ϕ(x) a ψ(y) tak můžeme integrovat znovu a získat:

b∫
a

ϕ(x) dx =

b∫
a

d∫
c

f(x, y) dy dx,

d∫
c

ψ(y) dy =

d∫
c

b∫
a

f(x, y) dx dy.

Předešlé integrály nazýváme dvojnásobnými integrály.
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Definice 3.13: Nechť T = [a, b] × [c, d] ⊂ R2 a nechť je funkce f(x, y) spojitá na T .
Dvojným integrálem funkce f(x, y) přes množinu T pak rozumíme:

∫∫
T

f(x, y) dx dy =

b∫
a

d∫
c

f(x, y) dy dx =

d∫
c

b∫
a

f(x, y) dx dy.

Definice 3.14: Uvažujme nyní oblast, jíž budeme říkat oblast základní, definovanou jako
T = {(x, y) ∈ R2 | x ∈ [a1, a2], y ∈ [s1(x), s2(x)]}, resp. T = {(x, y) ∈ R2 | y ∈ [b1, b2], x ∈
[p1(y), p2(y)]}, přičemž funkce s1(x), s2(x), p1(y), p2(y) jsou spojité na intervalech [a1, a2],
resp. [b1, b2]. Základní oblast ilustruje pro lepší představu obrázek 3.31.

Obrázek 3.31: Zobrazení základní oblasti (převzato z [4]).

Analogicky jako v předchozí definici nyní definujeme dvojný integrál funkce f(x, y) přes
množinu T jako:

∫∫
T

f(x, y) dx dy =

a2∫
a1

s2(x)∫
s1(x)

f(x, y) dy dx,

resp.
∫∫
T

f(x, y) dx dy =

b2∫
b1

p2(y)∫
p1(y)

f(x, y) dx dy.

Poznámka 3.18: Sjednocením konečně mnoha základních oblastí můžeme získat tzv. ele-
mentární oblast (množinu) K (viz obrázek 3.32).

Poznámka 3.19: Častým krokem při výpočtu integrálů je prohození pořadí integrace.
Musíme mít na paměti, že vnější integrál musí být vždy ten, který neobsahuje proměnnou
ve svých mezích.

Definice 3.15: Uvažujme nyní základní oblast T = {(x, y) ∈ R2 | x ∈ [a1, a2], y ∈
[s1(x), s2(x)]}, přičemž funkce s1(x), s2(x) jsou spojité na intervalu [a1, a2]. Definujme zá-
kladní těleso P = {(x, y, z) ∈ R3 | (x, y) ∈ T, z ∈ [h1(x, y), h2(x, y)]}.

Trojným integrálem funkce f(x, y, z) přes množinu P nazýváme:
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Obrázek 3.32: Zobrazení elementární oblasti (převzato z [8]).

∫∫∫
P

f(x, y, z) dx dy dz =
∫∫
T

 h2(x,y)∫
h1(x,y)

f(x, y, z) dz

 =

a2∫
a1

s2(x)∫
s1(x)

h2(x,y)∫
h1(x,y)

f(x, y, z) dz dy dx.

V systému Maple zadáváme vícenásobné integrály opakovaným použitím integračního
symbolu z palety Expression, příkazu int či vyvoláním kontextové nabídky dokumentu
(po kliknutí pravým tlačítkem myši na předpis funkce) a zvolením položky Integrate spolu
se specifikací integrační proměnné (pouze pro neurčitý integrál).

Obrázek 3.33: Vícenásobné integrály.

Pokud chceme do dokumentu zapsat vícenásobný integrál symbolicky (a nevyhodnocovat
jej), použijeme příkaz Int. Další možnost, jak zadat (určitý) vícenásobný integrál (dvojný
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nebo trojný), poskytuje příkaz MultiInt z balíku Student[MultivariateCalculus]. Pří-
kaz MultiInt nabízí možnost výpisu integrálu jako symbolu i jako integrálu, který bude
„rovnouÿ vyhodnocen. Navíc je možné nechat vypsat kroky výpočtu integrálu nastavením
nepovinného parametru output na hodnotu steps. Dalším nepovinným parametrem, který
můžeme specifikovat, je parametr coordinates určující, v jakých souřadnicích je integrál
uveden. Na výběr máme podle dimenze integrálu souřadnice kartézské (cartesian[x,y]
nebo cartesian[x,y,z]), polární (polar[r,theta]), sférické (spherical[r,phi,theta])
či cylindrické (cylindrical[r,theta,z]).

Obrázek 3.34: Vícenásobné integrály s příkazy MultiInt a Int.

K převodům mezi různými souřadnicovými systémy můžeme využít příkaz changecoords,
který převede zadaný výraz z kartézského systému souřadnic do námi zvoleného. Pro dvojné
a trojné integrály je k dispozici příkaz balíku Student[MultivariateCalculus] s názvem
ChangeOfVariables převádějící proměnné mezi dříve vyjmenovanými souřadnicovými sys-
témy. Příkaz má jednu „slabinuÿ, a to, že zpravidla nepřevede integrační meze do nových
proměnných, což musíme tedy udělat sami.
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Obrázek 3.35: Transformace mezi souřadnicovými systémy.

Příklad 3.41: Stanovte meze dvojnásobného integrálu

I =
∫∫

Ω

f(x, y) dx dy.

Integrál následně zapište i s těmito mezemi pro integrační oblast:

(a) Ω : 0 ≤ x ≤ y ≤ 1,

(b) Ω : x < x2 + y2 ≤ 1,

(c) Ω : 1 ≤ |x|+ |y| < 2,

(d) Ω je 4 s vrcholy [1, 0], [1, 1], [0, 0].

Řešení: Při stanovování mezí nám může velmi pomoci obrázek. Nejprve si tedy zadanou
množinu Ω vždy vykreslíme a následně odvodíme meze jednotlivých integrálů. Využijeme
přitom příkazů inequal z balíku plots, transform z balíku plottools a implicitplot
z balíku plots, s nimiž jsme se již setkali při vykreslování oblastí a definičních oborů funkcí
v sekci 3.1.3.

(a)

Z obrázku 3.36 můžeme vyvodit 2 různé (ekvivalentní) zápisy integračních mezí:

1. 0 ≤ y ≤ 1, 0 ≤ x ≤ y,

2. 0 ≤ x ≤ 1, x ≤ y ≤ 1.

Celkem tak získáváme:

I =
∫∫

Ω

f(x, y) dx dy =

1∫
0

y∫
0

f(x, y) dx dy =

1∫
0

1∫
x

f(x, y) dy dx.

122



Obrázek 3.36: Zobrazení oblasti Ω z příkladu 3.41.(a)

Obrázek 3.37: Zobrazení oblasti Ω z příkladu 3.41.(b)

(b)

Z obrázku 3.37 můžeme vyvodit opět 2 různé (ekvivalentní) zápisy integračních mezí.
Dostáváme však výrazně komplikovanější zápis než v předchozím případě, a tak za-
pišme pouze jednu možnost (která je jednodušší):
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1. −1 ≤ x ≤ 0,−
√

1− x2 ≤ y ≤
√

1− x2,

0 ≤ x ≤ 1,−
√

1− x2 ≤ y < −
√

1
4 −

(
x− 1

2

)2 ∪
√

1
4 −

(
x− 1

2

)2
< y ≤

√
1− x2.

Celkem tak získáváme:

I =
∫∫

Ω

f(x, y) dx dy =

0∫
−1

√
1−x2∫

−
√

1−x2

f(x, y) dy dx +

1∫
0

−
√
1
4−(x− 12)

2∫
−
√

1−x2

f(x, y) dy dx +

+

1∫
0

√
1−x2∫

√
1
4−(x− 12)

2

f(x, y) dy dx.

(c)

Obrázek 3.38: Zobrazení oblasti Ω z příkladu 3.41.(c)

I v tomto případě máme dvě (základní) možnosti, jak zapsat integrační meze. Pro
komplikovanost zápisu ukažme opět pouze jednu z možností. Doplňme, že v případech,
kdy je oblast Ω symetrická (kolem počátku či kolem některé z os) a podobně i zadaná
funkce (vzhledem k ose z), počítáme zpravidla integrál pouze pro část oblasti (tj.
např. jen pro jeden kvadrant) a výsledek vynásobíme počtem odpovídajících si částí.
V tomto příkladu bychom tak mohli počítat integrál pouze pro oblast náležící prvnímu
kvadrantu a výsledek vynásobit čtyřmi (pokud by funkce f(x, y) byla symetrická kolem
osy z).

1. −2 ≤ x ≤ −1,−x− 2 < y < x+ 2,
−1 ≤ x ≤ 0,−x− 2 < y ≤ −x− 1 ∪ x+ 1 ≤ y < x+ 2,
0 ≤ x ≤ 1, x− 2 < y ≤ x− 1 ∪ − x+ 1 ≤ y < −x+ 2,
1 ≤ x ≤ 2, x− 2 < y < −x+ 2.
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Celkem tak získáváme:

I =
∫∫

Ω

f(x, y) dx dy =

−1∫
−2

x+2∫
−x−2

f(x, y) dy dx +

0∫
−1

−x−1∫
−x−2

f(x, y) dy dx +

+

0∫
−1

x+2∫
x+1

f(x, y) dy dx +

1∫
0

x−1∫
x−2

f(x, y) dy dx +

1∫
0

−x+2∫
−x+1

f(x, y) dy dx +

+

2∫
1

−x+2∫
x−2

f(x, y) dy dx.

(d)

Obrázek 3.39: Zobrazení oblasti Ω z příkladu 3.41.(d)

Z obrázku 3.39 vidíme, že situace je velmi podobná případu (a). Můžeme opět vyvodit
2 různé (ekvivalentní) zápisy integračních mezí:

1. 0 ≤ x ≤ 1, 0 ≤ y ≤ x,

2. 0 ≤ y ≤ 1, y ≤ x ≤ 1.
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Celkem tak získáváme:

I =
∫∫

Ω

f(x, y) dx dy =

1∫
0

x∫
0

f(x, y) dy dx =

1∫
0

1∫
y

f(x, y) dx dy.

Příklad 3.42: Stanovte meze dvojnásobného integrálu

I =
∫∫

Ω

f(x, y) dx dy.

Integrál následně zapište i s těmito mezemi pro integrační oblast:

(a) Ω : 0 ≤ x+ y ≤ 1 ∧ x ≥ 0 ∧ y ≥ 0,

(b) Ω : x2 + y2 ≤ 1 ∧ x ≥ 0,

(c) Ω : |x|+ |y| < 3,

(d) Ω je 4 s vrcholy [2, 1], [−2, 1], [0, 0].

Příklad 3.43: Vyjádřete zadané integrály v obráceném pořadí integrace.

(a)
4∫
0

2∫
x
2

f(x, y) dy dx,

(b)
2∫
0

2·x∫
x

f(x, y) dy dx,

(c)
2∫
0

x2∫
0
f(x, y) dy dx,

(d)
1∫
0

x2∫
x3
f(x, y) dy dx.

3.5.1 Geometrická aplikace dvojného integrálu

Obsah rovinné oblasti

Poznámka 3.20: Nechť Ω ⊂ R2 je rovinná oblast. Plocha S oblasti Ω je dána vztahem

S =
∫∫

Ω

dx dy.

Příklad 3.44: Určete obsah oblasti Ω.

(a) Ω je ohraničená křivkami y = 1
x

a y = 3− 2 · x,

(b) Ω je ohraničená přímkami y = x, y = x− 3, y = 2 a y = 4.

Řešení:
V zadání není specifikováno, jak máme obsah zadané oblasti hledat. Mohli bychom si

proto vzpomenout na aplikace určitého integrálu funkce jedné proměnné a počítat obsah
oblasti tímto způsobem. U některých oblastí je navíc jednodušší i jiný způsob než počítat
integrály (jednoduché či dvojné). My si ukážeme výpočet jak pomocí jednoduchého, tak
pomocí dvojného integrálu.
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Obrázek 3.40: Zobrazení oblasti Ω z příkladu 3.44. Vlevo případ (a), vpravo případ (b).

(a) Pomocí jednoduchého integrálu zvolíme jednu proměnnou, u níž známe číselné meze,
a „odečítáme od sebeÿ dvě funkce vymezující zadanou oblast. U dvojného integrálu
zapíšeme zadanou oblast pouze v integračních mezích. Pozor na to, že při výpočtu dvoj-
násobného integrálu v systému Maple musíme zadat funkci, která bude integrována.
V případě počítání obsahů rovinných oblastí podle poznámky 3.20 se v integrálu žádná
funkce nevyskytuje, i když ve skutečnosti integrujeme konstantní funkci f(x, y) = 1,
kterou také zadáme do integrálu v systému Maple.

Obrázek 3.41: Výpočet obsahu oblasti Ω z příkladu 3.44.(a)

(b)

Obrázek 3.42: Výpočet obsahu oblasti Ω z příkladu 3.44.(b)
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Příklad 3.45: Určete obsahy oblastí Ω z příkladu 3.42 a obsahy oblastí tvořených inte-
gračními mezemi v příkladu 3.43. U příkladu 3.43 výpočtem obsahu příslušné oblasti navíc
ověřte rovnost integrálů v zadání a v řešení.

Příklad 3.46: Pomocí dvojného integrálu určete obsah kruhu o poloměru r.

Příklad 3.47: Pomocí dvojného integrálu určete obsah oblasti ohraničené elipsou o délce
hlavní poloosy a a délce vedlejší poloosy b.

Objem tělesa

Poznámka 3.21: Nechť f(x, y) je spojitá funkce na množině Ω ⊂ R2 a nechť f(x, y) ≥ 0
pro všechna (x, y) ∈ Ω. Objem (kolmého) tělesa T ⊂ R3 ohraničeného zdola množinou Ω
a shora částí grafu funkce f(x, y) je dán vztahem

V =
∫∫

Ω

f(x, y) dx dy.

Příklad 3.48: Určete objem kolmého tělesa ohraničeného:

(a) funkcí f(x, y) = x2 + y2 a množinou Ω : |x|+ |y| ≤ 1,

(b) funkcí f(x, y) = 64− x2 a rovinami 3 · x+ 4 · y = 24, x = 0, y = 0 a z = 0.

Řešení:

(a) Nejprve v systému Maple zobrazíme těleso, jehož objem počítáme, a jeho podstavu
(množinu Ω), abychom získali představu a snáze odvodili meze dvojného integrálu.
S množinou Ω (resp. jejími variantami) jsme se už několikrát setkali, takže by nám
nemělo činit problémy přepsat ji do mezí pro proměnné x a y. Když si však uvědomíme,
že množina Ω je středově souměrná podle počátku souřadné soustavy (bodu [0, 0, 0])
a že zadaná funkce f(x, y) je symetrická podle osy z, můžeme počítat objem pouze
části tělesa vyskytující se v prvním oktantu (tj. pro x, y, z ≥ 0) a výsledek vynásobit
čtyřmi (abychom získali objem celého tělesa rozprostírajícího se přes čtyři oktanty, pro
něž z ≥ 0).

Pro meze odpovídající prvnímu oktantu platí:
0 ≤ x ≤ 1, 0 ≤ y ≤ 1− x.

(b) Opět zobrazíme těleso, jehož objem počítáme. Vykreslením všech rovin (resp. funkcí),
které se protínají a těleso vytváří, můžeme získat graf, který není příliš přehledný.
Nastavováním různých nepovinných parametrů vykreslovacích příkazů, můžeme docílit
přehlednějšího zobrazení. Na obrázku 3.44 je získané těleso zobrazeno 2×: vlevo „bez
větších úpravÿ, vpravo bylo dosaženo zobrazení tělesa „bez zbytečných čarÿ, ovšem za
cenu použití dalších příkazů a některých „trikůÿ.

Na obrázku chybí zvláštní graf s podstavou tělesa. Z grafu vpravo je však ihned vidět,
že podstavu tvoří trojúhelník vymezení přímkami x = 0, y = 0 a 3 · x+ 4 · y = 24. Pro
meze integrálu proto platí:
0 ≤ x ≤ 8, 0 ≤ y ≤ 24−3·x

4 .
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Obrázek 3.43: Řešení příkladu 3.48.(a)

Příklad 3.49: Určete objem kolmého tělesa ohraničeného:

(a) funkcí f(x, y) = 6− 2 · x− 3 · y a rovinami x = 0, y = 0 a z = 0,

(b) funkcí f(x, y) = x+ 2 · y a podstavou vymezenou grafy funkcí y = 2− x2 a y = |x|,

(c) funkcí f(x, y) = ex
2+y2 a kruhovou podstavou popsanou nerovnicí x2 + y2 ≤ 4,

(d) funkcí f(x, y) = 5 ·x2−2 ·x ·y a trojúhelníkovou podstavou vymezenou body [2, 0], [0, 1]
a [0, 0].

(e) funkcí f(x, y) =
(
x
y

)2
a podstavou vymezenou grafy funkcí y = x, y = 1

x
a přímkou

x = 2.

Příklad 3.50: Pomocí dvojného integrálu určete objem kvádru o rozměrech a, b, c.

Příklad 3.51: Pomocí dvojného integrálu určete objem koule o poloměru r.

Příklad 3.52: Pomocí dvojného integrálu určete objem válce o poloměru podstavy r
a výšce v.
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Obrázek 3.44: Řešení příkladu 3.48.(b)

Obsah plochy

Poznámka 3.22: Nechť jsou funkce f(x, y), f ′x(x, y), f ′y(x, y) spojité na množině Ω ⊂ R2.
Obsah plochy tvořené grafem funkce f(x, y) nad množinou Ω je dán vztahem

S =
∫∫

Ω

√
1 + (f ′x(x, y))2 +

(
f ′y(x, y)

)2
dx dy.

Příklad 3.53: Určete obsah plochy tvořené grafem funkce f(x, y) nad množinou Ω z pří-
kladu 3.48 v případě (a) i (b).

Řešení:
V obou případech využijeme poznámky 3.22, již dříve vypočítaných integračních mezí

a předpisu ohraničující funkce.

Příklad 3.54: Určete obsah plochy tvořené grafem funkce f(x, y) nad podstavou tělesa
z příkladu 3.49.

Příklad 3.55: Určete obsah povrchu koule o poloměru r.
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Obrázek 3.45: Řešení příkladu 3.53.(a) vlevo, řešení příkladu 3.53.(b) vpravo.

Příklad 3.56: Určete obsah části plochy koule o rovnici x2 + y2 + z2 = 25 vymezené
rovinami z = 2 a z = 4.

Integrální součet

Jak již víme, geometrickým významem dvojného integrálu z funkce f(x, y) přes množinu Ω
je objem tělesa ohraničeného množinou Ω, funkcí f(x, y) a „svislými osamiÿ. Tento objem
můžeme počítat přibližně pomocí dolních (resp. horních, . . .) integrálních součtů podobně,
jako jsme si to ukazovali v případě jedné proměnné v sekci 2.7.4. Tentokrát přitom aproxi-
mujeme objem součtem objemů kvádrů se „zjemňující seÿ čtvercovou základnou a výškou
spočtenou např. z funkční hodnoty ve středu čtverce – základny nebo v jednom z vrcholů.
K tomu nám poslouží příkaz ApproximateInt z balíku Student[MultivariateCalculus].
Použití příkazu ApproximateInt je takřka totožné s příkazem RiemannSum, s nímž jsme se
dříve setkali. Příkazu opět povinně zadáváme funkci, již chceme integrovat, a meze inte-
grace. I v tomto případě můžeme zadávat nepovinné parametry specifikující typ integrálního
součtu, typ výstupu, rozdělení integračních intervalů a další. Ukázku použití můžeme vidět
na obrázku 3.46.

Tak jako v případě funkcí jedné proměnné, kde můžeme místo příkazu RiemannSum využít
nástroje Approximate Integration spouštěném například z hlavního menu, máme k dis-
pozici analogický nástroj i nyní. Opět má název Approximate Integration a tentokrát jej
spustíme například zvolením Tools > Tutors > Calculus – Multi-Variable > Appro-
ximate Integration. . . v hlavním menu (obrázek 3.47).
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Obrázek 3.46: Aproximace dvojného integrálu pomocí integrálních součtů.

3.5.2 Geometrická aplikace trojného integrálu

Objem tělesa

Poznámka 3.23: Nechť P je množina z definice 3.15 (obecně stačí tzv. měřitelná množina).
Pro objem V této množiny platí vztah

V =
∫∫∫
P

dx dy dz.

Příklad 3.57: Určete objem trojosého elipsoidu daného rovnicí(x
a

)2
+
(y
b

)2
+
(z
c

)2
= 1.

Řešení: Nejprve si elipsoid vykreslíme pro nějaké konkrétní hodnoty a, b, c. Na obrázku
3.48 jsou použity hodnoty a = 13, b = 8, c = 6. Následně musíme odvodit jednotlivé meze
v trojném integrálu. Za „počátečníÿ proměnnou vezměme x, pro niž tak platí: x ∈ [−a, a].
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Obrázek 3.47: Aproximace dvojného integrálu – maplet.

Proměnnou y vyjádříme pomocí proměnné x jako: y ∈
[
−
√

1−
(
x
a

)2
,
√

1−
(
x
a

)2
]

a nakonec

proměnnou z pomocí zbylých proměnných jako: z ∈
[
−
√

1−
(
x
a

)2 −
(
y
b

)2
,
√

1−
(
x
a

)2 −
(
y
b

)2
]
.

Obrázek 3.48: Řešení příkladu 3.57.
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Příklad 3.58: Pomocí trojného integrálu určete objem tělesa z příkladu 3.48.

Příklad 3.59: Pomocí trojného integrálu určete objem kvádru o rozměrech a, b, c.

Příklad 3.60: Pomocí trojného integrálu určete objem koule o poloměru r.

Příklad 3.61: Pomocí trojného integrálu určete objem válce o poloměru podstavy r
a výšce v.

3.5.3 Transformace souřadnic ve dvojném a trojném integrálu

U skupiny integrálů, kde pracujeme s kruhovými, kulovými či válcovými plochami, bývá
výhodná transformace do polárních, sférických či cylindrických souřadnic.

Poznámka 3.24: (Transformace do polárních souřadnic) Uvažujme dvojný integrál∫∫
Ω1

f(x, y) dx dy.

Pro transformaci tohoto integrálu do polárních souřadnic daných vztahy

x = r · cos(θ), y = r · sin(θ)

platí: ∫∫
Ω1

f(x, y) dx dy =
∫∫
Ω2

f(r · cos(θ), r · sin(θ)) · r dr dθ,

kde r ∈ [0,∞), θ ∈ [0, 2 · π].

Poznámka 3.25: (Transformace do sférických souřadnic) Uvažujme trojný integrál∫∫∫
Ω1

f(x, y, z) dx dy dz.

Pro transformaci tohoto integrálu do sférických souřadnic daných vztahy

x = r · cos(φ) · sin(θ), y = r · sin(φ) · sin(θ), z = r · cos(θ)

platí: ∫∫∫
Ω1

f(x, y, z) dx dy dz =

=
∫∫∫
Ω2

f(r · cos(φ) · sin(θ), r · sin(φ) · sin(θ), r · cos(θ)) · sin(θ) · r2 dr dφ dθ,

kde r ∈ [0,∞), φ ∈ [0, 2 · π], θ ∈ [0, 2 · π].
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Poznámka 3.26: (Transformace do cylindrických souřadnic) Uvažujme trojný inte-
grál ∫∫∫

Ω1

f(x, y, z) dx dy dz.

Pro transformaci tohoto integrálu do cylindrických souřadnic daných vztahy

x = r · cos(θ), y = r · sin(θ), z = z

platí: ∫∫∫
Ω1

f(x, y, z) dx dy dz =
∫∫∫
Ω2

f(r · cos(θ), r · sin(θ), z) · r dr dθ dz,

kde r ∈ [0,∞), θ ∈ [0, 2 · π], z ∈ R.

Příklad 3.62: Použitím transformace do polárních souřadnic určete objem kolmého tělesa
ohraničeného funkcí f(x, y) = ex

2+y2 a kruhovou podstavou popsanou nerovnicí x2 + y2 ≤ 4.

Řešení: Můžeme využít poznámky 3.24 nebo zapsat dvojný integrál pro kartézské souřad-
nice, který jsme již vytvořili v příkladu 3.49.(c), a pro transformaci do souřadnic polárních
využít příkaz ChangeOfVariables (či příkaz changecoords). Proveďme druhou možnost.

Integrační meze Maple nepřevede, musíme je tak vytvořit sami. Podstavou tělesa je kruh
o poloměru r = 2, což vede na následující meze: r ∈ [0, 2], θ ∈ [0, 2 · π]. Můžeme pozorovat,
že v porovnání s řešením příkladu 3.49.(c) jsme tentokrát získali i analytické řešení.

Obrázek 3.49: Řešení příkladu 3.62.

Příklad 3.63: Použitím transformace do polárních souřadnic určete objem kolmého tělesa
ohraničeného funkcí f(x, y) =

√
1− x2 − y2 a kruhovou podstavou popsanou nerovnicí

x2 + y2 ≤ 1.

Příklad 3.64: Vraťte se k příkladům 3.46, 3.51, 3.52, 3.60 a 3.61. Příslušné výpočty nyní
proveďte i v jiném systému souřadnic (tj. např. polárních, sférických, . . .) a výsledky porov-
nejte s původně získanými.
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3.6 Nekonečné řady

Definice 3.16: Mějme funkci f : R → R. Jestliže D(f) = N, nazýváme tuto funkci
posloupností reálných čísel a značíme {an}∞n=1.

Definice 3.17: Nechť {an}∞n=1 je posloupnost reálných čísel. Symbol

∞∑
n=1

an nebo a1 + a2 + ...+ an + ...

nazýváme nekonečnou (číselnou) řadou. Posloupnost {sn}∞n=1 definovanou předpisem

s1 = a1, s2 = a1 + a2, ... sn = a1 + a2 + ...+ an, ...

nazýváme posloupností částečných součtů této řady.

Definice 3.18: Existuje-li vlastní limita lim
n→∞

sn = s, řekneme, že řada
∞∑
n=1

an konverguje

a má součet s.

Neexistuje-li vlastní limita lim
n→∞

sn, řekneme, že řada
∞∑
n=1

an diverguje.

Poznámka 3.27: Divergenci řady můžeme ještě rozlišit na tři případy:

• je-li lim
n→∞

sn =∞, říkáme, že řada diverguje k ∞,

• je-li lim
n→∞

sn = −∞, říkáme, že řada diverguje k −∞,

• pokud lim
n→∞

sn neexistuje, říkáme, že řada osciluje.

V systému Maple zadáváme posloupnosti pomocí příkazu seq nebo pomocí kontextové
nabídky dokumentu. Příkaz seq je možné použít několika různými způsoby s ohledem na to,
jaké mu zadáváme parametry. S výjimkou jediného případu mu vždy zadáváme jako první
parametr n-tý člen posloupnosti a dalším parametrem (dalšími parametry) specifikujeme,
které členy posloupnosti chceme vypsat (což můžeme učinit zadáním intervalu, zápisem
jediné hodnoty – pro jediný člen nebo výpisem členů posloupnosti v seznamu).

V případě použití kontextové nabídky zadáme do dokumentu n-tý člen posloupnosti,
klikneme na něj pravým tlačítkem a zvolíme položku Sequence spolu s iterační proměn-
nou. V následně zobrazeném okénku navolíme, které členy posloupnosti chceme vypsat do
dokumentu. Použití kontextové nabídky má však oproti příkazu seq mnohá omezení.

Posloupnosti {an} můžeme též vykreslovat do grafů. Potřebujeme k tomu vytvořit dvo-
jice [n, an], které následně zobrazíme jako body příkazem plot. Pro vytvoření dvojic [n, an]
můžeme pochopitelně použít příkaz seq, vykreslení bodů je třeba specifikovat parametrem
style nastaveným na hodnotu point (v příkazu plot).

Nekonečné řady (i konečné součty) zadáváme v Maple několika způsoby. Jednak paleta
Expression nabízí předdefinovaný symbol velkého řeckého písmene sigma, k dispozici je
také příkaz sum a využít můžeme opět i kontextové nabídky dokumentu (i když trochu
„komplikovaněÿ). Příkaz sum má dva parametry (n-tý člen řady a „součtovéÿ meze). Po
provedení příkaz vypíše součet řady (pokud jej umí určit). Systém Maple nabízí též příkaz
Sum s velkým počátečním písmenem, jenž slouží pro matematický zápis řady s použitím
řeckého písmene sigma. A právě takový zápis je možné získat i pomocí kontextové nabídky,
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Obrázek 3.50: Různé možnosti vypsání členů posloupnosti.

Obrázek 3.51: Vykreslení členů posloupnosti.

když do dokumetu zapíšeme n-tý člen řady, klikneme na něj pravým tlačítkem myši a zvolíme
položku Constructions > Sum > n. Dalším kliknutím pravého tlačítka myši (tentokrát na
matematický zápis řady) a zvolením Evaluate (from inert) získáme součet řady (pokud
jej Maple umí určit).

S tím, co již známe, nám nic nebrání ve vypsání posloupnosti částečných součtů. Tuto
posloupnost navíc můžeme vykreslit, například společně se součtem řady – viz obrázek 3.53.

Existují nekonečné řady, jejichž součet Maple neumí určit8. V takových případech ani
nevypíše, zda řada součet má (tj. zda konverguje) či zda řada diverguje. V těchto situacích
musíme konvergenci řady vyšetřit „samiÿ jinými postupy, přičemž si samozřejmě můžeme
„pomáhat systémemÿ při dílčích krocích.

8V Maple 14 neexistuje příkaz, který by uspokojivě řešil limity posloupností reálných čísel.
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Obrázek 3.52: Různé možnosti zápisu nekonečných (i konečných) řad.

Obrázek 3.53: Vykreslení posloupnosti částečných součtů a součtu řady.

Příklad 3.65: Určete součty následujících řad:

(a)
∞∑
n=1

1
n·(n+1) , (b)

∞∑
n=1

1
n2

, (c)
∞∑
n=1

1
n
.
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Příklad 3.66: Určete součty následujících řad:

(a)
∞∑
n=1

(√
n+ 2− 2 ·

√
n+ 1 +

√
n
)
, (b)

∞∑
n=1

arctan
(

1
2·n2
)
.

Řešení:

(a) Systém Maple zadanou řadu sečíst neumí. Určíme tedy částečný součet řady sk pro
libovolné (pevné) k a následně prověříme existenci limity tohoto částečného součtu
pro k → ∞. Částečný součet sk přitom odvodíme na základě několika částečných
součtů pro různé konkrétní numerické hodnoty. Zcela správně bychom měli (například
matematickou indukcí) dokázat, že pravidlo, které vypozorujeme z některých (nejlépe
několika prvních) částečných součtů platí skutečně pro libovolné k.

Naznačme proto takový důkaz aspoň nyní. Díky Maple víme, že

10∑
n=1

(√
n+ 2− 2 ·

√
n+ 1 +

√
n
)

= 1−
√

2−
√

11 +
√

12,

11∑
n=1

(√
n+ 2− 2 ·

√
n+ 1 +

√
n
)

= 1−
√

2−
√

12 +
√

13,

12∑
n=1

(√
n+ 2− 2 ·

√
n+ 1 +

√
n
)

= 1−
√

2−
√

13 +
√

14.

Předpokládejme nyní, že pro libovolné k ≥ 10 platí:

k∑
n=1

(√
n+ 2− 2 ·

√
n+ 1 +

√
n
)

= 1−
√

2−
√
k + 1 +

√
k + 2.

Pak platí:

k+3∑
n=1

(√
n+ 2− 2 ·

√
n+ 1 +

√
n
)

= 1−
√

2−
√
k + 1 +

√
k + 2

+
(√

k + 3− 2 ·
√
k + 2 +

√
k + 1

)
+

(√
k + 4− 2 ·

√
k + 3 +

√
k + 2

)
+

(√
k + 5− 2 ·

√
k + 4 +

√
k + 3

)
= 1−

√
2−
√
k + 4 +

√
k + 5.

Zjistili jsme tedy, že pokud naše hypotéza platí pro libovolné k ≥ 10, platí i pro k+ 3.
Jelikož víme, že vypozorovaný vztah platí pro k ∈ {10, 11, 12}, pak musí nutně platit
pro zcela libovolné k ≥ 10.

(b) Systém Maple zadanou řadu sečíst opět neumí. Postupujeme totožným způsobem jako
v předchozím příkladu. Opět je třeba dokázat, že vypozorovaný vztah skutečně platí
pro libovolné k. V tomto případě to necháváme na čtenáři (obrázek 3.54).

Často se nám může stát, že neumíme součet řady určit. V této situaci bychom přesto
chtěli alespoň odpověď na otázku, zda řada konverguje či diverguje. Zabývat se nyní budeme
řadami s nezápornými členy, u nichž platí, že buď konvergují nebo divergují k nekonečnu.
Pro zjištění, zda řada konverguje či diverguje, máme několik rozhodovacích kritérií.
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Obrázek 3.54: Řešení příkladu 3.66. Část (a) vlevo, část (b) vpravo.

Poznámka 3.28: (Srovnávací kritérium) Mějme řady
∞∑
n=1

an,
∞∑
n=1

bn s nezápornými

členy a nechť an ≤ bn pro všechna n ∈ N. Pak platí:

• konverguje-li řada
∞∑
n=1

bn, konverguje i řada
∞∑
n=1

an,

• diverguje-li řada
∞∑
n=1

an, diverguje i řada
∞∑
n=1

bn.

Poznámka 3.29: (Limitní srovnávací kritérium) Mějme řady
∞∑
n=1

an,
∞∑
n=1

bn s nezápor-

nými členy a nechť existuje
lim
n→∞

an
bn

= L.
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Pak platí:

• je-li L <∞ a konverguje-li řada
∞∑
n=1

bn, konverguje i řada
∞∑
n=1

an,

• je-li L > 0 a diverguje-li řada
∞∑
n=1

bn, diverguje i řada
∞∑
n=1

an.

Poznámka 3.30: (Odmocninové kritérium) Nechť
∞∑
n=1

an je řada s nezápornými členy.

• Platí-li pro všechna n ∈ N: n
√
an ≤ q < 1, pak řada konverguje,

• existuje-li
lim
n→∞

n
√
an = q, kde q ∈ R ∪ {−∞,∞},

pak pro q < 1 řada konverguje, pro q > 1 řada diverguje.

Poznámka 3.31: (Podílové kritérium) Nechť
∞∑
n=1

an je řada s nezápornými členy.

• Platí-li pro všechna n ∈ N: an+1
an
≤ q < 1, pak řada konverguje, platí-li pro všechna

n ∈ N: an+1
an
≥ 1, pak řada diverguje,

• existuje-li
lim
n→∞

an+1

an
= q, kde q ∈ R ∪ {−∞,∞},

pak pro q < 1 řada konverguje, pro q > 1 řada diverguje.

Poznámka 3.32: (Limitní Raabeovo kritérium) Nechť
∞∑
n=1

an je řada s nezápornými

členy a nechť existuje

lim
n→∞

n ·
(

1− an+1

an

)
= q, kde q ∈ R ∪ {−∞,∞},

pak pro q > 1 řada konverguje, pro q < 1 řada diverguje.

Poznámka 3.33: (Integrální kritérium) Nechť je funkce f definovaná na intervalu
[1,∞), která je na tomto intervalu nezáporná a nerostoucí. Nechť f(n) = an pro n ∈ N.

Pak řada
∞∑
n=1

an konverguje právě tehdy, když konverguje nevlastní integrál

∞∫
1

f(x) dx.
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Příklad 3.67: Rozhodněte o konvergenci následujících řad:

(a)
∞∑
n=2

1
ln(n) ,

(b)
∞∑
n=1

sin
(
π
n

)
,

(c)
∞∑
n=1

n

(3+ 1
n)n

,

(d)
∞∑
n=1

nn

n! ,

(e)
∞∑
n=2

1
n·ln(n) .

Řešení:

(a) Využijeme srovnávacího kritéria a toho, že řada
∞∑
n=2

1
n

diverguje. Jelikož pro všechna

n ∈ N \ {1} platí: 1
n
< 1

ln(n) , podle srovnávacího kritéria řada
∞∑
n=2

1
ln(n) diverguje.

(b) Nyní využijeme limitního srovnávacího kritéria a znovu řady
∞∑
n=2

1
n
, která diverguje.

Jelikož lim
n→∞

sin(πn)
1
n

= π, řada
∞∑
n=1

sin
(
π
n

)
diverguje.

(c) Opět budeme počítat limitu, tentokrát v odmocninovém kritériu.
Jelikož lim

n→∞
n

√
n

(3+ 1
n)n

= 1
3 , zadaná řada konverguje.

(d) V tomto případě využijeme podílového kritéria, resp. opět jeho limitní varianty.

Jelikož lim
n→∞

(n+1)n+1

(n+1)!
nn

n!

= e, zadaná řada diverguje.

(e) V posledním případě použijeme integrální kritérium. Funkce f(x) = 1
x·ln(x) je na inter-

valu [2,∞) nezáporná a klesající (předpoklady integrálního kritéria). Jelikož

∞∫
2

f(x) dx =∞,

řada
∞∑
n=2

1
n·ln(n) diverguje. Pomocné výpočty v Maple k předešlým příkladům ilustruje

obrázek 3.55.

Příklad 3.68: Rozhodněte o konvergenci následujících řad:

(a)
∞∑
n=1

(√
n−
√
n− 1

)
,

(b)
∞∑
n=1

1√
n2+2·n ,

(c)
∞∑
n=1

√
n√

n4+1
,

(d)
∞∑
n=1

ln
(
1 + 1

n2

)
,

(e)
∞∑
n=1

sin
(
π
2n

)
,

(f)
∞∑
n=1

2n

n4
,

(g)
∞∑
n=1

2n

nn
,

(h)
∞∑
n=1

2n·n!
nn

,

(i)
∞∑
n=1

1
n3

.
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Obrázek 3.55: Pomocné výpočty k řešení příkladu 3.67.

3.6.1 Absolutní konvergence řad

Definice 3.19: Nekonečná řada
∞∑
n=1

an se nazývá alternující, jestliže pro všechna n ∈ N

platí: signum(an+1) = −signum(an).
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Poznámka 3.34: (Leibnizovo kritérium) Nechť an je nerostoucí posloupnost kladných

čísel. Pak alternující řada
∞∑
n=1

(−1)n−1 · an konverguje právě tehdy, když platí lim
n→∞

an = 0.

Alternující řady zadáváme systému stejným způsobem jako veškeré nekonečné řady. Jak
uvidíme, systém Maple umí počítat součty alternujících řad. V případech, kdy součet řady
určit nedokáže, nám velmi pomůže výše zmíněné Leibnizovo kritérium konvergence.

Příklad 3.69: Rozhodněte o konvergenci následujících řad:

(a)
∞∑
n=1

1
n
· (−1)n−1, (b)

∞∑
n=1

1
n√n · (−1)n−1.

Řešení:

(a) Systém Maple určí součet zadané řady.

(b) V tomto případě Maple součet neurčí, využijeme proto Leibnizova kritéria, díky němuž
zjistíme, že zadaná řada diverguje.

Obrázek 3.56: Pomocné výpočty k řešení příkladu 3.69.

Definice 3.20: Řekneme, že nekonečná řada
∞∑
n=1

an konverguje absolutně , jestliže konver-

guje řada
∞∑
n=1
|an|. Jestliže řada

∞∑
n=1

an konverguje a řada
∞∑
n=1
|an| diverguje, říkáme, že řada

∞∑
n=1

an konverguje neabsolutně .

Poznámka 3.35: Konverguje-li řada
∞∑
n=1
|an|, konverguje i řada

∞∑
n=1

an. Diverguje-li řada

∞∑
n=1

an, pak diverguje také řada
∞∑
n=1
|an|.
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Příklad 3.70: Rozhodněte o konvergenci a absolutní konvergenci následujících řad:

(a)
∞∑
n=1

ln
(
1 + 1

n

)
· (−1)n−1, (b)

∞∑
n=2

1
n·ln(n) · (−1)n.

Řešení:

(a) Systém Maple součet zadané řady neurčí. Využijeme proto Leibnizova kritéria, díky
němuž zjistíme, že zadaná řada konverguje. K posouzení absolutní konvergence již
můžeme využít systému Maple. Závěr tedy je, že zadaná řada konverguje neabsolutně.

(b) Systém Maple neurčí součet ani jedné z řad. Pro posouzení konvergence zadané řady
využijeme Leibnizova kritéria, díky němuž zjistíme, že zadaná řada konverguje. Kon-
vergenci (resp. divergenci) řady absolutních hodnot můžeme ověřit např. integrálním
kritériem, což jsme prováděli již v příkladu 3.67.(e), kde jsme zjistili, že tato řada
diverguje. Závěr tedy je, že zadaná řada konverguje neabsolutně.

Obrázek 3.57: Pomocné výpočty k řešení příkladu 3.70.

Příklad 3.71: Rozhodněte o konvergenci a absolutní konvergenci následujících řad:

(a)
∞∑
n=1

1
(2·n+1)! · (−1)n−1,

(b)
∞∑
n=1

1
3·n−1 · (−1)n−1,

(c)
∞∑
n=1

1
ln(n+1) · (−1)n−1,

(d)
∞∑
n=1

1
(n−ln(n) · (−1)n,

(e)
∞∑
n=1

1
(ln(n))n · (−1)n,

(f)
∞∑
n=1

n

(3+ 1
n)n
· (−1)n−1.
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4 Chybové zprávy

V této kapitole si ukážeme nejčastější chyby při práci se systémem Maple.

4.1 Chybové zprávy (Error Messages)

4.1.1 Math mode / Text mode

Jednou z prvních chyb, kterých se uživatelé často dopouštějí, je nevěnování dostatečné po-
zornosti příkazovému (matematickému) a textovému režimu. Příkazový (matematický) režim
(Math mode) slouží k zápisu příkazů. Po kliknutí na klávesu Enter dojde k jeho vyhod-
nocení. Textový režim slouží k zápisu obyčejného textu. Po kliknutí na klávesu Enter se
„pouzeÿ přesuneme na nový řádek. Častá a někdy těžko odhalitelná chyba je „smícháníÿ
těchto dvou režimů při zápisu příkazu, kdy zpravidla získáváme chybné výsledky. To, jestli
je celý příkaz zapsaný v příkazovém (matematickém) režimu, můžeme poznat z fontu písma
(ale nemusí tomu tak nutně být). Nejjistěji to poznáme umístěním kurzoru na příkaz, kdy
se objeví (naneštěští slabě viditelný) šedý obdélník tvořený přerušovanou čárou vymezující
znaky zapsané v příkazovém (matematickém) režimu – viz obrázek 4.1. U druhého příkazu ve
správné variantě (vpravo) je kurzor umístěn na příkazu, můžeme si tedy všimnout zmíněného
přerušovaného obdélníku.

Obrázek 4.1: Chyby v použití matematického a textového režimu.

4.1.2 Chybné argumenty příkazů

Další velmi častou chybou (ne-li nejčastější) je špatné zadání argumentů příkazů. Každý
příkaz má definované použití. Vždy mu musíme nastavit povinné argumenty, můžeme přidat
volitelné (charakterizované slovíčkem optional). Argumenty musí být zadány vždy v tako-
vém tvaru, jaký je předepsaný. Informace o tom, jak daný příkaz použít, jak specifikovat
argumenty příkazu, které argumenty jsou povinné a které volitelné, nalezneme v nápovědě
systému Maple k příslušnému příkazu. Následuje (na obrázku 4.2) přehled chybových zpráv,
které Maple při špatném zadání argumentů vypisuje.
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Obrázek 4.2: Chyby v zadávání argumentů příkazů.

4.1.3 Nesprávné použití závorek

V systému Maple můžeme používat všechny typy závorek, každý typ má však jiný význam
a tedy jiné použití. Navíc je třeba dávat pozor na počet levých (otevírajících) a počet pravých
(uzavírajících) závorek. Vždy, když se tyto počty nerovnají, systém vypíše chybovou zprávu
Error, unable to match delimiters (obrázek 4.3).

4.1.4 Nesprávné přiřazení

Systém Maple disponuje tzv. systémovými proměnnými a příkazy. Jejich názvy jsou chrá-
něné, tj. do chráněných proměnných není možné přiřazovat jiný typ hodnot, než pro který
jsou určeny a názvy příkazů není možné používat jinak než jako příkazy s definovaným použi-
tím (tj. není možné si např. vytvořit proměnnou se stejným názvem jako některý z příkazů).
To, jestli je nějaký název chráněný či nikoliv, je možné zjistit příkazem type majícím dva
argumenty: název (jméno), u nějž chceme zjistit, zda je chráněný, a argument protected
(který už se nenastavuje na žádnou hodnotu) – viz obrázek 4.4.
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Obrázek 4.3: Chyby v používání závorek.

Obrázek 4.4: Chyby v přiřazování hodnot do proměnných.

4.1.5 Dělení nulou

Když se při úpravě zadaného výrazu (příkazu) dostane Maple do situace, kdy má dělit nulou,
vypíše zprávu Error, numeric exception: division by zero. Tato situace se může přihodit
i u výrazů (příkazů), u nichž to neočekáváme (např. u funkce ln) – obrázek 4.5.

4.1.6 Nesprávný zápis mocnin

Při zápisu mocnin je možné se setkat s následujícími chybovými zprávami (obrázek 4.6).

4.1.7 Nesprávné použití objektů

V systému Maple můžeme narazit také na chybovou zprávu Error, illegal use of an object
as a name. Ta se objeví vždy, když použijeme nějaký objekt, který není jménem na místě,
kde systém jméno očekává. Význam chyby bude nejlépe patrný z obrázku 4.7.
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Obrázek 4.5: Vyhodnocení výrazu, v němž se dělí nulou.

Obrázek 4.6: Nesprávný zápis mocnin.

Obrázek 4.7: Nesprávné použití objektů.
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4.1.8 Nesprávné definice a použití funkcí

Různých chyb se můžeme dopustit i při definici a použití funkce (obrázek 4.8).

Obrázek 4.8: Nesprávné definice a použití funkcí.

4.1.9 Chyby při vykreslování

Následují chyby vyskytující se při vykreslování. Jako u každého příkazu musíme dbát na
správně uvedené argumenty i u příkazů pro vykreslování funkcí a výrazů. Chyby uvedené na
obrázku 4.9 jsou způsobeny především nesprávně uvedeným rozsahem proměnné x.

4.1.10 Další chyby

Na závěr chybových zpráv si ukážeme ještě tři chyby, s nimiž se často setkáváme, obr. 4.10.
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Obrázek 4.9: Chyby při vykreslování.

Obrázek 4.10: Další chybové zprávy.
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4.2 Varování (Warnings)

Kromě chybových zpráv vypisuje systém ještě tzv. varování. Varování může signalizovat naši
chybu (v zápisu příkazu), ale zpravidla informuje o důvodech, proč nemůže systém zadaný
příkaz vyhodnotit (někdy jej přesto vyhodnotí). Při výpisu varování s textem Warning,
solutions may have been lost je nutné přeformulovat problém (zapsat příkaz jinak, ne-
boť jej Maple nedokáže vyhodnotit). Ne vždy je toto však možné, zpravidla můžeme jinou
formulací problému dosáhnout alespoň „nějakých zlepšeníÿ.

Obrázek 4.11: Varování.
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5 Návody k řešení příkladů

Příklad 1.2: Pro vložení zadaného výrazu potřebujeme: sumační symbol a symbol nekonečna.
Sumační symbol nalezneme v paletě Expression, symbol nekonečna v paletě Common
Symbols. Zlomek můžeme buď vzít také z palety Expression, nebo jej zapíšeme ručně
pomocí lomítka.

Příklad 1.3: Potřebujeme vložit zlomek a mocninu (resp. exponent). Obojí najdeme v paletě
Expression. Můžeme také použít lomítko a „stříškuÿ.

Příklad 1.4: Opět využijeme již dříve zmíněných palet. Pozor však na vkládání Eulerova
čísla. To je nutné vzít z palety (resp. použít příkaz exp). Zapsané písmeno e z klávesnice
Maple bere jako „obyčejnéÿ písmeno (proměnnou) e.

Příklad 1.6: K zadání výrazu potřebujeme příkaz sqrt pro vložení odmocniny a příkaz exp
pro vložení Eulerova čísla. Příkaz má jeden parametr, kterým je exponent Eulerova čísla (tj.
pro Eulerovo číslo samotné zadáváme exp(1)). Vložit Eulerovo číslo je možné též zapsáním
písmene e, vyvoláním funkce automatického dokončování a zvolením položky Exponential
’e’.

Příklad 1.7: Nejrychlejší způsob je zadat do dokumentu ?sum, případně zadat sum, umístit
kurzor na příkaz a stisknout klávesu F2.

Příklad 1.8: Je několik způsobů, jak to zjistit. Zřejmě nejrychlejší je vyhledávat v nápovědě
klíčová slova matrix a vector, případně Linear Algebra.

Příklad 1.10: Pozor na rozdíl mezi počtem platných cifer a počtem desetinných míst.

Příklad 1.11: Když zapíšíme nějaké číslo s desetinnou tečkou, Maple jej automaticky bude
brát jako číslo v pohyblivé řádové čárce a výpočty s ním bude zaokrouhlovat na počet
platných míst specifikovaný proměnnou Digits.

Příklad 1.13: Použijeme příkaz isolve.

Příklad 1.14: Použijeme příkaz isolve. Systém Maple vypíše řešení s použitím konstant,
které jsou přirozenými čísly (bez nuly). Správně však mají být použity nezáporné celočíselné
konstanty.

Příklad 1.16: Řešíme jako soustavu nerovnic příkazem solve.

Příklad 1.17: Použijeme příkaz solve. Pro a = 0 bychom dostali lineární polynom.
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Příklad 1.18: Řešíme opět příkazem solve. Pozor, daná rovnice má nekonečně mnoho řešení.

Příklad 1.19: Řešíme jako soustavu rovnic příkazem solve.

Příklad 2.3: Použijeme zavedení předpokladu: assuming.

Příklad 2.4: Použijeme příkaz simplify.

Příklad 2.5: Použijeme příkaz simplify.

Příklad 2.6: Použijeme příkaz factor.

Příklad 2.7: Použijeme příkaz simplify.

Příklad 2.8: Využijeme příkazů simplify, factor a convert.

Příklad 2.12: Pro všechna x ∈ R platí: sin(x) ∈ [−1, 1].

Příklad 2.13: Platí: f(x) = 1
x2−5·x+6 a f(−x) = 1

x2+5·x+6 . Z toho máme: f(x) 6= f(−x),
f(x) 6= −f(−x) a tedy funkce není sudá, ani lichá. D(f) = R \ {2, 3}, H(f) = R \ (−4, 0].
Obor hodnot určíme z toho, že polynom x2−5 ·x+6 nabývá všech kladných hodnot (a proto
musí i funkce f(x)). Zmíněný polynom nabývá též záporných hodnot, a to na intervalu (2, 3),
přičemž tu nejmenší přesně uprostřed intervalu, tj. v bodě x = 5

2 . Funkce f(x) v tomto bodě
naopak nabývá své nejvyšší hodnoty na intervalu (2, 3), a to hodnoty −4.

Z předešlého plyne, že funkce není ohraničená.

Příklad 2.14:

(a) f(x) = 9− x2, f(−x) = 9− x2 = f(x)⇒ sudá funkce,

(b) f(x) =
√
x, f(−x) =

√
−x⇒ ani sudá, ani lichá,

(c) f(x) = 1
x
, f(−x) = −1

x
= −f(x)⇒ lichá funkce.

Příklad 2.15:

(a) f(x) = 2 · x, kde x ∈ (0, 1),

(b) f(x) = 1
x−1 ,

(c) f(x) = 1
x

+ 1,

(d) f(x) = ex,

(e) f(x) =

{
x+ 2 ... x ≤ −2

x− 2 ... x ≥ 2
,

(f) f(x) =


x− 2 ... x ≤ 0

2 ... 0 < x ≤ 1

x+ 1 ... x ≥ 1

,

(g) f(x) = arctan(x),

(h) f(x) =

{
ln(−x) ... x < 0

ln(x) ... x > 0
.

Příklad 2.16: f(x) = x3 − k · x2 + 2 · x, f(−x) = −(x3 + k · x2 + 2 · x). Z toho dostáváme:
k = −k = 0.
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Příklad 2.17:

(a) Pro a 6= 0 se jedná o bijekci.

(b) Ano, je to bijekce.

(c) Nejedná se o bijekci, funkce není prostá.

(d) Ano, je to bijekce.

(e) Ano, je to bijekce.

Příklad 2.19:

(a) f−1(x) = 1
2 · (x− 1),

(b) f−1(x) = 3
√
x,

(c) f−1(x) = x−1
x+1 ,

(d) f−1(x) = (1− x)2 ... x ≥ 0,

(e) f−1(x) = 1
x
,

(f) zadaná funkce není prostá (a nemá tak inverzi).

Příklad 2.20: Každá funkce osově symetrická vzhledem k přímce y = x je sama sobě inverzí.
To znamená, že jich je dokonce nekonečně mnoho.

Příklad 2.22: g−1(x) = 1
2 · ln(x). Legendu můžeme do grafu přidat nastavením parametru

legend příkazu plot nebo kliknutím na graf a výběrem z kontextové nabídky.

Příklad 2.23: Použijeme příkaz animate. Funkce h(x) je klesající pro a < 0, rostoucí pro
a > 0 a konstantní pro a = 0.

Příklad 2.25: Vycházíme z definice 2.8, pouze se nyní přibližujeme k bodu x0 zprava, tj.
uvažujeme interval (x0, x0 + δ).

Příklad 2.26: Vyjdeme z definic 2.9 a 2.10. Uvažujeme bod ∞ (resp. −∞) a chceme popsat
stav, kdy pro libovolně „vysokouÿ (resp. „nízkouÿ) hodnotu M existuje hranice, nad níž
(resp. pod níž) pro všechna x platí, že funkční hodnota f(x) je větší (resp. menší) než ona
původně (libovolně) zvolená hodnota M .

Příklad 2.27: Maple zvládne určit všechny limity. Postupujeme tedy klasicky využitím sym-
bolu pro počítání limit z palety, kontextové nabídky nebo příkazu limit.

Příklad 2.28:

(a) Zavedeme substituci y = x3.

(b) Využijeme vzorce cos(x) = cos(x2 )2 − sin(x2 )2.

(c) Rozšíříme výrazem
√
x2 + 5 + 3.
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(d) Rozšíříme výrazem 1
x

a uvědomíme si, že pro x→ −∞ je x = −
√
x2.

(e) Zadaný zlomek rozložíme na součet dvou zlomků a zavedeme substituci u = −x. Dal-
šími drobnými úpravami umíme rozhodnout, kam se který výraz (zlomek) limitně blíží
pro u→∞.

(f) Využijeme vzorce sin(2 · t) = 2 · sin(t) · cos(t) a platnosti lim
x→0

sin(x)
x

= 1.

Příklad 2.29:

(a) Stačí dát příklad takřka jakékoli „rozumnéÿ funkce definované na nějakém neprázdném
intervalu – viz definice 2.7.

(b) Vycházíme z 2.10. Je třeba dát příklad funkce f(x), jejíž hodnoty se blíží nějakému
konečnému číslu pro x→∞ (resp. x→ −∞). Mohla by něco takového splňovat nějaká
polynomiální, mocninná, exponenciální, či goniometrická funkce?

(c) Takřka „opačnýÿ případ k předešlému. Hledáme funkci f(x), která pro nějaké ko-
nečně velké x „roste nade všechny mezeÿ (resp. „klesá pod všechny mezeÿ). Mohla
by něco takového splňovat nějaká polynomiální, mocninná, exponenciální, či goniome-
trická funkce?

(d) Nyní chceme najít funkci f(x), jejíž hodnoty se blíží ∞ (resp. −∞) pro x→∞ (resp.
x→ −∞). Opět je na místě stejná otázka: splňuje toto nějaká polynomiální, mocninná,
exponenciální, či goniometrická funkce?

(e) Musíme spojit všechny předešlé body. Na bod (a) můžeme zapomenout. Pokud splníme
všechny ostatní, bude splněna i tato podmínka. Jedno možné řešení je najít funkci
splňující (b) a (d) – takovou funkci jste již možná dokonce našli – a zkombinovat ji (tj.
např. vynásobit) s funkcí splňující bod (c).

Příklad 2.31:

(a) Musíme se obejít bez systému Maple, jelikož příkaz discont neumí hledat nespojitosti
u funkcí definovaných po částech. Podezřelé body z nepojitosti jsou body 1 a 2. Musíme
ověřit, zda v nich existuje limita a zda je rovna příslušné funkční hodnotě.

(b) V tomto případě příkaz discont pracuje bezchybně.

(c) Opět se musíme obejít bez systému Maple. Postupujeme analogicky k řešení příkladu
2.30.

Příklad 2.32: Postupujeme analogicky k řešení příkladu 2.30. Hledání čísel c a d vede na
soustavu dvou rovnic.

Příklad 2.33: Jsou dvě hlavní možnosti, jak postupovat. Buď vzít známou funkci, která není
spojitá, ale víme, že má limitu v každém bodě (na daném intervalu), nebo vzít funkci spojitou
(ta má limitu v každém bodě) a nespojitost „vytvořitÿ, aniž bychom porušili existenci limity.

Příklad 2.34: Systém Maple zvládne určit všechny derivace. Ke správné odpovědi je nutné
porozumět výpisu systému v případě (b). Symbol D tu značí diferenciální operátor.
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Příklad 2.35: Je třeba najít spojitou funkci f(x), pro niž by v nějakém bodě x0 neexistovala
limita z definice 2.14: lim

x→x0

f(x)−f(x0)
x−x0 . K tomu, aby tato limita neexistovala, stačí, aby se

nerovnaly limity zleva a zprava, tedy aby platilo: lim
x→x0−

f(x)−f(x0)
x−x0 6= lim

x→x0+
f(x)−f(x0)

x−x0 . Jak

musí vypadat funkce splňující předchozí nerovnost?
Když najdeme právě popsanou funkci, je již jednoduché např. definováním po částech

vytvořit funkci, která bude mít na daném intervalu libovolný počet (a tedy i např. rovný
dvěma) bodů, v nichž bude funkce spojitá, ale nebude v nich mít derivaci.

Příklad 2.36: Z poznámky 2.4 víme, že směrnice tečny je rovna derivaci funkce v příslušném
bodě. V rovnici tečny tak zbývá určit pouze konstantní člen, jehož hodnotu zjistíme z toho,
že tečna má s funkcí jeden společný bod.

Příklad 2.37: Jelikož má být tečna rovnoběžná s nějakou přímkou, musí mít stejnou směrnici.
Tedy pokud y = k ·x+q je rovnicí tečny k funkci f(x) v bodě x0, pak musí platit k = f ′(x0) =
12 (neboť 12 je směrnice rovnoběžné přímky). Jelikož f ′(x0) = 3 · x0

2, dostáváme dva různé
body x0 a tedy dvě tečny.

Příklad 2.38: Řešíme obdobně jako předchozí příklad. Směrnice zadané přímky je rovna −1
3 .

My potřebujeme nyní směrnici kolmice. K tomu využijeme lineární algebry, odkud víme, že
dva vektory jsou na sebe kolmé, jestliže je jejich skalární součin roven 0. Máme-li přímky
y = k · x a y = l · x, pak tyto jsou na sebe kolmé, jestliže 1 + k · l = 0. Z toho dostáváme, že
směrnice hledané kolmice je rovna 3, což je tedy směrnice tečny. Tedy pokud y = k · x+ q je
rovnicí tečny k funkci f(x) v bodě x0, pak musí platit k = f ′(x0) = 3. Jelikož f ′(x0) = 3 ·x0

2,
dostáváme opět dva různé body x0 a tedy dvě tečny.

Příklad 2.40: f(x) =
√
x, x0 = 49, h = 2.

Příklad 2.41: f(x) = 3
√
x, x0 = 125, h = −2.

Příklad 2.42: f(x) = x4, x0 = 3, h = −0.05.

Příklad 2.43: Použijeme příkaz taylor pro bod x = 0 a získaný výsledek převedeme na
polynom příkazem convert.

Příklad 2.44: Použijeme příkaz taylor pro bod x = 1. Proměnnou Order nastavíme na
hodnotu 5 a získaný výsledek převedeme na polynom příkazem convert.

Příklad 2.45: Použijeme příkaz taylor pro bod x = 2.

Příklad 2.47: Postupujeme analogicky k příkladu 2.46.

(a) Uvažujeme funkci ex, kterou rozvineme do Taylorova polynomu v bodě x0 = 0, a hle-
dáme aproximaci v bodě x = −1. Stejným postupem jako v příkladu 2.46 dospějeme
k tomu, že je pro požadovanou přesnost potřeba nastavit proměnnou Order na hodnotu
7.

(b) Uvažujeme funkci 5
√
x, kterou rozvineme do Taylorova polynomu v bodě x0 = 243,

a hledáme aproximaci v bodě x = 250. Nyní musíme k odhadu velikosti Taylorova

157



zbytku použít poznámku 2.7, neboť x0 6= 0. Tvar zbytku je pak nejjednodušší vyhod-
nocovat postupně pro n = 1, 2, ..., neboť Maple neumí vyřešit příslušnou nerovnici.
Dostatečné n v tomto případě: n = 2.

Příklad 2.50:

(a) Funkce f má tři stacionární body, z nichž jediný je lokální extrém, další dva jsou body
inflexní. Funkce nemá žádnou asymptotu.

(b) Funkce f má dva stacionární body, oba jsou lokálními extrémy. Funkce má dále tři
inflexní body. Funkce není definována ve dvou bodech, v nichž má asymptoty bez
směrnice. Asymptoty se směrnicí neexistují. Aby Maple tento příklad správně vyřešil,
je potřeba načíst balík RealDomain.

(c) Funkce má dva stacionární body, z nichž jeden je lokální extrém, druhý je inflexním
bodem. Funkce není definována v jediném bodě, v němž má asymptotu bez směrnice.
Funkce má také asymptotu se směrnicí.

(d) Funkce má nekonečně mnoho stacionárních bodů (na zjištění tohoto v Maple je třeba
použít atribut allsolutions), všechny jsou však inflexními body. Funkce má i další
inflexní body (vždy uprostřed intervalu tvořeného stacionárními body). Funkce nemá
asymptotu bez směrnice ani asymptotu se směrnicí. Opět pozor na výpočet systému
Maple – při počítání limit v některých případech vypisuje interval jako hodnotu limity
(limita však neexistuje).

(e) Zásadní otázka v tomto příkladu je, zda je funkce f(x) spojitá v bodě 0. Funkce má tři
stacionární body a všechny jsou jejími lokálními extrémy. Funkce má dále dva inflexní
body a žádnou asymptotu (bez směrnice či se směrnicí).

Příklad 2.54:

(a) Stačí rozložit na dva zlomky a určit přímo ze znalosti „tabulkovýchÿ integrálů.

(b) Výraz pod odmocninou je možné upravit tak, aby se dala odmocnina odstranit (apli-
kovat). Poté už se výsledek určí podobně jako v předchozím případě.

(c) Po roznásobení je možné integrovat každý člen zvlášť.

(d) Rozklad na parciální zlomky.

(e) Opět rozklad na parciální zlomky. V tomto případě je však výrazně pracnější než
předchozí, neboť jeden ze získaných parciálních zlomků je třeba dále upravit (rozložit),
abychom integrací získali přirozený logaritmus. Tím se nám však objeví další zlomek,
u nějž je třeba rozpoznat, že připomíná derivaci funkce arkus tangens (arctan), jen je
potřeba zlomek opět upravit do vhodného tvaru.

(f) Zavedeme substituci t = 5 · x+ 6.

(g) Zavedeme substituci t = ln(x).

(h) Zavedeme substituci t = x2 + 1.
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(i) Řešíme metodou per partes, přičemž funkce, kterou budeme chtít derivovat, bude
funkce x. Maple při použití příkazu Parts využije znalosti

∫
cos2(x) dx = 1

2 · cos(x) ·
sin(x) + 1

2 · x, k čemuž dospějeme užitím vztahu cos2(x) = 1+cos(2·x)
2 . Integrál získaný

metodou per partes je třeba rozložit a na jeden z nich použít substituční metodu.

(j) Řešíme metodou per partes. Funkcí, kterou budeme derivovat, je funkce ln(x).

(k) Řešíme opět metodou per partes. Funkci arctan(x) si zapíšeme jako arctan(x)·1 a právě
samotná funkce arctan(x) bude ta, kterou budeme derivovat.

(l) Řešíme nejprve substituční metodou položením t = x2. Následně použijeme metodu
per partes, přičemž funkce, kterou budeme derivovat, bude funkce x.

Příklad 2.55: Ve všech případech využíváme Newton-Leibnizovy formule.

(a) Řešíme metodou per partes.

(b) Zavedeme substituci x = t2.

(c) Zavedeme substituci cos(x) = t.

(d) Zavedeme substituci ex = t.

(e) Řešíme metodou per partes.

(f) Zavedeme nejprve substituci t = ex a následně u2 = t− 1.

Příklad 2.58:

(a) Řešíme naprosto analogicky s příkladem 2.56. Výsledek je: S = 16·
√

2
3 .

(b) Obsah zadané plochy je třeba počítat „na dvakrátÿ. Nejprve se spočítá obsah plochy
mezi křivkami y = −x a y = 1 na intervalu [−1, 0], následně obsah plochy mezi
křivkami y = x3 a y = 1 na intervalu [−1, 0]. Výsledek je: S = 5

4 .

(c) Stačí si uvědomit, mezi kterými částmi křivek leží zadaná plocha. Výsledek je: S = 1
3 .

(d) Řešíme rovnou podle poznamky 2.21. Výsledek je: S = ln(2)
2 .

(e) Řešíme opět rozdělením na dva určité integrály. Výsledek je: S = 4 · ln(2)− 2.
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Obrázek 5.1: Zobrazení plochy z příkladu 2.58.(a).

Obrázek 5.2: Zobrazení plochy z příkladu 2.58.(b).
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Obrázek 5.3: Zobrazení plochy z příkladu 2.58.(c).

Obrázek 5.4: Zobrazení plochy z příkladu 2.58.(d).
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Obrázek 5.5: Zobrazení plochy z příkladu 2.58.(e).
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Příklad 2.59:

(a) Pomocí derivace musíme určit rovnici tečny. Dále už řešíme analogicky k předchozím
příkladům. Výsledek je: S = 23

8 .

Obrázek 5.6: Zobrazení plochy z příkladu 2.59.(a).

(b) Opět musíme určit rovnici tečny a také její průsečík s funkcí y = x3. Výsledek je:
S = 27

4 .

(c) Nyní je třeba určit rovnice dvou tečen a jejich průsečík. Výsledek je: S = 9
4 .
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Obrázek 5.7: Zobrazení plochy z příkladu 2.59.(b).

Obrázek 5.8: Zobrazení plochy z příkladu 2.59.(c).
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Příklad 2.60: Ve všech případech využijeme poznámky 2.22:

(a) Výsledek je: S = 72·
√

3
5 .

Obrázek 5.9: Zobrazení plochy z příkladu 2.60.(a).

(b) Výsledek je: S = 12 · π.

Obrázek 5.10: Zobrazení plochy z příkladu 2.60.(b).

(c) Výsledek je: S = 27·π
16 .

Příklad 2.61: Je třeba odvodit rovnici kružnice. Máme dvě možnosti – buď popsat „horníÿ po-
lovinu kružnice vztahem y =

√
r2 − x2 a „spodníÿ polovinu kružnice vztahem y = −

√
r2 − x2,

nebo kružnici popsat parametricky předpisem x = r · sin(t), y = r · cos(t), t ∈ [0, 2 · π]. Ná-
sledně využijeme odpovídajícího určitého integrálu. Při použití prvního postupu je v Maple
nutné přidat při výpočtu integrálu předpoklad, že r je nezáporné (reálné) číslo, abychom
dospěli k požadovanému výsledku.
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Obrázek 5.11: Zobrazení plochy z příkladu 2.60.(c).

Příklad 2.64: Ve všech případech využijeme poznámky 2.23.

(a) l = 26·
√

13
27 − 16

27

(b) l =
e−1·
√

2·e2+e4+1·(e2−1)
e2+1

.
= 2.35

(c) Systém Maple vyjádří řešení za pomoci eliptického integrálu. Informace k tomu vý-
sledku můžeme nalézt v nápovědě. Příkazem evalf získáme přibližné numerické řešení.

l = 2 ·
√

2 · EllipticE(
√

2
2 ) = 2 ·

√
2 ·

1∫
0

√
1−x22√
1−x2 dx

.
= 3.82

(d) l = 2 ·
√

2 · EllipticE(
√

2
2 ) = 2 ·

√
2 ·

1∫
0

√
1−x22√
1−x2 dx

.
= 3.82

Příklad 2.65: Ve všech případech využijeme poznámky 2.24.

(a) l = 2 ·
√

3

(b) l = 2 · π2

(c) l = 2 · π ·
√

1 + 16 · π2 − 1
2 · ln

(
−4 · π +

√
1 + 16 · π2

)
Příklad 2.66: Řešíme analogicky jako v příkladu 2.61, jen místo obsahu kruhu počítáme
obvod kružnice.

Příklad 2.69: Ve všech případech využijeme poznámky 2.25:

(a) Výsledek: V = 3·π
10 .

(b) Výsledek: V = π2

2 .

(c) Výsledek: V = 8·π
3 .

(d) Výsledek: V = 8·π
3 .
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Obrázek 5.12: Zobrazení zadané plochy a získaného rotačního tělesa z příkladu 2.69.(a).

Obrázek 5.13: Zobrazení zadané plochy a získaného rotačního tělesa z příkladu 2.69.(b).
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Obrázek 5.14: Zobrazení zadané plochy a získaného rotačního tělesa z příkladu 2.69.(c).

Obrázek 5.15: Zobrazení zadané plochy a získaného rotačního tělesa z příkladu 2.69.(d).
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Příklad 2.70: Ve všech případech využijeme poznámky 2.26:

(a) Výsledek: V = 3·π
4 .

Obrázek 5.16: Zobrazení zadané plochy a získaného rotačního tělesa z příkladu 2.70.(a).

(b) Výsledek: V = 288·π
35 .

Obrázek 5.17: Zobrazení zadané plochy a získaného rotačního tělesa z příkladu 2.70.(b).

(c) Výsledek: V = 3 · π.

(d) Výsledek: V = 4 · π2.
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Obrázek 5.18: Zobrazení zadané plochy a získaného rotačního tělesa z příkladu 2.70.(c).

Obrázek 5.19: Zobrazení zadané plochy a získaného rotačního tělesa z příkladu 2.70.(d).

Příklad 2.71: Koule vznikne například rotací „horníÿ poloviny kruhu kolem osy x. Je tedy
potřeba odvodit rovnici kružnice o poloměru r a její „horníÿ polovinu použít pro dosazení
do vztahu pro výpočet objemu.

Příklad 2.72: Válec o poloměru podstavy r a výšce válce v vznikne rotací (kolem osy x)
obdélníka tvořeného stranou o délce v na ose x, kolmicemi v krajních bodech o délkách r
a zbylou stranou o délce v (spojující kolmice „na druhé straněÿ).

Příklad 2.73: Kužel vznikne rotací trojúhelníka kolem osy x. Trojúhelník je tvořen úsečkou
na ose x odpovídající výšce kužele a kolmicí na jednom konci úsečky o délce rovné polo-

170



měru kužele. Lineární funkce pak spojí „zbývající konceÿ úsečky a kolmice (při vhodném
„rozmístěníÿ může být lineární funkcí funkce y = r

v
· x).

Příklad 2.76: Ve všech případech využijeme poznámky 2.28. Obsah pláště zpravidla počítáme
rozdělením na části pláště získané rotacemi jednotlivých funkcí na odpovídajících intervalech.

(a) S = 1
96 · π ·

(
134 ·

√
5− 3 · ln

(√
5 + 2

)
− 16

) .
= 9.14 .

(b) S = 2 · π ·
(√

2 + ln
(
1 +
√

2
)) .

= 14.42.

(c) S = π ·
(√

17 + 2 · ln (2)− ln
(
1 +
√

17
)

+ 2 ·
√

2 + ln
(
1 +
√

2
)

+ 6
) .

= 42.68.

(d) S = 4 · π ·
(√

2 + 2
) .

= 42.90.

Příklad 2.77: Ve všech případech využijeme poznámky 2.29:

(a) S = 3 · π.

(b) S = 108·π
5 .

(c) S = π ·
(
2 ·
√

5 + ln
(√

5 + 2
)) .

= 18.58.

(d) S = 8 · π2.

Příklad 2.78: Řešíme zcela analogicky k příkladu 2.71.

Příklad 2.79: Řešíme analogicky k příkladu 2.72. Pozor na to, že v zadání se požaduje povrch
celého válce, tj. musíme určit povrch pláště i podstavy válce.

Příklad 2.81: Postupujeme stejným způsobem jako v příkladu 2.80. Tentokrát je funkce

nespojitá v bodě 0, a musíme tak určit lim
t→0+

1∫
t

x · ln(x) dx.

Příklad 2.83:

(a) Integrál diverguje: lim
x→∞

(2 ·
√
x) =∞.

(b)
∞∫
−∞

1
1+x2 dx = lim

x→−∞
arctan(x) + lim

x→∞
arctan(x).

(c) Maple ve výledku zobrazí Fresnelův integrál definovaný jako

FresnelS (x) =

x∫
0

sin

(
1
2
· π · t2

)
dt,

neboť neumí zapsat řešení analyticky pomocí standardních funkcí. Příkazem evalf
zjistíme, že příslušný integrál konverguje.

(d) Integrál diverguje: lim
x→∞

ln(x) =∞.
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Příklad 3.4: Nakreslené oblasti jsou zobrazeny na obrázcích 5.20 – 5.24

(a)

Obrázek 5.20: Zobrazení zadané oblasti z příkladu 3.4.(a).

(b)

Obrázek 5.21: Zobrazení zadané oblasti z příkladu 3.4.(b).
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(c)

Obrázek 5.22: Zobrazení zadané oblasti z příkladu 3.4.(c).

(d)

Obrázek 5.23: Zobrazení zadané oblasti z příkladu 3.4.(d).
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(e)

Obrázek 5.24: Zobrazení zadané oblasti z příkladu 3.4.(e).

Příklad 3.6: Příslušné definiční obory jsou zobrazeny na obrázcích 5.25 – 5.30

(a) Výraz pod odmocninou musí být nezáporný.

Obrázek 5.25: Zobrazení definičního oboru funkce z příkladu 3.6.(a).
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(b) Výraz pod odmocninou musí být nezáporný.

Obrázek 5.26: Zobrazení definičního oboru funkce z příkladu 3.6.(b).

(c) Argument funkce ln musí být kladný.

Obrázek 5.27: Zobrazení definičního oboru funkce z příkladu 3.6.(c).

(d) Argument funkce arccos musí nabývat hodnot z intervalu [−1, 1]. Systém Maple má
s vykreslením příslušné množiny „problémyÿ. Při vyšší hodnotě parametru gridrefine
je výsledek akceptovatelný.
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Obrázek 5.28: Zobrazení definičního oboru funkce z příkladu 3.6.(d).

(e) Výrazy pod odmocninami musí být nezáporné. Díky jejich tvaru je pro ně možné vy-
tvořit jedinou nerovnost a zbývající část podmínky „schovatÿ do rozsahu proměnných,
abychom mohli použít příkaz implicitplot.

Obrázek 5.29: Zobrazení definičního oboru funkce z příkladu 3.6.(e).
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(f) Argument funkce ln musí být kladný, tzn. x > 0 ∧ y − x > 0.

Obrázek 5.30: Zobrazení definičního oboru funkce z příkladu 3.6.(f).

Příklad 3.7:

(a) Pro některé hodnoty parametru contoursMaple nezobrazí vrstevnice y = −x a y = x.

Obrázek 5.31: Zobrazení vrstevnic funkce z příkladu 3.7.(a).

(b) Pro rovnoměrné rozložení vrstevnic na zadané oblasti je vhodné specifikovat parametr
contours seznamem funkčních hodnot.
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Obrázek 5.32: Zobrazení vrstevnic funkce z příkladu 3.7.(b).

Obrázek 5.33: Zobrazení vrstevnic funkce z příkladu 3.7.(c).

(c)

Zadaná funkce je nespojitá pro y = 0, s čímž si Maple „neumí poraditÿ a vykresluje
v tomto místě svislou plochu. Příkaz plot3d nemá k dispozici parametr discont, což se
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obchází vytvořením dvou grafů tak, abychom se nespojitosti „vyhnuliÿ – vykreslíme
funkci nalevo od místa nespojitosti a napravo, grafy pak spojíme v jeden příkazem
display.

(d)

Obrázek 5.34: Zobrazení vrstevnic funkce z příkladu 3.7.(d).

Příklad 3.10: Položíme δ = min{ε, 1}. Následně musíme ukázat, že pro libovolná x, y splňující
|x| < δ, |y| < δ, [x, y] 6= [0, 0] platí:

x2 · y2

x2 + y2
< ε.

Jelikož x, y splňuje [x, y] 6= [0, 0], je aspoň jedno z nich nenulové. Bez újmy na obecnosti
předpokládejme, že například y 6= 0. Pak pro jinak libovolná x, y platí: x2 < x2 + y2. Z toho
máme:

x2 · y2

x2 + y2
< y2.

Pro ε > 1 máme |x| < 1, |y| < 1 a tedy

x2 · y2

x2 + y2
< y2 < 1 < ε.

Pro ε ≤ 1 máme |x| < ε, |y| < ε a tedy

x2 · y2

x2 + y2
< y2 < ε2 ≤ ε.

Příklad 3.11:

(a) Maple určí správně, že limita neexistuje. Sami to můžeme ověřit například přibližo-
váním se po přímkách y = k · x. Výsledek je závislý na k, tj. na přímce, po níž se
k limitnímu bodu blížíme.

(b) Maple limitu neumí spočítat. Limita v tomto případě opět neexistuje, což můžeme
stejně jako v předchozím případě ověřit přibližováním se k limitnímu bodu po přímkách.
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(c) Maple limitu nespočítá. Limita neexistuje, což můžeme zjistit pomocí transformace do
polárních souřadnic. Získaný výsledek závisí na úhlu ϕ.

(d) Maple limitu nespočítá ani v tomto případě, i když stačí pouze dosadit.

(e) Maple limitu nespočítá. Limita existuje a je rovná 0. Ověřit to můžeme transformací
do polárních souřadnic a aplikací poznámky 3.4.

(f) Maple limitu nespočítá. Proměnná y tu přitom není zdrojem nespojitosti, a tak za ni
můžeme dosadit a počítat zadanou limitu pouze jako limitu v proměnné x.

(g) Maple limitu nespočítá ani tentokrát. Limita existuje a je rovná 1
2 . Výsledek získáme

po rozšíření zadaného výrazu doplněním čitatele na rozdíl čtverců, následné úpravě
a dosazení.

Příklad 3.13: V případech a) – d) jsou body nespojitosti tvořeny vždy body, které nejsou
v definičním oboru funkce f(x, y). Ve všech bodech definičního oboru jsou funkce totiž spo-
jité.

(a) Jmenovatel rovný nule, takže jediným bodem nespojitosti funkce f(x, y) je bod [0, 0].

(b) Jmenovatel rovný nule, tj. body [x, y] takové, že x = 0 nebo y = 0.

(c) Jmenovatel rovný nule, tj. body [x, y] takové, že y = 0.

(d) Argument funkce ln(x) nekladný, tj. body [x, y] takové, že x2 + y2 = 1.

(e) Funkce f(x, y) nemá body nespojitosti. Jediný „podezřelýÿ bod z nespojitosti je bod
[0, 0], v němž je však limita rovna funkční hodnotě (viz příklad 3.9).

Příklad 3.14:

(a) Podle příkladu 3.11.(g): C = 1
2 .

(b) Podle příkladu 3.11.(c) limita v bodě [0, 0] neexistuje, tj. není možné „dodefinovatÿ C
tak, aby zadaná funkce byla v bodě [0, 0] spojitá.

Příklad 3.15:

(a) f ′x(x, y) = 2 · x · y + 1
x
,

f ′y(x, y) = x2 − 1
y
,

f ′′xx(x, y) = 2 · y − 1
x2

,
f ′′xy(x, y) = 2 · x,
f ′′yx(x, y) = 2 · x,
f ′′yy(x, y) = 1

y2
,

(b) f ′x(x, y) = 8 · (x2 · y + y)3 · x · y,
f ′y(x, y) = 4 · (x2 · y + y)3 · (x2 + 1),
f ′′xx(x, y) = 56 · x6 · y4 + 120 · x4 · y4 + 72 · x2 · y4 + 8 · y4,
f ′′xy(x, y) = 32 · x7 · y3 + 96 · x5 · y3 + 96 · x3 · y3 + 32 · x · y3,
f ′′yx(x, y) = 32 · x7 · y3 + 96 · x5 · y3 + 96 · x3 · y3 + 32 · x · y3,

f ′′yy(x, y) = 12 · y2 · (x2 + 1)4,
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(c) f ′x(x, y) = xy ·y
x

,
f ′y(x, y) = xy · ln(x),
f ′′xx(x, y) = xy−2 · y · (y − 1),
f ′′xy(x, y) = xy−1 · (y · ln(x) + 1),
f ′′yx(x, y) = xy−1 · (y · ln(x) + 1),
f ′′yy(x, y) = xy · ln(x)2,

(d) f ′x(x, y) = y · ln(x+ y) + x·y
x+y ,

f ′y(x, y) = x · ln(x+ y) + x·y
x+y ,

f ′′xx(x, y) = y · x+2∗y
(x+y)2 ,

f ′′xy(x, y) = ln(x+ y) + y
x+y + x

x+y −
x·y

(x+y)2 ,
f ′′yx(x, y) = ln(x+ y) + y

x+y + x
x+y −

x·y
(x+y)2 ,

f ′′yy(x, y) = x · 2·x+y
(x+y)2 .

Příklad 3.16:

(a) f ′x(1, 2) =
1+ 15 ·

√
5

1+
√

5
, f ′y(1, 2) = 2

5 ·
√

5
1+
√

5
,

(b) f ′x(e, e) = 12
e
, f ′y(e, e) = −12

e
,

(c) f ′x(1, 2) = 0, f ′y(1, 2) = 1
4 .

Příklad 3.18:

(a) f ′u(A) =
√

2
2 ,

(b) Příkaz DirectionalDerivative neumí pracovat s obecnými směry. Je proto potřeba
vypočítat řešení jinak. f ′u(A) = 1

2 · (cos(α) + sin(α)).

Příklad 3.20:

(a) f(x, y) = xy, [x0, y0] = [3, 1], [x, y] = [3.05, 0.99],

(b) Nejprve převedeme stupně na radiány. f(x, y) =
√
x · cos(y), [x0, y0] = [3, π3 ], [x, y] =

[3.05, 31·π
90 ],

(c) f(x, y) = arctan(x
y
), [x0, y0] = [1, 1], [x, y] = [1.02, 0.95],

(d) f(x, y) = log4(x · y2), [x0, y0] = [4, 1], [x, y] = [4.01, 0.97].

Příklad 3.22:

(a) t(x, y) = 4 · x− 2 · y − 5,

(b) t(x, y) = 5 · x+ y − 3,

(c) t(x, y) = 4
5 · x+ 2

5 · y + ln(5)− 2,

(d) t(x, y) = 1.
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Příklad 3.23: Ve všech příkladech použijeme příkaz mtaylor.

(a) musíme specifikovat bod [x = 1, y = 1],

(b) musíme specifikovat bod [x = 0, y = π
2 ],

(c) musíme změnit proměnnou Order nebo přidat třetí parametr příkazu mtaylor,

(d) musíme specifikovat všechny tři proměnné.

Příklad 3.24:

(a) f(x, y) =
√
x3 + y3, [x0, y0] = [1, 2], [x, y] = [1.02, 1.97],

(b) Nejprve převedeme stupně na radiány. f(x, y) =
√
x · cos(y), [x0, y0] = [3, π3 ], [x, y] =

[3.05, 31·π
90 ],

(c) f(x, y) = arctan(x
y
), [x0, y0] = [1, 1], [x, y] = [1.02, 0.95],

(d) f(x, y) = log4(x · y2), [x0, y0] = [4, 1], [x, y] = [4.01, 0.97].

Příklad 3.25: Definice lokálního minima je naprosto stejná s definicí 3.9, jen nyní požadujeme,
aby pro všechna X z nějakého okolí bodu X∗ platilo: f(X) ≥ f(X∗).

Příklad 3.30:

(a) Funkce má 2 stacionární body, z nichž jeden (bod [1, 1]) je lokálním minimem.

(b) Funkce má 4 stacionární body. Dva z nich jsou lokálními extrémy. Bod [0,−1] je lokál-
ním minimem, bod [0, 1] je lokálním maximem.

(c) Funkce má 8 stacionárních bodů. Čtyři z nich jsou lokální extrémy. Body [−
√

2·e
2·e ,−

√
2·e

2·e ]

a [
√

2·e
2·e ,

√
2·e

2·e ] jsou lokální minima, body [−
√

2·e
2·e ,

√
2·e

2·e ] a [
√

2·e
2·e ,−

√
2·e

2·e ] jsou lokální maxima
zadané funkce.

(d) Funkce má nekonečně mnoho stacionárních bodů, které jsou též jejími lokálními ex-
trémy. V bodě [0, 0] se nachází lokální minimum. Ostatní stacionární body, které jsou
všechny lokálními maximy, leží na kružnici x2 +y2 = 1. Klasickým způsobem neumíme
o těchto bodech rozhodnout. Pro ověření, že se jedná o lokální maxima, můžeme zavést
substituci t = x2 + y2 a vyšetřit lokální extrémy funkce, jako by se jednalo o funkci
jedné proměnné.

(e) Funkce má jediný stacionární bod ([2, 4]), který je jejím lokálním minimem. Pro y = 0
neexistuje parciální derivace podle proměnné y. Podle toho, jak chápeme pojem okolí
bodu (funkce není definovaná pro y < 0), bychom měli vyšetřit ještě body, pro něž
y = 0. Nicméně pro y = 0 funkce lokálního extrému nenabývá, o čemž je potřeba se
přesvědčit vyšetřením okolí „potenciálníhoÿ lokálního minima v bodě [4

3 , 0].

(f) Funkce má jeden stacionární bod, který není jejím lokálním extrémem. Pro x = −1
nebo y = −1 neexistují parciální derivace zadané funkce. Opět je na uvážení, jak chápat
pojem okolí bodu a případně vyšetřit i lokální chování funkce v případech x = −1 nebo
y = −1. Již z grafu je vidět, že funkce tu dosahuje lokálně své nejvyšší hodnoty v bodě
[−1,−1], takže je možné mluvit o lokálním maximu funkce v tomto bodě.
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(g) Funkce má nekonečně mnoho stacionárních bodů, žádný z nich však není jejím lokálním
extrémem. Funkce má dále dva body, v nichž neexistují parciální derivace. Bod [0, 0]
není lokálním extrémem funkce, bod [2, 3] je lokálním minimem.

Příklad 3.31: Definice absolutního minima je naprosto stejná s definicí 3.11, jen nyní poža-
dujeme, aby pro všechna X z množiny M platilo: f(X) ≥ f(X∗).

Příklad 3.35: Určete absolutní extrémy funkce f(x, y) na množině M :

(a) V tomto případě ani není potřeba nic počítat. Jen si pozorně přečíst zadání a zamyslet
se nad ním. Největší hodnota (absolutní maximum) zadané funkce je dána „přímoÿ
množinou M a jsou to tedy všechny body na její hranici. Absolutní minimum získáme
tak, když si uvědomíme, že druhá mocnina reálného čísla je vždy číslo nezáporné (tj.
větší nebo rovno nule).

(b) Opět není třeba nic počítat, stačí použít „selský rozumÿ. Množinu M můžeme přepsat
do intervalů: x ∈ [−1, 1], y ∈ [−1, 1] a odtud už je na první pohled vidět, že absolutní
minimum se nachází v bodě [−1,−1] a absolutní maximum v bodě [1, 1].

(c) Absolutní minimum funkce určíme již ze zadání, neboť absolutní hodnota nabývá své
nejmenší hodnoty pro nulový argument a ten je uvnitř množiny M . Absolutní ma-
ximum můžeme hledat klasickou cestou. Zadaná funkce nemá stacionární body, má
ovšem nekonečně mnoho bodů, kde není diferencovatelná. Z grafu funkce (případně
rovnou ze zadání) zjistíme, že absolutní maximum leží na hranici množiny M . Napří-
klad příkazem extrema můžeme extrém najít, a to hned ve čtyřech bodech: [

√
2

2 ,
√

2
2 ],

[
√

2
2 ,−

√
2

2 ], [−
√

2
2 ,
√

2
2 ] a [−

√
2

2 ,−
√

2
2 ].

(d) Postupujeme „klasickýmÿ způsobem. Určíme lokální extrémy (lok. max. v bodě [1, 1])
a následně extrémy na hranici množiny M . Celkem dostaneme, že absolutní maximum
je v bodě [1, 1], absolutní minima jsou dvě, a to v bodech [0, 4] a [4, 0].

(e) Zadaný trojúhelník M je možné vykreslit následující posloupností příkazů:
p1 := plots[pointplot]([[0, 2], [3, 0], [0, -1]], color = red, symbolsize
= 20, symbol = solidcircle):
p2 := plots[polygonplot]([[0, 2], [3, 0], [0, -1]], style=line, color=red,
thickness = 2):
plots[display](p1, p2)

Základním krokem je zápis jednotlivých úseček trojúhelníku v proměnných x a y. Pak
pokračujeme „klasickýmÿ způsobem. Určíme lokální extrémy (lok. min. v bodě [1

2 , 1])
a následně extrémy na hranici množiny M . Celkem dostaneme, že absolutní maximum
je v bodě [0,−1], absolutní minimum v bodě [1

2 , 1].

(f) Postupujeme opět „klasickýmÿ způsobem. Nejprve hledáme lokální extrémy. Dostá-
váme „třiÿ stacionární body, přičemž jeden z nich pokrývá všechny body takové, že
y = 0. Tento stacionární bod (body) však není extrémem již na první pohled, protože
funkční hodnota je pro něj rovna nule. Zbylé dva stacionární body [π3 ,

π
3 ], [−π

3 ,−
π
3 ] jsou

lokální minimum a maximum zadané funkce. Nyní je potřeba si uvědomit, že funkce
sinus je periodická s periodou 2π, takže těchto lokálních extrémů je vlastně nekonečně
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mnoho a všechny jsou současně i extrémy globálními na celém definičním oboru. V za-
dání byla specifikována množina M , a tak je potřeba omezit množinu těchto extrémů
tak, aby vyhovovala zadání, tj. absolutní maxima jsou body [π3 + 2 · k · π, π3 − 2 · l · π]
pro k, l ∈ N0, absolutní minima jsou body [5·π

3 + 2 · k · π,−π
3 − 2 · l · π] pro k, l ∈ N0.

Příklad 3.37: Řešíme naprosto stejným postupem jako v příkladu 3.36. Hledaná kladná čísla
jsou: x = y = z = 4.

Příklad 3.38: Opět postupujeme stejně jako v příkladu 3.36. Minimalizujeme funkci f(x, y) =
x + y + 50√

x·y pro x > 0, y > 0. Nejmenší možný součet takových čísel je 20 pro x = 5, y =
5, z = 10.

Příklad 3.39: Vzdálenost bodu o souřadnicích [x, y, z] od počátku souřadného systému je:√
x2 + y2 + z2. Tento součet musíme minimalizovat pro z = x · y− 1. Přepisem analogickým

k předchozím příkladům dostáváme úlohu minimalizovat funkci f(x, y) =
√
x2 + y2 + (x · y − 1)2

na celém jejím definičním oboru. K tomu můžeme využít příkaz minimize. Nejblíže počátku
je bod [0, 0,−1].

Příklad 3.40: Hledáme rovnici přímky y = k · x + q, tj. reálná čísla k a q, pro něž platí, že
S = (q − 2)2 + (k + q − 3)2 + (2 · k + q − 5)2 je minimální. Můžeme opět využít příkazu
minimize a dostáváme: k = 3

2 , q = 11
6 .

Příklad 3.42: U každého případu vykreslíme množinu Ω a z obrázku určíme meze dvojná-
sobného integrálu.

(a)

Obrázek 5.35: Zobrazení množiny Ω z příkladu 3.42.(a).

Můžeme volit následující:

1. 0 ≤ x ≤ 1, 0 ≤ y ≤ x,

2. 0 ≤ y ≤ 1, 0 ≤ x ≤ y.

184



Celkem tak získáváme:

I =
∫∫

Ω

f(x, y) dx dy =

1∫
0

x∫
0

f(x, y) dy dx =

1∫
0

y∫
0

f(x, y) dx dy.

(b)

Obrázek 5.36: Zobrazení množiny Ω z příkladu 3.42.(b).

Můžeme volit následující:

1. 0 ≤ x ≤ 1,−
√

1− x2 ≤ y ≤
√

1− x2.

Celkem tak získáváme:

I =
∫∫

Ω

f(x, y) dx dy =

1∫
0

√
1−x2∫

−
√

1−x2

f(x, y) dy dx.

(c)

Můžeme volit následující:

1. −3 < x ≤ 0,−x− 3 < y < x+ 3,
0 ≤ x < 3, x− 3 < y < −x+ 3.

Celkem tak získáváme:

I =
∫∫

Ω

f(x, y) dx dy =

0∫
−3

x+3∫
−x−3

f(x, y) dy dx +

3∫
0

−x+3∫
x−3

f(x, y) dy dx.
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Obrázek 5.37: Zobrazení množiny Ω z příkladu 3.42.(c).

Obrázek 5.38: Zobrazení množiny Ω z příkladu 3.42.(d).
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(d)

Můžeme volit následující:

1. −2 ≤ x ≤ 0,−x
2 ≤ y ≤ 1,

0 ≤ x ≤ 2, x2 ≤ y ≤ 1.

Celkem tak získáváme:

I =
∫∫

Ω

f(x, y) dx dy =

0∫
−2

1∫
−x2

f(x, y) dy dx +

2∫
0

1∫
x
2

f(x, y) dy dx.

Příklad 3.43: Podobně jako v předchozím příkladu si nejprve zobrazíme mmožinu ohraničenou
integračními mezemi a následně množinu vyjádříme v obráceném pořadí mezí.

(a)

Obrázek 5.39: Zobrazení množiny ohraničené integračními mezemi z příkladu 3.43.(a).

Přepis množiny v obráceném pořadí proměnných:

0 ≤ y ≤ 2, 0 ≤ x ≤ 2 · y.

Celkem tak získáváme:

4∫
0

2∫
x
2

f(x, y) dy dx =

2∫
0

2·y∫
0

f(x, y) dx dy.
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(b)

Obrázek 5.40: Zobrazení množiny ohraničené integračními mezemi z příkladu 3.43.(b).

Přepis množiny v obráceném pořadí proměnných:

0 ≤ y ≤ 2, y2 ≤ x ≤ y,
2 ≤ y ≤ 4, y2 ≤ x ≤ 2.

Celkem tak získáváme:

2∫
0

2·x∫
x

f(x, y) dy dx =

2∫
0

y∫
y
2

f(x, y) dx dy +

4∫
2

2∫
y
2

f(x, y) dx dy.

(c)

Přepis množiny v obráceném pořadí proměnných:

0 ≤ y ≤ 4,
√
y ≤ x ≤ 2.

Celkem tak získáváme:

2∫
0

x2∫
0

f(x, y) dy dx =

4∫
0

2∫
√
y

f(x, y) dx dy.
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Obrázek 5.41: Zobrazení množiny ohraničené integračními mezemi z příkladu 3.43.(c).

(d)

Obrázek 5.42: Zobrazení množiny ohraničené integračními mezemi z příkladu 3.43.(d).

Přepis množiny v obráceném pořadí proměnných:

0 ≤ y ≤ 1,
√
y ≤ x ≤ 3

√
y.

189



Celkem tak získáváme:

1∫
0

x2∫
x3

f(x, y) dy dx =

1∫
0

3√y∫
√
y

f(x, y) dx dy.

Příklad 3.45: Řešení je velice jednoduché. U příkladu 3.42 stačí dosadit f(x, y) = 1 do
integrálů, které jsme získali řešením příkladu. U příkladu 3.43 stačí dosadit f(x, y) = 1 jak
do zadání, tak do řešení příkladu.

Příklad 3.46: Vyjdeme z rovnice kružnice o poloměru r: x2 +y2 = r2. Jestliže postupujeme od
proměnné x, meze prvního integrálu jsou zřejmé: x ∈ [−1, 1]. Následně potřebujeme vyjádřit
meze proměnné y, což provedeme právě z rovnice kružnice: y ∈ [−

√
r2 − x2,

√
r2 − x2]. Podle

vztahu v poznámce 3.20 již jednoduše pomocí systému Maple určíme požadovaný obsah
kruhu.

Příklad 3.47: Postupujeme analogicky předchozímu příkladu. Tentokrát vyjdeme z rovnice
elipsy: x2

a2
+ y2

b2
= 1. Proměnná x nyní nabývá hodnot z intervalu [−a, a], pro meze proměnné

y platí: y ∈
[
−b ·

√
1− x2

a2
, b ·
√

1− x2

a2

]
.

Příklad 3.49: Ve všech případech je vhodné pro získání představy vykreslit alespoň náznak
tvaru získaného tělesa. Dále je vhodné si zobrazit podstavu tělesa, z níž odvodíme integrační
meze. Dvojný integrál nám následně spočítá systém Maple, jen v případě (c) nezískáme
přesnou (symbolickou) hodnotu a musíme použít příkaz evalf.

Obrázek 5.43: Řešení příkladu 3.49.(a).
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Obrázek 5.44: Řešení příkladu 3.49.(b).

Obrázek 5.45: Řešení příkladu 3.49.(c).
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Obrázek 5.46: Řešení příkladu 3.49.(d).

Obrázek 5.47: Řešení příkladu 3.49.(e).
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Příklad 3.50: Kvádr je třeba vhodně umístit do souřadné soustavy – například tak, že spodní
roh podstavy dáme do bodu [0, 0, 0], zbylé rohy podstavy budou v bodech [a, 0, 0], [0, b, 0]
a [a, b, 0]. Výška kvádru bude rovna c. Z toho vyplývá, že funkce ohraničující kvádr je
konstantní funkce f(x, y) = c a podstavu kvádru můžeme přepsat do mezí následovně:
x ∈ [0, a], y ∈ [0, b].

Příklad 3.51: Je potřeba znát rovnici koule: x2 + y2 + z2 = r2. Koule vyjádřená touto rovnicí
má střed v počátku souřadné soustavy. Její objem určíme tak, že spočítáme objem její horní
poloviny (která leží nad rovinou z = 0) a ten vynásobíme dvěma. Plášť horní poloviny
koule je popsán funkcí f(x, y) =

√
r2 − x2 − y2, podstava je tvořena kruhem popsaným

nerovnicí x2 + y2 ≤ r2. Integrační meze tak můžeme zapsat následovně: x ∈ [−r, r], y ∈
[−
√
r2 − x2,

√
r2 − x2].

Příklad 3.52: Opět je potřeba vhodně umístit válec do souřadného systému. Můžeme na-
příklad podstavu válce umístit do roviny z = 0 tak, že její střed je v počátku souřadné
soustavy. Podstava je pak popsána nerovnicí x2 + y2 ≤ r2 a je možné ji přepsat do inte-
gračních mezí následovně: x ∈ [−r, r], y ∈ [−

√
r2 − x2,

√
r2 − x2]. Válec je shora ohraničen

konstantní funkcí f(x, y) = v.

Příklad 3.54: Postupujeme stejným způsobem jako v příkladu 3.53.
Výsledky:

(a) S = 3 ·
√

14,

(b) S = −15
16 + 185

128 · ln (5) + 5
6 ·
√

5 + 185
64 · arcsinh

(
2
5 ·
√

5
) .

= 5.58,

(c) příslušný integrál musíme vyhodnotit numericky, S
.
= 583.77,

(d) příslušný integrál musíme vyhodnotit numericky, S
.
= 7.57,

(e) příslušný integrál musíme vyhodnotit numericky, S
.
= 6.00.

Příklad 3.55: Kouli umístíme opět středem do počátku souřadného systému. Povrch horní
poloviny koule je pak popsán funkcí f(x, y) =

√
r2 − x2 − y2. Integrační meze můžeme za-

psat následovně: x ∈ [−r, r], y ∈ [−
√
r2 − x2,

√
r2 − x2]. Získaný výsledek je třeba vynásobit

dvěma (neboť počítáme povrch pouze horní poloviny koule).

Příklad 3.56: Povrch horní poloviny koule je popsán funkcí f(x, y) =
√

25− x2 − y2. Dále
je třeba odvodit integrační meze. Rovina z = 2 protne kouli v bodech kružnice popsané
rovnicí x2 + y2 = 21 a rovina z = 4 protne kouli v bodech kružnice popsané rovnicí x2 +
y2 = 9. Množina Ω je tedy prstencového tvaru vymezená kružnicemi o poloměrech

√
21

a 3. Díky symetrii celého tělesa je možné zabývat se pouze prvním oktantem a výsledek
vynásobit čtyřmi. Integrační meze (meze části množiny Ω) bychom pak zapsali následovně:
x ∈ [0, 3], y ∈ [

√
9− x2,

√
21− x2] ∪ x ∈ [3,

√
21], y ∈ [0,

√
21− x2].

Pro získání symbolického výsledku je třeba převést integrál do polárních souřadnic, např.
příkazem ChangeOfVariables z balíku Student[MultivariateCalculus]. Maple to ne-
zvládne dokonale, a tak je potřeba následně zapsat do polárních souřadnic ještě množinu
Ω (pro získání integračních mezí). V polárních souřadnicích je navíc jednodušší množinu Ω
zapsat, a tak ji přepíšeme rovnou celou. Pro poloměr r platí: 3 ≤ r ≤

√
21, a pro úhel θ:

0 ≤ θ ≤ 2 · π.
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Obrázek 5.48: Řešení příkladu 3.56

Příklad 3.58: Můžeme využít dvojných integrálů již získaných při řešení příkladu 3.48 a pouze
funkci f(x, y) „přepsatÿ do mezí pro proměnnou z v třetím integrálu. Zřejmě platí:

(a) z ∈ [0, x2 + y2],

(b) z ∈ [0, 64− x2].

Příklad 3.59: Postupujeme analogicky k řešení příkladu 3.50. Kvádr vhodně umístíme do
souřadné soustavy a jeho meze pak můžeme zapsat následovně: x ∈ [0, a], y ∈ [0, b], z ∈ [0, c].

Příklad 3.60: Koule je speciálním případem trojosého elipsoidu z příkladu 3.57 pro a = b =
c = r. Můžeme tedy pouze pozměnit tyto hodnoty v řešení v příkladu 3.57 a získáme vztah
pro objem koule o poloměru r.

Příklad 3.61: Postupujeme analogicky k řešení příkladu 3.52. Válec vhodně umístíme do
souřadné soustavy a jeho meze pak můžeme zapsat následovně:
x ∈ [−r, r], y ∈ [−

√
r2 − x2,

√
r2 − x2], z ∈ [−v, v].

Příklad 3.63: Zadaná funkce představuje plášť horní poloviny koule o poloměru r = 1. V pří-
kladu tak počítáme objem horní poloviny koule o zmíněném poloměru a z předešlých příkladů
víme, že by výsledek měl vyjít 2·π

3 . Můžeme například zapsat dvojný integrál v kartézských
souřadnicích a použít příkaz ChangeOfVariables. Nové integrační meze odvodíme velmi
snadno, neboť se jedná o kruh o poloměru r = 1. Dostáváme tedy: r ∈ [0, 1], θ ∈ [0, 2 · π].
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Příklad 3.64: Ve všech příkladech (3.46, 3.51, 3.52, 3.60 a 3.61) jsme v tomto textu využili
kartézských souřadnic. Nyní tedy provedeme příslušné výpočty v souřadnicích polárních,
sférických a cylindrických.

V příkladu 3.46 počítáme obsah kruhu o poloměru r. V polárních souřadnicích můžeme
kruh popsat následovně: x = ρ · cos(θ), y = ρ · sin(θ), kde ρ ∈ [0, r], θ ∈ [0, 2 · π]. Podle
poznámky 3.24 tak počítáme integrál

2·π∫
0

r∫
0

ρ dρ dθ.

Jak v příkladu 3.46, tak i nyní bychom měli obdržet tabulkový vzorec: S = π · r2.

V příkladu 3.51 počítáme objem koule o poloměru r. Využijeme polárních souřadnic,
v nichž popíšeme podstavu horní polokoule následovně: x = ρ · cos(θ), y = ρ · sin(θ), kde
ρ ∈ [0, r], θ ∈ [0, 2 · π]. Podle poznámky 3.24 tak počítáme integrál

2 ·
2·π∫
0

r∫
0

ρ ·
√
r2 − ρ2 · cos(θ)− ρ2 · sin(θ) dρ dθ.

Jak v příkladu 3.51, tak i nyní bychom měli obdržet tabulkový vzorec: V = 4
3 · π · r

3.

V příkladu 3.52 počítáme objem válce o poloměru podstavy r a výšce v. Využijeme opět
polárních souřadnic, v nichž popíšeme podstavu válce: x = ρ · cos(θ), y = ρ · sin(θ), kde
ρ ∈ [0, r], θ ∈ [0, 2 · π]. Podle poznámky 3.24 tak počítáme integrál

2·π∫
0

r∫
0

ρ · v dρ dθ.

Jak v příkladu 3.52, tak i nyní bychom měli obdržet tabulkový vzorec: V = π · r2 · v.

V příkladu 3.60 počítáme objem koule o poloměru r. Ve sférických souřadnicích můžeme
kouli popsat následovně: x = ρ · cos(φ) · sin(θ), y = ρ · sin(φ) · sin(θ), z = ρ · cos(θ), kde
ρ ∈ [−r, r], φ ∈ [0, 2 · π], θ ∈ [0, 2 · π]. Podle poznámky 3.25 tak počítáme integrál

2·π∫
0

2·π∫
0

r∫
−r

sin(θ) · ρ2 dρ dφ dθ.

Jak v příkladu 3.60, tak i nyní bychom měli obdržet tabulkový vzorec: V = 4
3 · π · r

3.

V příkladu 3.61 počítáme objem válce o poloměru podstavy r a výšce v. V cylindrických
souřadnicích můžeme válec popsat následovně: x = ρ · cos(θ), y = ρ · sin(θ), z = z, kde
ρ ∈ [0, r], θ ∈ [0, 2 · π], z ∈ [0, v]. Podle poznámky 3.26 tak počítáme integrál

2·π∫
0

r∫
0

v∫
0

ρ dz dρ dθ.

Jak v příkladu 3.61, tak i nyní bychom měli obdržet tabulkový vzorec: V = π · r2 · v.
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Příklad 3.65: Všechny tři řady umí Maple „sečístÿ.

(a)
∞∑
n=1

1
n·(n+1) = 1, (b)

∞∑
n=1

1
n2

= π2

6 , (c)
∞∑
n=1

1
n

=∞, řada diverguje.

Příklad 3.68:

(a) sn =
√
n, s = lim

n→∞
sn =∞⇒ řada diverguje,

(b) an = 1√
n2+2·n > 1√

n2+2·n+1
= 1√

(n+1)2
= 1

n+1 , řada
∞∑
n=1

1
n+1 diverguje ⇒ zadaná řada

také diverguje,

(c) an =
√
n√

n4+1
<
√

1
n3
, řada

∞∑
n=1

√
1
n3

konverguje ⇒ konverguje i zadaná řada,

(d) použijeme limitní srovnávací kritérium a budeme srovnávat s řadou
∞∑
n=1

1
n2

, o níž víme,

že konverguje,

(e) použijeme limitní verzi podílového kritéria a zjistíme, že řada konverguje,

(f) využijeme opět limitní verze podílového kritéria a zjistíme, že řada diverguje,

(g) využijeme limitní verze odmocninového kritéria a zjistíme, že zadaná řada konverguje,

(h) využijeme limitní verze podílového kritéria a zjistíme, že zadaná řada konverguje,

(i) stačí zadat systému Maple a zjistíme, že zadaná řada konverguje; jinak je možné použít
například integrální kritérium.

Příklad 3.71:

(a) Jak součet zadané řady, tak součet řady absolutních hodnot umí určit Maple přímo.
Zadaná řada konverguje absolutně.

(b) Součet zadané řady i řady absolutních hodnot opět určí Maple přímo (i když je po-
třeba se „nevyděsitÿ vypsaným tvarem výsledku pro součet zadané řady). Zadaná řada
konverguje neabsolutně.

(c) Pomocí Leibnizova kritéria zjistíme, že zadaná řada konverguje. Pomocí integrálního
kritéria ověříme, že řada absolutních hodnot diverguje. Zadaná řada proto konverguje
neabsolutně.

(d) Pomocí Leibnizova kritéria zjistíme, že zadaná řada konverguje. Srovnávacím krité-

riem s řadou
∞∑
n=1

1
n

ověříme, že řada absolutních hodnot diverguje. Zadaná řada proto

konverguje neabsolutně.

(e) Pomocí limitní varianty odmocninového kritéria zjistíme, že řada absolutních hodnot
konverguje. Zadaná řada proto konverguje absolutně.

(f) V příkladu 3.67.(c) jsme zjistli, že řada absolutních hodnot zadané řady konverguje,
tedy zadaná řada konverguje absolutně.
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Rejstřík

?, 13
%, 16

abs, 11
absolutní konvergence řady, 143
All values, 22
AllSolutions, 21
allvalues, 22
alternující řada, 142
animate, 43
apply, 32
Approximate Integration, 74, 130
ApproximateInt, 130
assign, 17
assume, 25, 86
assuming, 26
Asymptotes, 65
axes, 40

bod uzávěru, 113

Change, 69
changecoords, 120, 134
ChangeOfVariables, 120, 134
Classic Worksheet, 5
coeff, 26
collect, 26
color, 40
combine, 25
contourplot, 94
contours, 94, 176
convert, 26, 56, 69
CriticalPoints, 65

D, 51, 100
definiční obor, 33
Determinant, 109
diff, 51, 99
Digits, 14, 17
DirectionalDerivative, 103
discont, 48, 60, 62, 63, 98
display, 81, 101
divergence řady, 135

Document Mode, 7
dolní integrál, 71
dolní integrální součet, 70
Drawing, 40
dsolve, 21

Error, (in plot) . . ., 149
Error, illegal use of an object as a name, 147
Error, invalid assignment, 146
Error, invalid input, 145
Error, invalid operator parameter name, 149
Error, invalid power, 147
Error, numeric exception: division by zero,

147
Error, unable to match delimiters, 146
eval, 30, 31, 51, 109
evalb, 35
evalf, 14, 15, 22
expand, 26, 30
extrema, 60, 109, 113, 114
ExtremePoints, 65

factor, 26
frames, 43
fsolve, 21
FunctionChart, 65

gridlines, 89
gridrefine, 89, 91, 93

hessián, 109
Hessian, 109
Hessova matice, 109
hlavní menu, 5
horní integrál, 71
horní integrální součet, 71

implicitplot, 89, 91, 93, 121
implicitplot3d, 100
inequal, 91, 121
InflectionPoints, 65
Int, 68, 119
int, 67, 72, 119
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integrální kritérium, 140
integrační konstanta, 66
IntegrationTools, 68, 69
integrovatelná funkce, 72
intsolve, 21
InversePlot, 36
InverseTutor, 36
invfunc, 36
isolve, 21

kernelopts(maxdigits), 14
kontextová lišta, 5
konvergence řady, 135

labels, 40
lcm, 15
legend, 40
Leibnizovo kritérium, 143
limit, 46, 95
limitní Raabeovo kritérium, 140
limitní srovnávací kritérium, 139
LinearAlgebra, 18, 109
LinearSolve, 21

Maclaurinův vzorec, 56
Maclaurinův zbytek, 56
Maple Help, 11
Math Mode, 7
Maximize, 111, 113
maximize, 34, 111, 113, 114
metoda per partes, 67
Minimize, 111, 113
minimize, 34, 111–114
msolve, 21
mtaylor, 107
MultiInt, 120

nástrojová lišta, 5
neabsolutní konvergence řady, 143
nekonečná řada, 135
neurčitý integrál, 66
normal, 25
numpoints, 89

obor hodnot, 33
odmocninové kritérium, 140
ohraničená funkce, 33
Optimization, 111, 113
Order, 56, 107
oscilace řady, 135

palety, 5, 9

parfrac, 69
Parts, 68
pdsolve, 21
Pi, 10
piecewise, 32
Plot, 40
plot, 40, 62, 135
Plot Builder, 40
plot3d, 80, 81, 88, 89, 94, 100, 101, 106
PlotBuilder, 88
plots, 43, 91, 101, 106, 121
plottools, 76, 121
podílové kritérium, 140
pointplot3d, 101, 106
polygonplot, 182
posloupnost, 135
posloupnost částečných součtů, 135
primitivní funkce, 66

RealDomain, 19, 34
restart, 17
Riemannův integrál, 72
RiemannSum, 72, 130
Roots, 65
rsolve, 21

seq, 135
simplify, 20, 25, 26, 30
singular, 98
solve, 20, 60, 76
sort, 26
spacecurve, 101, 113, 114
sqrt, 10
srovnávací kritérium, 139
stacionární body, 59
Standard Worksheet, 4
stavová lišta, 5
Student[Calculus1], 36, 65, 72, 84
Student[MultivariateCalculus], 103, 120, 130
subs, 69
substituční metoda, 67
Sum, 135
sum, 135

taylor, 56, 107
Taylorův polynom, 55, 107
Taylorův vzorec, 55, 107
Taylorův zbytek, 55, 107
Text Mode, 7
thickness, 40
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trace, 43
transform, 76, 121
type, 146

unapply, 31, 51, 72
unassign, 17
Units, 20
Units Calculator, 20
unwith, 18
uzávěr množiny, 113
uzavřená množina, 113

value, 68, 69
VectorCalculus, 109
verify, 35

Warning, solutions may have been lost, 151
Warning, unable to determine if . . ., 151
What Assumptions, 22
with, 18, 109
Worksheet Mode, 7
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